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Notice

Every effort was made to ensure that the information in this manual was accurate at the
time of printing. However, information is subject to change without notice, and Viavi
reserves the right to provide an addendum to this manual with information not available
at the time that this manual was created.

Copyright/Trademarks

© Copyright 2018 Viavi Solutions Inc. All rights reserved. No part of this guide may be
reproduced or transmitted, electronically or otherwise, without written permission of the
publisher. Viavi Solutions and the Viavi logo are trademarks of Viavi Solutions Inc.
(“Viavi”).

The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth
SIG, Inc. and any use of such marks by Viavi is under license.

All other trademarks and registered trademarks are the property of their respective
owners.

Copyright release

Reproduction and distribution of this guide is authorized for US Government purposes
only.

Ordering information

The catalog number for a printed getting started manual is ML-22046563. The catalog
number for electronic manuals on USB is CEML-21138299.

Terms and conditions

Specifications, terms, and conditions are subject to change without notice. The provi-
sion of hardware, services, and/or software are subject to Viavi’'s standard terms and
conditions, available at www.viavisolutions.com/en/terms-and-conditions.

Open Source Disclaimer - IMPORTANT READ CAREFULLY

The MSAM, CSAM, T-BERD / MTS 5800 family of instruments, and SC 4800/4800P
include third party software licensed under the terms of separate open source software
licenses. By using this software you agree to comply with the terms and conditions of
the applicable open source software licenses. Software originated by Viavi is not
subject to third party licenses. Terms of the Viavi Software License different from appli-
cable third party licenses are offered by Viavi alone.
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Product Regulatory Compliance

Federal Communications Commission (FCC) Notice

This product was tested and found to comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment is operated in a commer-
cial environment. This product generates, uses, and can radiate radio frequency energy
and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this product in a residential
area is likely to cause harmful interference, in which case you will be required to correct
the interference at your own expense.

The authority to operate this product is conditioned by the requirements that no modifi-
cations be made to the equipment unless the changes or modifications are expressly
approved by Viavi.

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) This device may not cause harmful interference, and (2)
This device must accept any interference received, including interference that may
cause undesired operation.

If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try
to correct the interference by one or more of the following measures:

— Reorient or relocate the receiving antenna.
— Increase the separation between the equipment and receiver.

— Connect the equipment into an outlet on a circuit different from that to which
the receiver is connected.

—  Consult the dealer or an experienced radio/TV technician for help.

In order to maintain compliance with the limits of a Class A digital device Viavi requires
that quality interface cables be used when connecting to this equipment. Any changes
or modifications not expressly approved by Viavi could void the user's authority to
operate the equipment.

Industry Canada Requirements

This device complies with Industry Canada license-exempt RSS standard(s). Operation
is subject to the following two conditions: (1) this device may not cause interference,
and (2) this device must accept any interference, including interference that may cause
undesired operation of the device.

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appar-
eils radio exempts de licence. L'exploitation est autorisée aux deux conditions suiva-
ntes: (1) I'appareil ne doit pas produire de brouillage, et (2) I'utilisateur de I'appareil doit
accepter tout brouillage radioélectrique subi, méme si le brouillage est susceptible d'en
compromettre le fonctionnement.

This Class A digital apparatus complies with Canadian ICES-003.
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Cet appareil numérique de la classe A est conforme a la norme NMB-003 du Canada.

Please note that Industry Canada certification for the TB/MTS-5800-100G includes the
following models: TB-5800-100G, MTS-5800-100G, and TB-5800v3.

EU WEEE and Battery Directives

This product, and the batteries used to power the product, should not be disposed of
as unsorted municipal waste and should be collected separately and disposed of
according to your national regulations.

Viavi has established a take-back processes in compliance with the EU Waste Elec-
trical and Electronic Equipment (WEEE) Directive, 2012/19/EU, and the EU Battery
Directive, 2006/66/EC.

Instructions for returning waste equipment and batteries to Viavi can be found in the
WEEE section of Viavi's Standards and Policies web page.

If you have questions concerning disposal of your equipment or batteries, contact
Viavi's WEEE Program Management team at WEEE.EMEA@ ViaviSolutions.com.

EU REACH

Article 33 of EU REACH regulation (EC) No 1907/2006 requires article suppliers to
provide information if a listed Substances of Very High Concern (SVHC) is present in
an article above a certain threshold.

For information on the presence of REACH SVHCs in Viavi products, see the
Hazardous Substance Control section of Viavi's Standards and Policies web page.

EU CE Marking Directives (LV, EMC, RoHS, RE)

This product conforms with all applicable CE marking directives. Please see EU Decla-
ration of Conformity for details.
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About this Guide

This preface explains how to use this Getting Started Guide. Topics discussed in this
chapter include the following:

“Purpose and scope” on page Xxvi

“Assumptions” on page xvi

“Terminology” on page xvi

“Related information” on page xix

“Conventions” on page xx

“Safety and compliance information” on page xxii
“Technical assistance” on page xxii
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About this Guide
Purpose and scope

Purpose and scope

The purpose of this manual is to help you successfully use the features and capabilities
of the Dual Module Carrier (DMC), Transport Module, Multi-Service Application Module
(MSAM), and 100 G Service Application Module (CSAM) for the T-BERD/MTS 8000,
6000A, and 5800 platforms as well as each of the members of the T-BERD /MTS 5800
Handheld Network Test Family, and Smart Class 4800/4800P instruments. This manual
includes task-based instructions that describe how to configure, use, and troubleshoot
the general functions each of the test instruments.

Assumptions

This manual is intended for novice, intermediate, and experienced users who want to
use their test instruments effectively and efficiently. We are assuming that you have
basic computer experience and are familiar with basic telecommunication concepts,
terminology, and safety.

Terminology

The T-BERD 8000 is branded as the MTS-8000 in Europe, and it is interchangeably
referred to as the T-BERD 8000, MTS 8000, MTS-8000, MTS8000 and Media Test Set
8000 in the guide.

The T-BERD 6000A is branded as the MTS-6000A in Europe, and it is interchangeably
referred to as the T-BERD 6000A, MTS 6000A, MTS-6000A, MTS6000A and Media
Test Set 6000A.

The T-BERD 5800 family of instruments is branded as the MTS-5800 in Europe, and it
is interchangeably referred to as the T-BERD 5800, MTS 5800, MTS-5800, MTS5800,
Media Test Set 5800 and 5800.

The Smart Class 4800 is also referred to as the SC 4800/4800P, SC 4800, SC4800,
and 4800.

Components

The following terms are used to represent instrument components throughout this
manual:

*  Application module — Used throughout this manual to refer to the component
that provides test functionality to the assembled instrument. This manual supports
two application modules: the MSAM and CSAM.

The T-BERD / MTS 5800 and 5800-100G are all-in-one test instruments which do
not require an application module; however, optional modules are available and
can be attached to the devices for additional functionality.

T-BERD/MTS/SC Getting Started Guide
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Terminology

Assembly — Used throughout this manual to refer to a complete set of compo-
nents assembled as an instrument and used for testing.

— DMC assembly, consisting of a T-BERD/MTS 8000 base unit, an interme-
diary Dual Module Carrier (DMC), and up to two MSAMSs with up to four Phys-
ical Interface Modules (PIMs, two per MSAM), or up to two CSAMSs (requires
a DMC2).

— MSAM assembly, consisting of a either a T-BERD/MTS 6000A base unit
with a single MSAM and up to two PIMs, or a T-BERD/MTS 8000 base unit
with a DMCv2 and up to two MSAMs and up to four PIMs.

— CSAM assembly, consisting of either a T-BERD / MTS 6000Av2 base unit
with a single CSAM, or a T-BERD/MTS 8000 base unit with a DMCv2 and
up to two CSAMs.

— 5800, 5800-100G assembly, consisting of a T-BERD/MTS 5800 test instru-
ment and a battery module. Optional Optical Time Domain Reflectometer
(OTDR), or Timing Expansion Module (TEM) modules are also available for
the 5800. The 5800-100G and 5882 instruments have an internal GNSS
receiver.

— SC 4800 and 4800P assembly, consisting of a Smart Class 4800/4800P test
instrument and a battery module.

— Base unit — The unit which connects directly to the application module
(MSAM or CSAM), DMC (if applicable), and power adapter, providing the
user interface and a variety of connectivity and work flow tools. If optioned to
do so, the base unit also allows you to measure emitted power, received
power, and optical link loss on fiber optic networks.

Battery Module — The module connected to the back of the T-BERD / MTS 8000
base unit, which supplies power whenever power is not provided using the AC
power adapter.

Component— Used throughout this manual to refer to an individual hardware
component which is connected to the other components to build a complete test
instrument (assembly). This manual supports the following components: the
MSAM, CSAM, DMC, 5800 and SC 4800/4800P devices.

CSAM 100G Services Application Module—Referred to generically as “the
instrument” when inserted in the T-BERD / MTS 6000A base unit or the DMCv2
and a T-BERD / MTS 8000 base unit. The CSAM provides testing functionality for
the base unit.

DMC — Dual Module Carrier. The DMC is a two slot chassis which you can
connect to the T-BERD / MTS 8000 base unit to test using up to two MSAM appli-
cation modules and up to four PIMs, or up to two CSAMs (DMCv2 required).

Expansion Module — A variety of expansion modules are available for some of
the 5800 family of instruments to provide additional functionality. Available expan-
sion modules are listed in “Attaching an expansion module to the 5800v2/100G
and 5882” on page 40.

FC — Used to represent Fibre Channel on instrument connector panels and user
interface. Also identifies the optical ports used for Fibre Channel testing.

MSAM Multiple Services Application Module — Referred to generically as “the
instrument” when inserted in the T-BERD / MTS 6000A base unit with at least one
PIM, or the DMC and T-BERD / MTS 8000 base unit with at least one PIM. The
MSAM and PIM provide testing functionality for the base unit.
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PIM — Physical Interface Module. The module inserted into one of up to two ports
provided on the MSAM chassis. PIMs supply the physical connectors (interfaces)
required to connect the MSAM to the circuit under test. A variety of cables, SFPs,
and XFPs are offered as options, and are used to connect the PIMs to the circuit.

T-BERD /MTS 8000, 6000A — The family of products, typically a combination of
a base unit, a battery module, and one or more application modules. The DMC
can be used on the T-BERD / MTS 8000 platform to test using two MSAMs or two
CSAMS (DMCv2 required).

OTDR Module — Optical Time Domain Reflectometer Module. The module can
optionally be connected to the back of the 5800 to characterize optical networks.

OTN — Optical Transport Network.
SyncE — Synchronous Ethernet.

TEM Module — Timing Expansion Module. The module can optionally be
connected to the back of the T-BERD / MTS 5800 to support testing using a
GNSS (Global Navigation Satellite System) based clock or other precise clock
sources.

GPS chip — A device that fulfills some of TEM’s GNSS functions and can be
used on T-BERD / MTS 5800-100G and 5882.

Viavi Ethernet test set — A test set marketed by Viavi and designed to transmit
an Acterna Test Packet (ATP) payload. These packets carry a time stamp used to
calculate a variety of test results. The FST-2802 TestPad, the SmartClass
Ethernet tester, the HST with an Ethernet SIM, the T-BERD/MTS 6000A MSAM,
the T-BERD/MTS 5800, and SC 4800/4800P can all be configured to transmit
and analyze ATP payloads, and can be used in end-to-end and loopback configu-
rations during testing.

SC 4800 and 4800P — Stand-alone units that do not support expansion modules.

Transceivers

The following terms are used to represent the transceivers supported by the instru-
ments documented in this manual:

CFP — C Form-Factor Pluggable optical transceiver. A variety of optional CFPs
(CFP, CFP2, and CFP4) and adapters are available for performing tests over 40G
and/or 100G fiber circuits using your instrument.

Copper SFP — Small Form-factor Pluggable module. Transceiver used to test
copper over 10GigE LAN circuits.

QSFP+ — Quad Small Form-Factor Pluggable optical transceiver. A transceiver
used to test 40G fiber circuits. A CFP2 to QSFP28 adapter supporting 100G fiber
circuits can also be used in the CSAM.

SFP — Small Form-factor Pluggable module. Used on the connector panel and
throughout this manual to represent pluggable optical modules.

SFP+ — Enhanced Small Form-Factor Pluggable module. An enhanced SFP
module designed to support data rates up to 10G.

XFP — 10 Gigabit Small Form-Factor Pluggable optical transceiver. A transceiver
used to test 10G fiber circuits.
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Line rates and signals

The following terms are used to represent the line rates and signals supported by the
instruments in this manual:

10/100/1000 Ethernet — Used to represent 10/100/1000 Mbps Ethernet. The
connector panel may also use 10/100/1000M to identify the port to be used for 10/
100/1000 Mbps Ethernet testing.

1GigE — Used to represent 1 Gigabit Ethernet.

10G — Used to represent 10 Gigabit circuits. 7T0GE may also be used to identify
the optical ports used for 10 Gigabit Ethernet LAN and WAN testing.

100G — Used to represent 100 Gigabit circuits. 7T00GE may also be used to iden-
tify the optical ports used for 100 Gigabit Ethernet testing.

OC-n — Used to refer to each optical SONET rate (OC-3, OC-12, OC-48, and
0C-192), where “n” represents the user-selected line rate.

STM-n — Used to refer to each optical SDH rate (STM-1, STM-4, STM-16, and
STM-64), where “n” represents the user-selected line rate.

STS-1 — Used to refer to the electrical equivalent of OC-1 (51.84 Mbps).
STM-1e — Used to refer to the electrical equivalent of STM-1 (155.52 Mbps).

OTU1 — Optical Transport Unit 1. A 2.7G OTN signal designed to carry a SONET
0OC-48 or SDH STM-16 client signal. OTU1 is used on connector panels and user
interfaces to identify the connectors and applications used for 2.7G OTN testing.

OTU2 — Optical Transport Unit 2. A 10.7G, 11.05G, or 11.1G OTN signal
designed to carry SONET OC-192, SDH STM-64, or 10G Ethernet WAN and LAN
client signals. OTU2 is used on connector panels and user interfaces to identify
the connectors and applications used for 10.7G, 11.05G, or 11.1G OTN testing.

OTU3 — Optical Transport Unit 3. A 43G OTN signal designed to carry 40G
BERT signals.

OTU4 — Optical Transport Unit 4. An 111.8G OTN signal designed to carry 100G
Ethernet BERT and ODU4 encoded signals.

Related information

This is the getting started guide for the DMC, Transport Module, CSAM, MSAM, 5800
and 5800-100G, and Smart Class 4800/4800P. It provides basic instructions for assem-
bling the instrument components, setting up the instrument, instrument specifications,
and contact information for Viavi’s Technical Assistance Center (TAC). Read this
manual carefully before connecting your instrument to the circuit you are testing.

Use this guide in conjunction with the following manuals:

The 8000 Base Unit User Manual. This manual provides an overview, specifica-
tions, and instructions for proper operation of the 8000 base unit.

The 6000A Base Unit User Manual. This manual provides an overview, specifica-
tions, and instructions for proper operation of the 6000A base unit.
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* The T-BERD/MTS/SC Ethernet and Fibre Channel Testing Guide for the
T-BERD 5800 family of instruments, MSAM, and CSAM. For SC 4800/4800P only
Ethernet, IP, TCP/UDP and IP Video are applicable. The manual provides detailed
instructions for testing on each of the listed networks. It also explains how to run
key scripts and describes each of the available test results.

* The T-BERD/MTS/SC SONET, SDH, OTN and PDH Testing Manual for the
T-BERD 5800 family of instruments, MSAM, and CSAM. For SC 4800/4800P only
PDH is applicable. The manual provides detailed instructions for testing on each

of the listed networks.

*  The Data Communications and Diphase Testing Manual for the MSAM. The
manual provides detailed instructions for testing Datacom and Diphase interfaces

using the MSAM.

*  The Timing Expansion Module (TEM) User Manual for the optional TEM Module
that is available for high accuracy timing when testing using the 5800v2 and 5800-

100G.

« The OTDR Functions, Options, and Software Applications User Manual for the
optional OTDR modules that are available for testing using the 5800v2 and 5800-

100G.

*  Help. The topics addressed in the three testing manuals are also available on
your instrument in an HTML format.

Conventions

This guide uses typographical and symbols conventions as described in the following

tables.

Table 1 Text formatting and other typographical conventions

Item(s)

Example(s)

Buttons, keys, or switches that
you press or flip on a physical
device.

Buttons, links, menus, menu
options, tabs, or fields on a PC-
based or Web-based user inter-
face that you click, select, or
type information into.

Directory names, file names,
and code and output messages
that appear in a command line
interface or in some graphical
user interfaces (GUIs).

Press the On button.
— Press the Enter key.
— Flip the Power switch to the on position.

Press the On button.
— Click File > Properties.
— Click the Properties tab.

— Type the name of the probe in the Probe
Name field.

SNANGT DATA DIR/results (directory)

— test products/users/
defaultUser.xml (file name)

— All results okay. (output message)
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Table 1 Text formatting and other typographical conventions (Continued)
Item(s) Example(s)
Text you must type exactly as — Restart the applications on the server using
shown into a command line the following command:
interface, text file, or a GUI text $BASEDIR/startup/npiu init
field. restart

Type: a: \set.exe in the dialog box.

References to guides, books, Refer to Newton’s Telecom Dictionary.
and other publications appear in
this typeface.
Command line option separa- platform [a|b|e]
tors.
Optional arguments (text vari- login [platform name]

ables in code).

Required arguments (text vari- <password>
ables in code).

Table 2

Symbol conventions

>

This symbol indicates a note that includes important supplemental infor-
mation or tips related to the main text.

This symbol represents a general hazard. It may be associated with either a
DANGER, WARNING, CAUTION, or ALERT message. See Table 3 for
more information.

This symbol represents an alert. It indicates that there is an action that must
be performed in order to protect equipment and data or to avoid software
damage and service interruption.

This symbol represents hazardous voltages. It may be associated with
either a DANGER, WARNING, CAUTION, or ALERT message. See Table 3
for more information.

This symbol represents a risk of explosion. It may be associated with either
a DANGER, WARNING, CAUTION or ALERT message. See Table 3 for
more information.

This symbol represents a risk of a hot surface. It may be associated with
either a DANGER, WARNING, CAUTION, or ALERT message. See Table 3
for more information.

This symbol represents a risk associated with fiber optic lasers. It may be
associated with either a DANGER, WARNING, CAUTION or ALERT mes-
sage. See Table 3 for more information.

This symbol, located on the equipment, battery, or the packaging indicates
that the equipment or battery must not be disposed of in a land-fill site or
as municipal waste, and should be disposed of according to your national
regulations.
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Safety and compliance information

Table 3 Safety definitions

Term Definition

DANGER Indicates a potentially hazardous situation that, if not avoided, will
result in death or serious injury. It may be associated with either a
general hazard, high voltage, or other symbol. See Table 2 for
more information.

WARNING Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury. It may be associated with
either a general hazard, high voltage, or other symbol. See Table 2
for more information.

CAUTION Indicates a potentially hazardous situation that, if not avoided,
could result in minor or moderate injury and/or damage to equip-
ment.

It may be associated with either a general hazard, high voltage, or
risk of explosion symbol. See Table 2 for more information.

When applied to software actions, indicates a situation that, if not
avoided, could result in loss of data or a disruption of software
operation.

ALERT Indicates that there is an action that must be performed in order to
protect equipment and data or to avoid software damage and ser-
vice interruption.

Safety and compliance information

Safety and compliance information for the instrument are provided in printed form and
ship with your instrument.

The MSAM and CSAM are part of a modular platform; therefore, the safety and compli-
ance information are provided with the base unit in the supporting base unit user
manual (delivered in the equipment’s help system), with additional information in the
printed T-BERD / MTS-6000 Getting Started Manual card or the T-BERD / MTS-8000
Getting Started Manual card. The cards are shipped and delivered with their respective
base units.

For a 5800 and 4800 instruments, refer to the T-BERD./MTS 5800, SC 4800 and TEM
Safety Information document that is shipped with the instrument.

Technical assistance

If you require technical assistance, call 1-844-GO-VIAVI. For the latest TAC informa-
tion, go to http://www.viavisolutions.com/en/services-and-support/support/technical-
assistance.

Page xxii

T-BERD/MTS/SC Getting Started Guide
22046537, Rev. 016 March 2018


http://www.viavisolutions.com/en/services-and-support/support/technical-assistance
http://www.viavisolutions.com/en/services-and-support/support/technical-assistance

Overview

This chapter provides a general description of each of the test instruments. Topics

discussed in this chapter include the following:

e “About the instruments” on page 2

*  “Features and capabilities” on page 2

*  “Configuring your instrument” on page 4

e “What ships with your instrument?” on page 4

*  “Accessories” on page 6

*  “About the T-BERD / MTS 5800 and SC 4800” on page 8

e “About the CSAM Assembly” on page 14

*  “About the MSAM Assembly” on page 17

e “About the DMC Assembly” on page 24

*  “Viavi recommended optical adapters and transceivers” on page 25
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Chapter 1 Overview
About the instruments

About the instruments

The T-BERD / MTS MSAM, CSAM, 5800, 5800-100G are all-in-one test solutions for
the following networks:

e  T-Carrier (DS1 and DS3)

* PDH (E1 through E4)

*  SONET (STS-1 through OC-192)
* SDH (STM-1e through STM-64)

*  Ethernet (10/100/1000, 100 M Optical, 1 Gigabit Optical, 10 Gigabit Ethernet LAN
and WAN, 40 Gigabit Optical and 100 Gigabit Optical)

 IP(10/100/1000, 100 M Optical, 1 Gigabit Optical, 10 Gigabit Ethernet LAN and
WAN, 40 Gigabit Optical and 100 Gigabit Optical)

« TCP/UDP (10/100/1000, 100 M Optical, 1 Gigabit Optical, and10 Gigabit Ethernet
LAN)

* [P Video (10/100/1000, 100 M Optical, 1 Gigabit Optical, and 10 Gigabit Ethernet
LAN)

* Fibre Channel (1G, 2G, 4G, 8 G, 10G, 16G and 32G)
(8G available only on MSAMv2 with 8G-capable SFP+ or XFP transceiver)

* OTN (2.7G, 10.7G, 11.05G, 11.1G, 43.02G and 111.8G)

The Smart Class 4800 and 4800P are stand-alone units that do not support expansion
modules and have fewer features. Refer to your customer documentation for a list of
covered networks.

The MSAM also accepts physical interface modules (PIMs) designed to allow you to
test Data communications and Diphase interfaces. The 5800 family of instruments
allows you to connect optional expansion modules for enhanced optical testing or a
highly accurate timing source during testing.

Each of the instruments is designed to be a rugged, portable, battery-operated test
solution that facilitates the quick turn-up and troubleshooting of multiple services and
network elements in the Metro and Core network. This allows providers who are
expanding their offerings into new data and wavelength services to deploy a single
technician to install and maintain new elements and services using one integrated
module or integrated instrument.

Features and capabilities

Features and capabilities of the instruments include the following (assuming your
instrument is optioned and configured to do so):

e Electrical interfaces support — Ability to test circuits from a variety of electrical
interfaces (DS1, E1 BNC, E1 RJ-48, E3, DS3, STS-1, E4, and STM-1e BNC os
HD-BNC).

*»  SONET/SDH interfaces support — Ability to test circuits from a variety of SONET
and SDH interfaces (OC-3/STM-1 through OC-192/STM-64).
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Features and capabilities

Ethernet interface support — Ability to test circuits from a variety of Ethernet inter-
faces (10/100/1000 Mbps Electrical through 100M and 1 GigE optical circuits),

10 Gig LAN and WAN, and 100 GigE optical circuits at 850 nm, 1310 nm, and
1550 nm.

SyncE interface support — Ability to test circuits from a variety of SyncE inter-
faces.

Fibre Channel interface support — Ability to test 1, 2, 4, 8, 16 and 32 Gigabit (on
T-BERD / MTS 5800-100G only) Fibre Channel interfaces.

OTN support — Ability to test OTU1 (2.7G) and OTUZ2 (10.7G, 11.05G, and 11.1G)
circuits by performing FEC tests, BER tests, and inserting errors and alarms. Also
test OTU3 (43.02G) and OTU4 (111.8G) circuits by performing BERT and
Ethernet tests and inserting errors and alarms. All tests are to verify that network
performance conforms to G.709 standards.

High Accuracy Timing support — Using the optional TEM module and a T-BERD /
MTS 5800v2, the ability to provide a highly accurate timing reference during
testing and precisely synchronize the timing on multiple instruments.

OTDR support — Ability to use your instrument to conduct OTDR testing and
characterize an optical fibre cable.

Intuitive user interface — User interface facilitates quick test configuration and
execution, and easy interpretation of test results.

Detailed test results — You can use the entire screen to observe test results, or
you can collapse and expand certain test results for which a variety of measure-
ments are made (such as current, average, minimum, or peak throughput
measurements). You can also suppress graphical result collection if you intend to
run resource intensive applications. For Dual Term or Dual Through applications,
you can observe test results for both ports simultaneously.

Automatic traffic transmission —You can optionally set up Ethernet, IP, TCP/UDP,
and Fibre Channel test applications to generate and transmit traffic automatically
whenever you turn the laser on (for optical applications).

VT-100 terminal emulation — If your instrument is optioned to do so, you can use

it to emulate a VT-100 terminal, and then connect it to a network element via a
serial interface to gather information about the element.

Optical power measurements — Ability to measure optical power.

Automated RFC 2544 and Fibre Channel tests — In addition to the standard
tests, expert tests are available which allow you to specify and review test settings
quickly and efficiently.

HTML viewer — An HTML viewer is available which allows you to easily view and
navigate through HTML files on your instrument.

Cable Test — Ability to examine the state of the cables, including AOC/DAC
cables, used to transmit 10/25/40/100 GigE before you begin testing.

Ethernet and Internet Protocol service verification — Ability to verify proper instal-
lation and maintenance of carrier-grade Ethernet and Internet Protocol services.
IP video service verification — The ability to verify and troubleshoot IP video
service.

TCP/UDP, FTP, and HTTP protocol support — The ability to transmit and analyze
traffic carried using the TCP/UDP, FTP, and HTTP protocols.
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Configuring your instrument

VLAN, Q-in-Q, VPLS, MPLS, and stacked VLAN up to 8 tags encapsulation
support — The ability to transmit and analyze VLAN, Q-in-Q, VPLS, MPLS and
stacked VLAN up to 8 tags encapsulated Ethernet traffic.

Dual view applications — When running multiple tests, you can view results for
two tests side-by-side. For more information, see “Viewing both tests” on
page 129.

Support for tunable SFP+ or XFPs — The ITU-T G.694.2 standard provides a
frequency grid for DWDM which creates channel spacing. The channel spacing
allows different carriers to run on the same fiber. When using a tunable SFP+ or
XFP in our instrument, you can specify a channel, wavelength or frequency for the
transceiver. If the tunable SFP+ or XFP uses a specification unit other than that
specified in the interface, an automatic best-match calculation will be made to
select the appropriate value. For more information, see “Tuning SFP+ and XFP
transceivers” on page 100.

VNC password — Allows you to change the password on your test instrument.

For a comprehensive list of features and capabilities for each technology supported,
refer to the Testing Manual that shipped with your instrument.

Configuring your instrument

Each instrument is factory-configured to meet your unique testing requirements. When
you place an order for an instrument, a customer service or sales representative will
help you determine which base unit (if applicable), chassis, optics assembly, connector
configuration, PIM, or testing options you need.

To discuss a specific hardware chassis, configuration, or the available testing options,
contact your regional sales office. Contact information is provided on the back cover of
this manual.

What ships with your instrument?

The following items typically ship with your instrument:

Base unit, application modules, and DMC — Depending on your order, the
components required to test network elements and services are shipped to you.
Components may include the T-BERD/MTS 8000 base unit, the T-BERD/MTS
6000 base unit, the DMC, the CSAM, or the MSAM. Software and hardware
options are also available which enable you to expand your testing capabilities for
T-Carrier/PDH, SONET/SDH, Ethernet, IP, TCP/UDP, IP Video, Fibre Channel,
and OTN testing.

Physical interface module (PIM) — Each MSAM provides up to two PIM slots,
enabling you to connect and swap a variety of PIMs designed to test specific inter-
faces. After you select the MSAM chassis that best suits your needs, your
customer service representative will let you know which PIMs are available for
that particular chassis.

The T-BERD /MTS 5800 and SC 4800 instruments are factory-configured to
meet your testing requirements (see Table 6 on page 10).

Page 4

T-BERD/MTS/SC Getting Started Guide
22046561, Rev. 016 March 2018



Chapter 1 Overview
Unpacking the components

* AC power adapter — A power adapter designed specifically for use with your
instrument is included. Use only the Viavi AC Power Adapter that shipped with
your particular instrument. For details, refer to “Powering the instrument” on
page 56.

* Transceivers — When you order your instrument, a customer service representa-
tive will let you know which transceivers are available from Viavi. Additional trans-
ceivers can be ordered separately for an additional charge.

*  Fiber Optic connectors — If your Module is configured for 10 Gigabit testing, one
set of SC, FC, or ST fiber optic connectors is included with the module. When you
order your module, a customer service representative will ask you which type of
connectors (SC, FC, or ST) you would like. For single-mode interfaces, such as
100GBASE-LR4 or 40GBASE-LR4, the typical connector type used on the optics
which Viavi provides is LC.

LC connectors, SFPs, and CFP adapters are also available for some interfaces
and can be ordered separately for an additional charge.

The CSAM can be used with CFP or CFP2 optics (40/100G rates) or QSFP+
optics (40G rates). The CSAM can also be used with an optional CFP2 to
QSFP28 adapter (100G rates).

* BNC to BNC adapter cable — If you order an instrument with SONET testing
capabilities, two BNC to BNC adapter cables are included for DS3 and STS-1
applications. Note: T-BERD/MTS 5800-100G supports CFP4 and QSFP28 as
native ports (i.e. no adapter is required).

*  BNC to 440A adapter cable — If you order an instrument with SONET testing
capabilities, two BNC to 440A adapter cables are included for DS3 and STS-1
applications.

* SMB to SMA adapter — Included with T-BERD/MTS 5800-100G.

* Carrying case — A carrying case is included with the MSAM. Always use this
carrying case when transporting your instrument, and follow the instructions
provided with the carrying case carefully.

If you ordered an instrument with optics, a transceiver case designed to accom-
modate up to six SFPs and three XFPs is also available. A PIM carrying case is
also available, which can store up to three PIMs.

e User documentation — A Getting Started Manual and Testing Manuals (on USB
memory stick), a list of Viavi recommended optics (SFP transceivers), and a
comprehensive help system also ship with the instrument. Remote control
command documentation is also available on the documentation USB memory
stick.

Before testing, the application modules (and if applicable, the DMC) must be connected
to a base unit, which can be ordered separately. Refer to the 8000 Base Unit User
Manual or the 6000A Base Unit User Manual for a list of options and accessories
offered for the base units.

Unpacking the components

Viavi typically ships our instruments using anti-static packing material to stabilize the
components inside the box.
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Inspecting the components for damage

When unpacking the components, verify that all the items you ordered are included in
the package. Accessories may be shipped in a separate box.

After you unpack the components, you should inspect them for damage.

If undamaged, consider saving the box and packing materials in case you need to
repackage the components for shipment. For information about shipping equipment,
see Appendix C “Storage and Shipment” .

Inspecting the components for damage

After you unpack the components, examine the connectors, ports, LEDs, and screen
for damage. Be sure to check the top, bottom, and front panels.

If you find damage, contact Viavi Customer Care at 1-844-GO-VIAVI. For the latest TAC
information, go to http://www.viavisolutions.com/en/services-and-support/support/tech-
nical-assistance.

For information about returning equipment, see “Returning equipment to Viavi” on
page 263.

Accessories

Table 4 lists some of the accessories available for the instruments.

Table 4 Accessories

Accessory Description

Transceivers A variety of Viavi recommended SFP, SFP+, XFP, QSFP+,
QSFP28, and CFP transceivers (and adapters) are available
for testing optical circuits. Be certain to only use Viavi recom-
mended transceivers and adapters with your test instrument.
Each of the transceivers and adapters offered by Viavi as an
accessory is MSA compliant, and has been qualified for use
with your instrument. A list of Viavi recommended optics
shipped with your instrument or upgrade Kkit.

For a list of currently supported optics, contact your Viavi TAC
representative or your local Viavi sales office. Please refer to
your transceiver (or adapter) manufacturer’s site for detailed
specifications.

Cables A variety of Viavi-recommended optical cables are available for
connecting to the circuit you are testing.

TB/MTS-5800- The 5800 Ethernet Pairing Partner is an accessory used for

EPP enhanced RJ-45 Ethernet cable diagnostics. It includes two
RJ-45 ports, one for completing a wire-map test with a TB/
MTS-5800 and the other for performing a shield ground conti-
nuity test with the RJ-45 connector on port 2 of a TB/MTS-
5882.

T-BERD/MTS/SC Getting Started Guide
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Table 4 Accessories (Continued)

Accessory Description

TB/MTS-5800- The 5800 Time of Day accessory is a USB powered accessory

TOD that accepts two (2) RS-422 interfaces on an 8 pin RJ interface
(8P8C — 8 position 8 contact). The Time of Day messages are
passed to the TB/MTS-5800 mainframe via a USB type B
(Mini-B) connector. The One-Pulse-Per-Second (1 PPS) sig-
nals are presented to the 5800 on an SMA coaxial interface.

Attenuators A variety of Viavi-recommended attenuators are available for
attenuating transmitted and received signals if necessary.

Rack Mount This kit allows you to mount various devices in a 19 inch rack.

Hard case A hard case allows you to protect your test instrument.

Soft case Light weight cases allow you to store your test instrument when

it is not being used.

The MSAM cases are designed to hold a single base unit with
a single MSAM. A PIM carrying case is also available, which
can store up to three PIMs. In addition to the MSAM and PIM
cases, a transceiver case designed to accommodate up to six
SFPs and three XFPs is available.

Refer to the 8000 Base Unit User Manual or 6000A Base Unit User Manual for a list of
accessories offered for the base unit.

NOTE:

x For additional information about available configurations, options, and ser-
vices, contact your local Viavi representative or contact Viavi via the com-
pany web site, www.viavisolutions.com.

Optional Expansion Modules

Table 5 lists the available optional expansion modules for the product families and test
instruments that are supported in this manual. The expansion modules are configured
and offered with different capabilities. For example, different Optical Time-Domain
Reflectometer (OTDR) Modules are available that support singlemode, multimode,
short range, long range, extended range, and passive optical network (PON) fiber
testing.

In addition to providing specific capabilities, each expansion module is designed to
support specific product families, and is compatible with specific versions (models) of
any given test instrument that is part of the product family. For example, the Timing

T-BERD/MTS/SC Getting Started Guide
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Expansion Module (TEM) is designed to support the 5800 product family, and is only
compatible with the 5800v2 and 5800-100G test instruments.

Table 5 T-BERD/MTS Platform Expansion Modules

Modules Used to

OTDR Measure and characterize fiber loss. OTDR expansion
modules are available to test:

— 850 nm and 1300 nm multimode fibers spanning
short distances;

— 1310 nm, 1550 nm, and/or filtered 1625 nm single-
mode fibers spanning long distances;

— 1310 nm, 1550 nm, and/or filtered 1625 nm single-
mode fibers supporting extended distances (metro
access);

— 1310 nm, 1490 nm,1550 nm, and/or filtered 1625 nm
singlemode fibers supporting passive optical net-
works (PON);

— Multimode (850 nm and 1300 nm) and singlemode
(1310 nm and 1550 nm) fibers.

All modules allow you to measure and characterize fiber
loss; others also support work flow optimization and accu-
rate fibre-link fingerprinting.

CDWM Optical Characterize fiber links with exact CWDM wavelengths

Spectrum Analyzer per ITU-T G.694.2, and simulate a CWDM transmitter

(COSA) for insertion loss testing and end-to-end continuity
checks.

TEM Provide a high accuracy timing reference when testing

using a 5800v2.

NOTE:

D For additional information about the expansion modules that are available
for your test instrument, contact your local Viavi representative, or contact
Viavi via the company web site, www.viavisolutions.com. Data sheets with
specifications and product family brochures are also available on the site.

About the T-BERD / MTS 5800 and SC 4800

The T-BERD / MTS 5800 (shown in Figure 1) and Smart Class 4800/4800P (shown in
Figure 2) family of testers are designed to be rugged, portable, battery-operated test
solutions that facilitate the quick turn-up and troubleshooting of multiple services and
network elements in the Metro and Core network. This allows providers who are
expanding their offerings into new data and wavelength services to deploy a single

T-BERD/MTS/SC Getting Started Guide
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About the T-BERD / MTS 5800 and SC 4800

technician to install and maintain new elements and services using one integrated
instrument.

Figure1 T-BERD /MTS 5800-100G

Configuring the T-BERD / MTS 5800 and SC 4800

The T-BERD / MTS 5800 and SC 4800 units are factory-configured to meet your
testing requirements.

When you place an order for a 5800 or 4800, a customer service or sales representative
will help you determine the right configuration for your needs.

T-BERD/MTS/SC Getting Started Guide
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Table 6 describes the available configurations.

Table 6 T-BERD /MTS 5800 and SC4800 configurations

Catalog Number

Configuration

TB/MTS-5801
TB/MTS-5802
TB/MTS-5812
TB/MTS-5812LB

TB/MTS-5801P
TB/MTS-5802P
TB/MTS-5812P

TB/MTS-5811P

TB/MTS-5811PG

TB/MTS-5811PL
TB/MTS-5882

TB/MTS-5822P

TB/MTS-5822PG

TB/MTS-5800-
100G

TB/MTS-5800-
100GG

SC4800
SC4800P

T-BERD / MTS 5800 Single Port Test Instrument
T-BERD / MTS 5800 Dual Port Test Instrument
T-BERD / MTS 5800 10g and Dual Port Test Instrument

T-BERD /MTS 5800 10G and Dual Port Loop Back Device
(used for loop back applications only; no traffic generation)

T-BERD / MTS 5800 Single Port Test Instrument with PDH
T-BERD / MTS 5800 Dual Port Test Instrument with PDH

T-BERD / MTS 5800 10G and Dual Port Test Instrument with
PDH

T-BERD/MTS 5800 V2 Single 10G Port Test Instrument with
PDH

T-BERD / MTS 5800 V2 Single 10G Port Test Instrument with
PDH, no WiFi / Bluetooth

T-BERD /MTS 5800 V2 Single 10G Port with T1/E1

T-BERD / MTS 5800 Dual 10G Port Test Instrument with
PDH and internal GNSS receiver

T-BERD / MTS 5800 V2 Dual 10G Port Test Instrument with
PDH

T-BERD / MTS 5800 V2 Dual 10G Port Test Instrument with
PDH, no WiFi / Bluetooth

T-BERD / MTS 5800-100G Test Unit with internal GNSS
receiver

T-BERD / MTS 5800-100G Test Unit with internal GNSS
receiver, no WiFi / Bluetooth

Smart Class 4800 Single Port Test Instrument
Smart Class Single Port Test Instrument with T1/E1 port

Page 10
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NOTE:

D Some configurations also require you to purchase and install certain testing
options; others require specific hardware connectors to connect to circuits
for testing. For example, if your instrument does not have a connector
designed to support 1GigE Optical testing, you can not transmit and ana-
lyze a signal or traffic over a 1GigE circuit. OTDR testing and testing using
GNSS timing requires the connection of supporting OTDR and TEM mod-
ules or an internal GNSS receiver.

You can quickly determine whether or not your instrument supports certain
applications by exploring the technologies, rates, and test modes presented
on the Test menu and by reviewing the settings available when you config-
ure a test.

To discuss a specific configuration or to order accessories for your 5800 or 4800,
contact Viavi Customer Care or your regional sales office. Contact information for
regional sales headquarters is provided on the back cover of this manual. You can also
contact Viavi through the company web site, www.viavisolutions.com.

Exploring the SC 4800 and T-BERD / MTS 5800

Smart Class 4800

The connector panels on SC 4800 and 4800P have one 10/100/1000 port and one
SFP+ port. SC 4800P has an additional DS1/E1 port.

Figure 3 SC 4800 connector panel

T-BERD/MTS/SC Getting Started Guide
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Figure 4 SC 4800P connector panel

10/100/1000M connector

A 10/100/1000M connector allows you to connect the SC 4800 to an electrical Ethernet
circuit to transmit and analyze traffic.

SFP+ connector

The SFP+ connector allows you to connect the SC 4800 to 1 Gigabit Ethernet, 100 FX,
or 100M Ethernet circuit to transmit and then analyze traffic.

DS1/E1 connector (on SC 4800P only)

One balanced 120 Ohm RJ 48 transmitter/receiver allows you to connect the 4800 to
an E1 (2M) circuit to transmit and analyze traffic.

NOTE:

The E1 and DS1 interfaces should not be connected at the same time. After
running your test, disconnect from one interface before connecting to the
other interface.

T-BERD/MTS/SC Getting Started Guide
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T-BERD / MTS 5800

The connector panel of the T-BERD / MTS 5800 provides the connectors and SFP+
connectors (and QSFP/CFP4 on 5800-100G) used to connect the instrument to the
circuit for testing.

Figure 5 T-BERD /MTS 5800-100G connector panel

After selecting a test application, LEDs illuminate indicating which connectors to use for
your test.

SFP+ connectors
Two SFP+ connectors allow you to connect the 5800 to a SONET, SDH,

1 Gigabit Ethernet, 10GigE, 100 FX, or 100M Ethernet circuit to transmit and then
analyze traffic.

QSFP/CFP4 connectors

The QSFP connectors provide 40G and 100G capabilities, so capabilities cover
QSFP+/QSFP28. The CFP4 port is for 100G usage.

E3/DS3/STS-1/E4/STM1(e) connectors

One Tx/Rx pair or two receivers allow you to connect the 5800 to an E3, DS3, STS-1,
E4, or STM-1e circuit to transmit and analyze traffic.

10/100/1000M connectors

Up to two 10/100/1000M connectors allow you to connect the 5800 to an electrical
Ethernet circuit to transmit and analyze traffic.

March 2018
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E1 connectors
Two unbalanced 75 Ohm BNC receivers, and one unbalanced 75 Ohm BNC transmitter

allow you to connect the instrument to an E1 (2M) circuit to transmit and analyze traffic.
The Rx 2 receiver can be used as the input for a SETS signal or an E1 reference clock.

E1 RJ 48 transmitter/receiver

One balanced 120 Ohm RJ 48 transmitter/receiver allows you to connect the 5800 to
an E1 (2M) circuit to transmit and analyze traffic.

NOTE:

D The E1 and DS1 interfaces should not be connected at the same time. After
running your test, disconnect from one interface before connecting to the
other interface.

DS1 connectors
Two DS1 Bantam receivers and one DS1 Bantam transmitter allow you to connect the

5800 to a DS1 circuit to transmit and analyze traffic. The Rx 2 receiver can be used as
the input for a DS1 BITS signal.

EXT CLK connector

SMA connector for external clock input. Use the SMA to BNC barrel adapter if a BNC
connector is needed (applicable to MSAM v1 only).

Headset/handset connector

Use the headset connector when dropping voice traffic from a DSO0 interface.

USB host connector

Located on the right side of the unit, the two USB host connectors (USB 2.0) allow
connection of a USB drive, or other USB device.

LAN connector

Located on the right side of the unit, the RJ-45 LAN connector is used to connect to
your local network.

About the CSAM Assembly

The CSAM is used in combination with the T-BERD/MTS 6000A base unit, the
T-BERD /MTS 6000AV2 base unit or a T-BERD/MTS 8000 base unit with a DMC
chassis. Each CSAM is factory-configured to meet your unique testing requirements.

Page 14
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Figure 6 T-BERD/MTS 6000AV2 with CSAM user interface

When you place an order for an CSAM, a customer service or sales representative will
help you determine the following:

*  Whether you want to use the CSAM with a T-BERD/MTS 6000A base unit, or
with a T-BERD/MTS 8000 base unit with a Dual Module Carrier (DMCv2).

* If you ordered a CSAM that provides CFP or QSFP+ connectors; associated
transceivers (and potentially CFP adapters) are required. A variety of
Viavi-approved adapters and transceivers are available.

For assembly instructions, see “Inserting MSAMs or CSAMs into the 6000A base unit
or DMC” on page 35. All dual port applications require two connectors. CFP and QSP+
adapter and transceiver specifications vary depending on the manufacturer.

Exploring the CSAM connector panel

The CSAM connector panel provides the connectors used to connect the module to the
circuit for testing. See Figure 7.

Figure 7 CSAM Connector Panel
r |
-. F - - F

' I
CFPZ 40/1000

L 4
Clock out/1PPS External Clock CFP2 QSFP+ SFP+
connector Reference 40/100G connectors 40G connectors  connectors
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External Clock Reference and Clock Out/1PPS connectors

These connectors provide input/output of synchronization reference signals (BITS,
SETS, 2.048MHz, and 100Mhz) and allow you to connect the CSAM to external
sources to obtain synchronization timing signals. The Clock Out/1PPS connector can
be used as an input or output.

CFP2 40/100G connectors

A single CFP connector (labeled CFP2 40/100G) supports a CFP2 transceiver, and
allows you to connect the CSAM to a 40G SONET/SDH, 40 or 100G Ethernet, or OTU3
(43.02 G)/OTU4 (111.8 G) circuit to transmit and then analyze traffic during testing. You
can also use a CFP2 to QSFP28 adapter to connect to and perform tests on 100G
Ethernet or OTU4 (111.8 G) circuits; or a CFP2 to CFP4 adapter and a CFP4 trans-
ceiver.

QSFP+ 40G connectors

A single QSFP+ connector (labeled QSFP+ 40G) supports QSFP+ transceivers, and
allows you to connect the CSAM to a 40G SONET/SDH, 40G Ethernet, or OTU3
(43.02 G) circuit to transmit and then analyze traffic during testing (for more information
about the rates, check with your customer documentation).

MPO connectivity

LR4 interfaces for 40G and 100G connectivity are based on regular single mode fibers
and use LC connectors.

SRx interfaces are based on multimode ribbon cables and use MPO connectors.

MSA compliant QSFP+ transceivers (with a 40GBASE-SR4 interface) and a CFP2 to
QSFP28 adapter (with a 100GBASE-SR4 interface) have been qualified by Viavi for
use with the CSAM. CFP transceivers and adapters (with a 100GBASE-SR10 inter-
face) have also been qualified.

40GBASE-SR4 and 100GBASE-SR4 interfaces use single row MPO connectors with
12 fiber terminations (as illustrated in Figure 8).

Figure 8 12-fiber MPO connector
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100GBASE-SR10 interfaces use double row MPO connectors with 24 fiber termina-
tions (as illustrated in Figure 9).

Figure 9 24-fiber MPO connector

SFP+ connectors

Two SFP connectors allow you to connect the CSAM to a SONET, SDH,

1 Gigabit Ethernet, 100 FX, 100M, or 1, 2, or 4 Gigabit Fibre Channel circuit to transmit
and then analyze traffic during testing. If your instrument is configured and optioned to
do so, you can also analyze IP Video traffic on the Ethernet circuits. OTU-1 connections

are only supported on PORT# 1.

About the MSAM Assembly

The MSAM is used in combination with the T-BERD/MTS 6000A base unit, the
T-BERD /MTS 6000AV2 base unit or a T-BERD/MTS 8000 base unit with a DMC
chassis. Each MSAM is factory-configured to meet your unique testing requirements.

Figure 10 T-BERD/MTS 6000A with MSAM user interface
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Figure 11 T-BERD/MTS 6000AV2 with MSAM user interface
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When you place an order for an MSAM, a customer service or sales representative will
help you determine the following:

Whether you want to use the MSAM with a T-BERD/MTS 6000A base unit, or
with a T-BERD./MTS 8000 base unit with a Dual Module Carrier (DMC).

The type of MSAM chassis required (for example, you can order a single or dual

port chassis that supports PIMs designed for 1.544 Mbps through 10 Gigabit
testing).

The PIM (or PIMs) required for testing 1.544 Mbps through 10 Gigabit circuits. If
you ordered a dual port chassis and you intend to use both ports simultaneously
(for example, in dual port through mode), PIMs should be ordered for both ports.

If you ordered an SFP or XFP PIM, the transceivers are required. A variety of
Viavi-approved SFP and XFP transceivers are available for each PIM.

The plug in panel of each MSAM provides one or more physical interface module (PIM)
ports. Before connecting the instrument to the circuit for testing, you must insert the
required PIMs into the ports, and then insert the appropriate SFPs or XFPs into the
transceiver cages provided on the PIMs.

Page 18
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MSAM chassis

Each MSAM chassis provides the application module software, one or two PIM ports,
and a 75 OHM BNC connector (used for external timing). Several types of chassis are
available; therefore, your unit may not have both of the ports illustrated in Figure 12.

Figure 12 MSAM chassis (dual port with XFP and SFP PIMs)

MSAM chassis

BNC connector

XFP PIM with one  SFP PIM with two
transceiver cage transceiver cages

NOTE:

D The MSAMvV2 chassis has an additional USB host connector to the right of Port
2 and the BNC EXT REF connector is replaced with a SMA CLK |/O connector.

Table 7 lists the available MSAM chassis.
Table 7 MSAM chassis

ﬁ:::ll;?r Description

C0400 Single Port 1.544 Mbps to 4 Gbps

C0400-v2 Single Port 1.544 Mbps to 10 Gbps

C0404 Dual Port’ 1.544 Mbps to 4 Gbps

C0404-v2 Dual Port 1.544 Mbps to 6 Gbps

C1000 Single Port 1.544 Mbps to 10 Gigabit

c1000LB Single Port 10 Mbps to 10 Gbps Loopback Only

C1004 Dual Port' — One 1.544 Mbps to 10 Gbps port
— One 1.544 Mbps to 4 Gbps port

C1010-v2 Dual Port 1.544 Mbps to 10 Gbps

1. A dual port chassis is required if you intend to use the MSAM for OTN testing.

T-BERD/MTS/SC Getting Started Guide
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USB connector

The MSAMv2 USB connector provides analog audio using a Viavi analog headset and
USB-to-analog adapter. When using the MSAMv2, the audio from the MSAMv2 is used
(USB audio from the base unit is disabled). USB 2.0 is not supported. For best audio
quality, the switch on the headset should be set to the lowest position (the smallest of
the three dots, closest to the wire).

SMA connector

The MSAMv2 SMA connector provides access to external reference timing

CAUTION: DAMAGE TO COMPONENTS

Use caution when connecting the cable to the SMA connector. Over-tight-
ening could damage internal components. Finger tighten only.

For assembly instructions, see “Inserting MSAMs or CSAMs into the 6000A base unit
or DMC” on page 35.

MSAM PIMS

Table 7 lists the PIMs available for testing from various interfaces using the MSAM.

Table 8 MSAM PIMs

o Compatible
Catalog Number  Description Chassis
CPHSDATA Data communications PIM with universal data  C0404
communications connector. C1004
C0404-v2
C1010-v2
CPCDI Diphase PIM with dual BNC connectors C0404
C1004
C0404-v2
C1010-v2
CPDS1BANT DS1 jitter capable PIM with Bantam connector Al
A DS1 PIM is shown in Figure 15 on page 22.
CPE1BNC E1 jitter capable PIM with BNC connector All
An E1 PIM with a BNC connector is shown in
Figure 16 on page 23.
CPE1RJ48 E1 jitter capable PIM with RJ-48 connector All
CPE3DS3BNC E3/DS3/STS-1 jitter capable PIM All
An E3/DS3/STS-1 PIM is shown in Figure 17
on page 23.

T-BERD/MTS/SC Getting Started Guide
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Table 8 MSAM PIMs (Continued)
o Compatible
Catalog Number  Description Chassis
CPE4STM1BNC E4/STM-1e jitter capable PIM with All

BNC connector

An E4/STM1(e) PIM is shown in Figure 18 on
page 23.

CPSFP SFP PIM All
Provides two transceiver ports, allowing you
to insert two transceivers designed to support
different wavelengths. Only one transceiver
can be used for testing at a time.
An SFP PIM is shown in Figure 12 on
page 19.

CPSFPPLUS SFP+ PIM All

Provides two transceiver ports, allowing you
to insert two SFP or SFP+ capable transceiv-
ers designed to support different wavelengths.

CPXFP XFP PIM C1000
Provides one transceiver port. C1004
An XFP PIM is shown in Figure 12 on c1000LB
page 19. C1010-v2

CPRJSYNCE SyncE PIM All

Photos of the HS Datacom and Diphase PIMs are provided in Figure 13 and Figure 14.

Figure 13 Datacom PIM
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Figure 14 Diphase PIM

Photos of the DS1, E1 BNC, E1 RJ-48, E3/DS3/STS-1, and E4/STM-1e PIMs are
provided in Figure 15 on page 22 through Figure 18 on page 23.

Figure 15 DS1 PIM
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Figure 16 E1 BNC PIM

Figure 18 E4/STM1(e) PIM
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For assembly instructions, see “Inserting, removing, and swapping PIMs in the MSAM”
on page 37.

Restrictions

With the introduction of the MSAMv2, 6000Av2, and 8000v2, new applications are
enabled due to variations in the design. If you require voice support for DS VF and VolP
you are encouraged to use a MSAMv2 with all versions of the 6000A and 8000 main-

frames.

About the DMC Assembly

The DMC chassis is used with the T-BERD/MTS 8000 base unit. It provides two
MSAM or CSAM slots, allowing you to insert two MSAMs and up to four PIMs, or two
CSAMs. This provides connections for testing up to four independent circuits simulta-
neously.

Figure 19 T-BERD/MTS 8000 base unit with a DMC

MSAM or
CSAM slot

MSAM or
CSAM slot

Figure 19 shows a DMC connected to a base unit. For assembly instructions, see
“Connecting a DMC to a base unit” on page 28.

Base unit requirements

if you intend to test using two MSAMs or CSAMs in a DMC chassis, verify that the
T-BERD/MTS 8000 base unit satisfies the requirements stated in Table 9 on page 28.

If your base unit does not satisfy the DMC requirements, contact Viavi Customer Care
for instructions on returning the base unit for a factory upgrade. For details, see
“Returning equipment to Viavi” on page 263.
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Restrictions

With the introduction of the MSAMv2 and 8000v2, new applications are enabled due to
variations in the design. If you require voice support for DS VF and VolIP you are
encouraged to use a MSAMv2 with all versions of the 8000 mainframes.

Viavi recommended optical adapters and transceivers

To ensure proper operation of your instrument during testing, we strongly recommend
purchasing the required adapters and transceivers from Viavi. These components have
been tested to verify that they will perform reliably with our test instruments.

A list of recommended optics can be found by selecting Recommended Optics from
the Help menu. Or you can obtain the list by contacting Viavi Customer Care, or con-
tacting Viavi via the company web site, www.viavisolutions.com.
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Assembling Your Instrument

This chapter explains how to assemble the components of your T-BERD / MTS 5800,
MSAM, or CSAM before testing. Topics discussed in this chapter include the following:
*  “Preparing for assembly” on page 28

*  “Connecting a DMC to a base unit” on page 28

*  “Inserting MSAMs or CSAMs into the 6000A base unit or DMC” on page 35

* ‘“Inserting, removing, and swapping PIMs in the MSAM” on page 37

*  “Attaching an expansion module to the 5800v2/100G and 5882” on page 40

* “Handling CFP adapters and transceivers” on page 43

* “Handling SFP/SFP+, XFP, and QSFP+ transceivers” on page 48

e  “Attaching an external optical connector” on page 51

*  “Disconnecting the DMC” on page 52
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Preparing for assembly

Preparing for assembly

Before you unpack the components that comprise your test instrument, review the
following instructions in Chapter 1 “Overview”:

*  “Unpacking the components” on page 5
*  “Inspecting the components for damage” on page 6

Connecting a DMC to a base unit

Before connecting your DMC to a T-BERD/MTS 8000 base unit, review the key prin-
ciples and base unit requirements, and gather the proper tools.

Key principles

When connecting or disconnecting the instrument components, focus on the following
principles to ensure a secure connection and avoid damaging the connectors:

Sequence. If you are connecting a DMC to an 8000 base unit, the DMC must be
connected directly to the base unit with no modules between the base unit and the
DMC. If you are connecting two DMCs, they must be the first two modules attached,
and the first DMC must be connected directly to the base unit. You can attach additional
modules after connecting the DMC (or DMCs) to the base unit.

Alignment. Ensure that the holes on the corners of the DMC, or Battery Module are
aligned with the holes on the component you are attaching it to. For example, if you are
attaching the DMC to the base unit, ensure that the holes of the DMC are aligned with
the holes on the base unit.

Parallel position. Ensure that you are holding the DMC, or Battery Module in a position
parallel to the base unit or DMC. If either module is held at even a slight angle, there is
a risk of damage to the connectors.

Proper torque. Ensure that you tighten the screw using the hex key (for the DMC) or
a flat blade screwdriver (for the Battery Module) until you feel a slight resistance, and
then tighten it using an additional 1/4 turn. If you are using a torque wrench, apply
1.5 N-m (13.3 in-Ib) to the final turn.

Verifying the base unit requirements

Before connecting a DMC to a base unit, verify that the base unit satisfies the require-
ment stated in Table 9.

Table 9 T-BERD/MTS 8000 base unit requirements

Requirement DMC

Serial number of 336 or above X
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Table 9 T-BERD/MTS 8000 base unit requirements

Requirement

DMC

Touch screen

Hard drive

BERT Software Version 5 or above
BERT Software Version 7.0 or above
BERT Software Version 8.0 or above
BERT Software Version 14.0 or above
400MHz CPU

1000MHz CPU

256 MB DRAM

2GB DRAM

X
X

1. Software version 8.0 can also be run on the MSAM assemblies.

To verify the requirements on a base unit

1 Press the SYSTEM/HOME key.

>

NOTE:

Depending on the version of T-BERD/MTS 8000 base unit you have, the

key may be labeled SYSTEM or may be labeled HOME (on UIMv2).

To verify the current BERT software version, select the Help Page soft key.

Under Software Version Information, observe the BERT software version.

— If the software version is lower than Version 5.0, you must upgrade the soft-
ware on your base unit before connecting a Version 2 Transport Module.

— If the software version is lower than Version 7.0, you must upgrade the soft-
ware on your base unit before connecting a Version 3 Transport Module.

— If the software version is lower than Version 8.0, you must upgrade the soft-
ware on your base unit before connecting a DMC.

To verify the CPU speed and DRAM, select the Services Data soft key.

Under Services Data, check the CPU speed and the Memory.

If your base unit does not meet the requirements stated above, contact Viavi Customer
Care for assistance.

Required tools

Large, flat blade screwdriver. You will need a large, flat blade screwdriver to
remove and then replace the battery module on the base unit.

Hex key. A hex key is provided in a groove on the inside panel of the battery
module. This key is used to secure and then tighten the screws that connect the

DMC to the base unit.
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Connecting the components

To connect the DMC to a base unit

1 Verify that power is OFF on your base unit and the power adapter is unplugged.

2 Using the large flat blade screwdriver, loosen each of the 4 slotted bolts on the
back panel of the battery module (attached to the base unit).

3 Disconnect the battery module from the base unit, and then remove the hex key
from the groove on the inside panel of the battery module. See Figure 20.

Figure 20 Hex key groove in battery module

Hex Key
groove

4 The base unit and DMC have rectangular mating connectors.

Figure 21 Base Unit Mating Connector

Base Unit Mating Connector
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These connectors must be aligned carefully before connecting the module to the
base unit.

Figure 22 DMC Mating Connector

DMC Mating Connector

a To align the connectors properly, place the base unit with the screen side
down on your work surface. The mating connector on the back panel should
be facing you, at the top side of the unit

b Position the DMC over the base unit, with the DMC’s mating connector
directly over the mating connector on the base unit.

¢ Verify that the holes on each corner of the DMC are aligned precisely with the
holes on each corner of the base unit.

d IMPORTANT: Verify that you are holding the DMC in a position parallel to the
base unit. If the module or DMC is tilted at even a slight angle, the mating
connectors may not connect properly.

e Slowly lower the DMC until it is just over the holes on the base unit, and then
gently but firmly press the center of the module to attach it to the base unit.
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5 Starting at the upper right corner, do the following:

a

Using the hex key that you removed from the battery module, tighten screws
1 through 4 (in the sequence illustrated in Figure 23) until you feel a slight
resistance. The same sequence is used when attaching a DMC.

After all four screws are tightened, using the hex key, tighten each screw at
least one additional quarter-turn in the sequence illustrated in Figure 23.

Figure 23 Sequence for securing and tightening the screws

6 After the DMC is secured to the base unit, put the hex key back in the battery
module, and then do the following:

a

Position the battery module over the DMC, with the battery module’s mating
connector directly over the mating connector on the DMC.

Verify that the holes on each corner of the battery module are aligned
precisely with the holes on each corner of the DMC.

IMPORTANT: Verify that you are holding the battery module in a position
parallel to the DMC. If the module is tilted at even a slight angle, the mating
connectors may not connect properly.

7 Slowly lower the battery module until it is just over the holes on the DMC, and
then gently but firmly press the center of the battery module to attach it to the
DMC.

8 Starting at the upper right corner, do the following:

a

Using the large flat blade screwdriver, tighten screws 1 through 4 until you
feel a slight resistance. Use the same sequence illustrated for the DMC
screws in Figure 23.

After all four screws are tightened, tighten each screw at least one additional
quarter-turn.
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The DMC is connected to the base unit. It is completely assembled, and can be used
for testing.

Before testing using the DMC, you must insert the MSAM(s) and the appropriate PIMs
or the CSAM(s) for the circuits you intend to test. For details, see “Inserting MSAMs or
CSAMs into the 6000A base unit or DMC” on page 35 and “Inserting, removing, and
swapping PIMs in the MSAM” on page 37.

Connecting two DMCs to a base unit

If you intend to connect two DMCs to a base unit for testing, verify that you are using
an AC power adapter that can support your instrument assembly. To discuss the vari-
ous power adapters available for your instrument, contact Viavi Customer Care, or
contact Viavi via the company web site, www.viavisolutions.com.

Disconnecting the DMC

Before disconnecting the DMC from the base unit, review the “Key principles” on
page 28 for assembling the instrument. The same principals apply when disassembling
the various components.

Required tools

Large, flat blade screwdriver

You will need a large, flat blade screwdriver to remove the battery module.

Hex key (provided)

A 5 mm hex key is provided in a groove on the inside panel of the battery module. This
key is used to secure and then tighten the screws that connect the module to the base
unit.

Torque wrench (optional)
If you want to ensure that you don’t apply too much pressure when connecting or
disconnecting components, you can optionally use a torque wrench capable of applying

13.3 in-Ib. A torque wrench with the ability to apply up to 20 in-lIb in 0.1 in-lb increments
will be adequate. You will also need a 5 mm hex key bit for the wrench.

Disassembling the instrument

To remove the DMC from a base unit

1  Verify that power is OFF on your base unit and that the power adapter is
unplugged.
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2 Using the large flat blade screwdriver, loosen each of the 4 slotted bolts on the
back panel of the battery module (attached to the base unit), and then gently
remove the battery module.

3 Use the provided hex key to loosen screws 1 through 4 in the sequence illustrated
in Figure 23 on page 32.

4  Turn the base unit over so the display is facing upwards.

Disconnect the DMC from the base unit by gently pressing upwards on the two
lower bumpers of the base unit as illustrated in Figure 40 on page 53.

Figure 24 Bumpers (Base Unit)

Press Up Bumpers

IMPORTANT: When lifting the base unit, be certain to apply force directly over the
base unit mating connector (illustrated in Figure 21 on page 30). The lower
bumpers are located on the front (display) panel of the base unit, and they are
parallel with the mating connector provided on the bottom (connector) panel. In
Figure 40, the base unit mating connector is not visible; it is directly above the
mating connector of the DMC.

6 After the base unit is completely disengaged from the DMC, lift it up further and
place it elsewhere on your work surface.

The instrument is disassembled.
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Inserting MSAMs or CSAMs into the 6000A base unit or DMC

Before inserting an MSAM or CSAM into the 6000A base unit or DMC, review the
MSAM or CSAM requirements, and gather the proper tools.

IMPORTANT:
0 Be certain the base unit is powered OFF and the AC power adapter is

unplugged before inserting or swapping MSAMs or CSAMs.

MSAM requirements

Before inserting an MSAM into a DMC, verify that the MSAM is labeled as DMC-
compatible. If it is not, you must return it to Viavi for a factory upgrade before using it
with a DMC.

DMC-compatible MSAMs can be inserted into any T-BERD/MTS 6000A base unit or
DMC; MSAMs that are not compatible with the DMC must be used with a
T-BERD/MTS 6000A base unit. A 90W or 150W power supply is also required.

CSAM requirements

When using a CSAM in a T-BERD/MTS 6000A base unit, the base unit must be a
6000Av2, and the module carrier within the 6000Av2 must be an E6300. A 150W power
supply is also required.

If the CSAM is not compatible with the module carrier of the 6000Av2, the software will
prevent you from using the instrument to test.

Required tools

You will need a large, flat blade screwdriver to secure the MSAM or CSAM in the
T-BERD/MTS 6000A base unit or the DMC chassis.

Inserting the MSAM or CSAM

To insert the MSAM or CSAM

1  Verify the following:
— Power is OFF on your base unit.
— The AC power adapter is unplugged.

2 Place the base unit on a flat surface, with the screen facing down, and the appli-
cation module slots on the base unit or DMC chassis facing towards you.
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3 Hold the MSAM or CSAM with the exterior panel facing towards you. The thumb
screws should be at the top of the panel.

Figure 25 MSAM inserted into the DMC chassis

Screw

I PIM Ejection
Ejection
Screw Button Ports Button

4 Align the MSAM or CSAM with the application module slot, and then gently but
firmly slide it into the slot. Figure 25 shows an MSAM in a DMC application
module slot; a similar slot is also available on the T-BERD/MTS 6000A base unit.

5 Place your thumbs just below each of the thumbscrews on the top of the panel,
then push the MSAM or CSAM into the slot until the exterior panel is flush with the
side panel of the base unit or DMC chassis (see Figure 26 and Figure 27).

Figure 26 Fully inserted MSAM

—
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Figure 27 DMC with CSAM inserted (left) and MSAM v2 inserted (right)

6 Using the screwdriver, tighten each screw. You can also use your fingers to
tighten the screws; however, using the screwdriver will ensure a more secure
connection.

The MSAM or CSAM is connected to the base unit or DMC chassis.

Inserting, removing, and swapping PIMs in the MSAM

Inserting a PIM

After connecting the MSAM to the base unit or DMC chassis, you can insert up to two
PIMs into the two ports provided on the MSAM. The PIM(s) will provide the physical
interfaces that you need to connect to the circuit for testing.
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To insert a PIM into the MSAM

1 Verify that the MSAM is designed to support the PIM that you intend to insert by
doing the following:

— Ifyou are inserting an SFP PIM, it will work with any available MSAM chassis,
in any port. Simply look at the PIM label to verify that it is an SFP PIM.

Figure 28 SFP PIM and SFP transceivers

— Ifyou are inserting an XFP PIM, it requires a high rate MSAM chassis. These
chassis are labeled with a C1000, C1004, C0400-v2, C0404-v2, or C1010-v2
model number on the exterior panel. After verifying that the chassis can
support the PIM, look at the PIM label to verify that it is an XFP PIM.

Figure 29 XFP PIM and XFP transceiver

2 Place the base unit on a flat surface, with the screen facing down, and the exterior
panel of the MSAM facing towards you.

3 Ifyou are inserting the PIM into a dual port chassis, determine which port to insert
the PIM into.

— If you are inserting an SFP PIM, you can use any port (all MSAM ports
support 10 Mbps to 4 Gbps interfaces).

— If you are inserting an XFP PIM, in most instances you must use the left port
(labeled Port #1).

— If you have a dual 10G MSAMv2 (labeled C1010-v2), you can insert the XFP
PIM on either port.
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4  After verifying that the port is designed to support the same physical interface(s)
as the PIM, align the PIM with the transceiver cages facing you, and the internal
connectors facing down towards the interior of the port.

5 Insert the PIM into the port (see Figure 30).

Figure 30 XFP PIM in Port #1

6 Push the PIM into the port until the PIM panel is flush with the exterior panel of the
chassis, and the PIM ejection button pops out.

The PIM is inserted.

Removing a PIM
There are two types of PIMs: single port and dual port. The single port PIMs fit into a

single port (for example, the DS1 PIM); dual port PIMs are wider and use both ports (for
example, the datacom PIM). Thus, there are slightly different ways to remove the PIMs.

To remove a single port PIM

1 On the exterior panel of the MSAM chassis, press the PIM ejection button.
The PIM is released.

2 Pull the PIM out of the port.
To remove a dual port PIM

1 Rotate the long front lever. This will press both of the PIM ejection buttons.
The PIM is released.
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2

Pull the PIM out of the ports.

The PIM is removed from the MSAM chassis.

Swapping PIMs

If you need to swap PIMs during testing, you must turn the BERT (MSAM) module off,
remove one PIM, and then insert another. If you are swapping PIMs in two MSAMSs in
the DMC, be certain to turn the BERT (MSAM) module off for both MSAMSs. You do not
need to turn OFF the instrument.

>

NOTE:

If you do not turn the BERT (MSAM) module off, you will lose the settings for
the last test you configured, and your MSAM may not launch the expected test
application automatically when you insert a different PIM.

To swap PIMs

1

Press the SYSTEM/HOME button to display the System screen, then turn the icon
representing the BERT (MSAM) module off. The BERT (MSAM) module can be
toggled on or off by selecting the BERT icon. When off, the icon is grey.

Press the Results soft key to go to the MSAM status screen, and then verify that
the module is off by observing the Message bar at the top of the screen. When off,
the message states:

BERT Module OFF

After verifying that the BERT (MSAM) module is off, remove the PIM (see
“Removing a PIM” on page 39).

Insert the new PIM (see “Inserting, removing, and swapping PIMs in the MSAM”
on page 37).

On the System screen, turn the BERT module back on. When on, the icon is
yellow.

The PIMs are swapped.

Attaching an expansion module to the 5800v2/100G and 5882

If you have an optional expansion module for your T-BERD / MTS 5800v2/100G or
5882 (for example, an OTDR Module or Timing Expansion Module), follow the instruc-
tions on how to attach it.

To attach a module to your instrument

1

Power down the instrument and disconnect the AC power adapter.
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2 Remove the four screws that hold the back cover in place.

3
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5 Insert the module hinges into the instrument at about a 45 to 60 degree angle.

6

7 Seat the module into the connector with slight pressure.
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8 Tighten the screws on the module.

Power up the instrument. Menus related to the attached module are now available.

Handling CFP adapters and transceivers

Inserting a CFP adapter

CFP adapters allow you to use a port designed to support a larger CFP transceiver for
a smaller CFP transceiver. For example, a CFP2 to CFP4 adapter (shown in Figure 31)
can be inserted into the CFP2 port of the CSAM to provide the physical interface that
you need to connect a CFP4 to the instrument. The release lever shown at the left of
the adapter must be pulled up before removing the adapter from a port.

Figure 31 CFP2 to CFP4 Adapter
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Or, you can insert a CFP2 to QSFP28 adapter (shown in Figure 32) into the CFP2 port
of the CSAM.

Figure 32 CFP2 to QSFP28 Adapter

NOTE:

D Details concerning the inserted adapter used for the currently selected applica-
tion appear on the CFP2 Interface setup tab. Details concerning the QSFP28
inserted into the adapter appear on the QSFP Interface setup tab.

To insert a CFP adapter

1 Ensure that the CSAM is connected to the DMC or base unit.

2 Verify that the CSAM is designed to support the CFP adapter that you intend to
insert.

3  Atfter verifying that you have the correct adapter, do the following:

a Position the instrument with the display facing towards you and the connector
panel on the top.

b  With the identification label facing you, align the adapter in the slot, and then
gently but firmly insert the adapter until the adapter panel is flush with the
exterior panel of the chassis.

CAUTION: DAMAGE TO UNIT

If you feel any resistance when first inserting the adapter into the slot (or
when tightening the retaining screws, if applicable), do not force the adapter
any further. The bottom of the adapter may be obstructed.

If this occurs, do the following:

* Remove the adapter.

*  Visually inspect the adapter for any mechanical impediments to proper
insertion. If impediments are identified, repair or replace the defective
part.

* Verify that you are inserting the adapter correctly (for example, with the
label facing you).

* Reinsert the adapter.

4 Tighten the retaining screws (if equipped) until they are finger tight.
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The CFP adapter is inserted.

Inserting a CFP, CFP2, or CFP4 transceiver

Figure 33 through Figure 35 show the CFP transceivers used to perform 40G and/or
100G out-of-service testing over fiber circuits using your instrument.

Figure 33 CFP transceiver

Before inserting a CFP, CFP2, or CFP4 transceiver consider the following:

*  Expected optical power must not exceed the power level specified for the optical
module.
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>

The recommended optics are available on your unit by selecting
Help > Recommended Optics.

NOTE:

Details concerning the inserted transceiver used for the currently selected
application appear on the Interface setup tab.

To insert a CFP, CFP2, or CFP4 transceiver

1

Obtain a transceiver that supports the physical interface you intend to test.

If you are not certain which interfaces a particular transceiver supports, refer to
the list of Viavi Recommended Optics.

If you can not locate the sheet, in most instances an online search using the
model number (printed on the transceiver label) will result in a number of hits
providing specifications for the transceiver.

After verifying that you have the correct transceiver for the interface, do the
following:

a Position the instrument with the display facing towards you and the connector
panel on the top.

b Forthe CSAM, with the identification label facing you, align the transceiver in
the slot, and then gently but firmly insert the transceiver until it is seated
securely (indicated by an audible click, or by feeling the transceiver snap into
place).

: CAUTION: DAMAGE TO UNIT

If you feel any resistance when first inserting the transceiver into the unit or
when tightening the retaining screws (if applicable), do not force the trans-
ceiver any further. The bottom of the transceiver may be obstructed.

If this occurs, do the following:
e Remove the transceiver.

*  Visually inspect the transceiver for any mechanical impediments to
proper insertion. If impediments are identified, repair or replace the
defective part.

»  Verify that you are inserting the adapter correctly (for example, with the
label facing you).

. Reinsert the transceiver.

¢ For TB/MTS 5800-100G with the identification label facing against you, align
the transceiver in the slot, and then gently but firmly insert the transceiver
until it is seated securely (indicated by an audible click, or by feeling the
transceiver snap into place).

d Tighten the retaining screws (if equipped) until they are finger tight.
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The transceiver is inserted; be certain to cover the optical connector openings
when they are not in use.

NOTE: Laser warm up requirement

D When testing 10 Gigabit, 40 Gigabit and 100 Gigabit optical circuits, some
lasers (particularly 1550 nm lasers) are temperature stabilized; and therefore
need to reach a certain temperature before you can use them to transmit a sig-
nal. This is expected behavior, and does not indicate that there is something
wrong with the laser or test instrument.

It typically takes up to one minute for the temperature to stabilize. If you have
turned the laser on, but no signal is present on the receiving instrument or
device, simply wait for one minute.

Removing a CFP, CFP2, or CFP4 transceiver

To prolong the life of your transceivers, leave the transceiver you intend to use most
frequently in the instrument until you need to replace them with transceivers designed
for a different circuit.

To remove a CFP, CFP2, or CFP4 transceiver

1 If necessary, remove any optical cables that are currently connected to the trans-
ceiver. If you need to remove a cable, do the following:

a Press the release latch on the cable.

b Grasp the cable connector near the connection point.
¢ Gently pull the cable connector from the transceiver.
d Insert a dust plug into the open end of the transceiver.

2 Remove any external timing reference cables. If you need to remove an external
timing reference cable do the following:

a Grasp the plug close to the panel.
b Loosen by turning the connector counter-clockwise.

¢ When connector threads are fully disengaged, pull the plug straight off the
jack.

3 Loosen the retaining screws securing the transceiver into the instrument or flip out
bail handle.

4 Hold onto the retaining screws or bail handle and remove the transceiver from the
instrument using a steady, gentle pressure.

The transceiver is removed. Be certain to store it in an anti-static bag.
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Handling SFP/SFP+, XFP, and QSFP+ transceivers

If you have a 5800, CSAM, MSAM chassis, you can insert transceivers designed for
testing a variety of optical circuits. Examples of SFP and QSFP transceivers are
provided in Figure 36 and Figure 37.

 The 5800v1 accept SFP transceivers.
* The 5800v2, 5882 and CSAM accept SFP/SFP+ transceivers.
* The 5800-100G accepts QSFP+/QSFP28 and SFP/SFP+/SFP28 transceivers.

*  The MSAM (with connected SFP and/or XFP PIMs), accepts SFP and XFP trans-
ceivers.

* The CSAM accepts QSFP+ transceivers.
Each of these pluggable transceiver modules has similar insertion characteristics.

Figure 36 shows a Copper SFP (used to test copper over 10GigE LAN circuits).

Figure 36 Copper SFP

Figure 37 shows the QSFP transceiver+ used to perform out of service testing over
40GE fiber circuits.

Figure 37 QSFP+ transceiver (40GE circuits)

Inserting an SFP/SFP+, XFP, or QSFP+ transceiver

Before inserting an SFP/SFP+, XFP, or QSFP+ transceiver, consider the following:

¢ Applied power must not exceed the power level specified on the panel for each
optical connector.

T-BERD/MTS/SC Getting Started Guide
Page 48 22046537, Rev. 016 March 2018



Chapter 2 Assembling Your Instrument
Handling SFP/SFP+, XFP, and QSFP+ transceivers

* Use only the transceivers and adapters that shipped with your instrument, or
those that are identified on the list of Viavi supported optics that shipped with your
instrument. The recommended optics are also available on your instrument by
selecting Help > Recommended Optics. Many of these transceivers and
adapters can be purchased from Viavi.

*  Verify that the transceiver, adapter (if applicable), and the connector on the instru-
ment support the same physical interface. For example, if you intend to connect a
CSAM to a 100G Ethernet circuit, verify that you are inserting a CFP transceiver
(or adapter) into the CFP2 port of the CSAM. If you inserted a CFP2 adapter,
verify that you are inserting the appropriate transceiver for the adapter (CFP4 or
QSFP28).

NOTE:

D Details concerning the inserted transceiver used for the currently selected
application appear on the Interface setup tab.

To insert a SFP/SFP+, XFP, QSFP+, or QSP28 transceiver

1 Obtain a transceiver from Viavi that supports the physical interface you intend to
test.

If you are not certain which interfaces a particular transceiver supports, refer to
the list of Viavi Recommended Optics.

If you can not locate the sheet, in most instances an online search using the
model number (printed on the transceiver label) will result in a number of hits
providing specifications for the transceiver.

2 After verifying that you have the correct transceiver for the interface, do the
following:

Position the instrument with the connector panel facing towards you.

b  Ensure that the bale-clasp latch on the transceiver is closed as illustrated in
Figure 38. The bale-clasp latch handle should be on top of the transceiver
module.

Figure 38 Transceiver (SFP shown) with closed bail-clasp latch

¢ With the identification label facing away from you, align the transceiver with
the connector cage, and then gently but firmly insert the transceiver until it is
seated securely (indicated by an audible click, or by feeling the transceiver
snap into place).
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Handling SFP/SFP+, XFP, and QSFP+ transceivers

CAUTION: DAMAGE TO UNIT

If you feel any resistance when first inserting the transceiver into the cage,
do not force it any further. The bottom of the transceiver may be obstructed
by the latch tab in the cage, and forcing it any further may damage the cage.

If this occurs, do the following:
* Remove the transceiver, then push the latch tab in the cage down.

* Verify that you are inserting the transceiver correctly (for example, with
the label facing away from you).Verify that the bale-clasp latch on the
transceiver is completely closed, realign it with the cage, and then insert
it again.

The transceiver is inserted; be certain to cover the optical connector openings when
they are not in use.

>

NOTE: Laser warm up requirement

When testing 10G, 40G, or 100G optical circuits, some lasers (particularly 1550
nm lasers) are temperature stabilized; and therefore need to reach a certain
temperature before you can use them to transmit a signal. This is expected
behavior, and does not indicate that there is something wrong with the laser or
test instrument.

It typically takes up to one minute for the temperature to stabilize. If you have
turned the laser on, but no signal is present on the receiving instrument or
device, simply wait for one minute.

Removing an SFP/SFP+, XFP, or QSFP+ transceiver

To prolong the life of your transceivers, leave the transceiver you intend to use most
frequently in the instrument until you need to replace them with transceivers designed
for a different circuit.

To remove an SFP/SFP+, XFP, or QSFP+ transceiver

1 If

necessary, remove the dust cover, or any cables that are currently connected to

the transceiver. If you need to remove a cable, do the following:

Q O T 9o

Press the release latch on the cable.
Grasp the cable connector near the connection point.
Gently pull the cable connector from the transceiver.

Insert a dust plug into the open end of the transceiver.
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2 Open the bail-clasp latch (as illustrated in Figure 39), and grasp the latch and pull
gently upwards to remove the transceiver from the cage.

Figure 39 Transceiver (SFP shown) with open bail-clasp latch

N,

The transceiver is removed. Be certain to store it in an anti-static bag.

Attaching an external optical connector

Some instruments also use external optical connectors. Before attaching an external
connector to your instrument, be certain the connector is clean. If the external
connector is new, or has been used with clean, defect-free fiber connectors and capped
when not in use, it does not typically require cleaning.

If you suspect poor performance is due to a dirty cable, connector, or optical jack, make
sure you clean them.

To attach an external optical connector

1  Verify that the laser is turned OFF on the instrument.
2 \Verify that the locking lever of the connector is in a released position.

3 Pinch the connector with your index finger on the top of the locking lever, and your
thumb on the bottom of the connector.

4  Align the connector squarely with the four sides of the optical connector on the
panel.

NOTE:
D If you insert the connector at an angle you risk damaging the connector.

5 Insert the connector into the optical connector on the panel, and then lock the
shell in place by rotating the locking lever upwards until you hear a click.

The connector is attached. Be certain to cover it with a dust cap if you don’t intend to
begin testing immediately.
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Disconnecting the DMC

Before disconnecting the DMC from the base unit, review the “Key principles” on
page 28 for assembling the instrument. The same principals apply when disassembling
the various components.

Required tools

Large, flat blade screwdriver

You will need a large, flat blade screwdriver to remove the battery module.

Hex key (provided)

A 5 mm hex key is provided in a groove on the inside panel of the battery module. This
key is used to secure and then tighten the screws that connect the module to the base
unit.

Torque wrench (optional)

If you want to ensure that you don’t apply too much pressure when connecting or
disconnecting components, you can optionally use a torque wrench capable of applying
13.3 in-Ib. A torque wrench with the ability to apply up to 20 in-Ib in 0.1 in-Ib increments
will be adequate. You will also need a 5 mm hex key bit for the wrench.

Disassembling the instrument

To remove the DMC from a base unit
1  Verify that power is OFF on your base unit and that the power adapter is
unplugged.

2 Using the large flat blade screwdriver, loosen each of the 4 slotted bolts on the
back panel of the battery module (attached to the base unit), and then gently
remove the battery module.

3 Use the provided hex key to loosen screws 1 through 4 in the sequence illustrated
in Figure 23 on page 32.

4  Turn the base unit over so the display is facing upwards.
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5 Disconnect the DMC from the base unit by gently pressing upwards on the two
lower bumpers of the base unit as illustrated in Figure 40 on page 53.

Figure 40 Bumpers (Base Unit)

Press Up Bumpers

IMPORTANT: When lifting the base unit, be certain to apply force directly over the
base unit mating connector (illustrated in Figure 21 on page 30). The lower
bumpers are located on the front (display) panel of the base unit, and they are
parallel with the mating connector provided on the bottom (connector) panel. In
Figure 40, the base unit mating connector is not visible; it is directly above the
mating connector of the DMC.

6 After the base unit is completely disengaged from the DMC, lift it up further and
place it elsewhere on your work surface.

The instrument is disassembled.
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Getting Started

This chapter explains how to start using your instrument, and describes the user inter-
face. Topics discussed in this chapter include the following:

“Powering the instrument” on page 56

“Launching the MSAM or CSAM” on page 60
“Navigating the user interface” on page 62

“Setting up the instrument” on page 70

“Connecting your instrument to the circuit” on page 79
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Powering the instrument

Power is supplied to the instrument by the battery or the AC power adapter supplied
with the application module (MSAM, or CSAM) or DMC. For the 5800, the adapter is
supplied with the instrument. Use of AC power adapters or batteries other than those
supplied with your 5800, application module, or DMC is not recommended as other
slices/modules may be supplied with incompatible adapters or batteries.

When supplying power using an AC power adapter, consider the following:

*  Multiple (“Stacked”) DMCs — If you intend to test by connecting multiple DMCs to
a single T-BERD/MTS 8000 base unit, you will need an adapter that provides
more than the standard 150 Watts.

* Two MSAMs — If you intend to test by using two MSAMs in one DMC module in a
single T-BERD/MTS 8000 base unit, you must connect the AC power adapter
that shipped with the DMC.

*  Two CSAMs — If you intend to test by using two CSAMs in one DMC module in a
single T-BERD/MTS 8000 base unit, you must connect the AC power adapter
that shipped with the DMC.

To discuss the various power adapters available for your instrument, contact Viavi
Customer Care, or contact Viavi via the company web site,www.viavisolutions.com.

Verifying that you have the correct adapter

The following figure shows the labels on the adapter that ship with T-BERD/MTS
5800v2, 5800-100G and SC 4800/4800P test instruments.

Figure 41 5800v2, 5800-100G, 5882 and 4800/4800P Adapter Labels

O JDsu | VIAVI

TB/MTS-5800v2 T-Berd/MTS 5882/5800-100G
60W Power Supply 150W Power Adapter
AD-22046660 AD-PS150W19V

VIAVI

T-Berd/MTS 5800v2

V1AV

T-Berd/MTS 5800v2/

SmartClass 4300
60W Power Adapter
C5PS5800

60W Power Adapter
C5PS5800
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Figure 42 shows the label on the adapter that shipped with the T-BERD/MTS 5800v1
test instruments.

Figure 42 Adapter label

nced Power Solutions
Tel:925-456-9890

WARNING:
RISK OF ELECTRIC SHOCK,

MODEL: PA1060-120T28500 DO NOT OPEN, INDOOR USE ONLY @

PRODUCT CODE:1110-0171

INPUT : 100-240V~ 50-60Hz 1.8
OUTPUT: 12V ===5.0A 60W Max
EFFICIENCY LEVEL: @ ©60 7

A

Figure 43, Figure 44 and Figure 45 show the labels provided on the adapters that ship
with the DMC and MSAM.

Figure 43 DMC adapter label

{> IDSU

TB8000/MTS 8000
150W Power Adapter
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Figure 44 MSAM Adapter label

e epACPOWER ELEC
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DATE CODE: EEEEEEIIIIEEIEII
21314]1516]78
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MADE IN CHIMA
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Figure 45 40/100G Power Adapter label

Order No.:
GS220A21-JD

DO NOTOPEN RISK. (=
OF ELECTRIC ﬁHOCl
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MADE IN TAIWAN( £+ 0 % & )5 % 4 4)
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Using the AC power adapter

To supply power using the AC power adapter

1  Verify that the AC power adapter is the one that shipped with your application
module, DMC, 5800 or 4800 (see “Verifying that you have the correct adapter” on
page 56).

2 Plug the adapter into the power supply jack.
— The jack for the DMC is located on the bottom right-hand corner of the unit.
— The jack for the MSAM or CSAM is located on:
- the top panel of the unit, or
- the bottom right-hand corner of the DMC.

— The jack for the T-BERD / MTS 5800 and SC 4800 families is located on the
bottom right side of the unit.

3 Plug the opposite end of the adapter into the power mains.
Power is supplied using the adapter.

For specifications, see “Power supply specifications” on page 178.

Turning on the instrument

To power the instrument

¢ Press the ON/OFF key.

The On LED, located on the front panel, illuminates green when the unit is powered,
and the instrument beeps.

Turning off the instrument

To turn off the instrument

*  Press the ON/OFF key.

The On LED, located on the front panel, extinguishes when the unit turned off, and the
instrument beeps.

Charging the battery

In most instances, the battery charges automatically when you supply power to your
instrument using the AC power adapter. In some instances, the instrument may not
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automatically charge the battery because the power supplied via the AC Adapter is
required to:

e Support high speed applications (for example, OTU2, OTU3, and OTU4 applica-
tions).

*  Support multiple tests running concurrently; particularly when using an MSAM
with an XFP SIM.

e Support optical Jitter applications.

6000A Charge LED

The Charge LED on the front of the 6000A base unit behaves as follows when testing
using an MSAM:

Table 10 Charge LED behavior

. LED .
Scenario State Indicates
Power supplied by adapter1 ON The battery is charging.
OFF The battery is not charging.
Power supplied by battery ON The battery has six minutes or less of power avail-
only able. If the Charge LED illuminates when operating
on battery power, supply power using the adapter
immediately.
OFF The battery has more than six minutes of power
available.

1. When running OTU2 applications, or multiple tests on an MSAM with one application that requires an XFP PIM, the instrument does
not charge the battery - even when the adapter supplies power. When you launch these applications, the Charge LED extinguishes to
alert you that the battery is not charging. Applications that use the XFP PIM include 10 Gigabit LAN, 10 Gigabit WAN, 10 Gigabit Fibre
Channel, OC-192 SONET, STM-64 SDH, and OTU2 OTN.

Launching the MSAM or CSAM

If the MSAM, or CSAM was launched during your last test session (when you turned
the power OFF), the instrument launches it automatically when you turn power back
ON. If the module was off when you turned power OFF, you must actively launch it after
you turn power back ON.

Multiple BERT icons

The MSAM and CSAM are all represented by a “BERT” icon on the System screen. If
you are using a DMC with two MSAMs, two CSAMs, or one of each, two BERT icons
appear on the screen (one for each MSAM and CSAM). If you stack multiple DMCs on
a single T-BERD/MTS 8000 base unit, an icon appears for each MSAM, or CSAM.
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When multiple BERT icons are available, a yellow icon indicates which module is
active; a green outline surrounding a yellow icon indicates that the instrument is
currently providing the user interface for that particular module (in other words, it is the
module in focus).

About the Jitter icon

If your instrument is configured and optioned for optical jitter/wander testing, before
launching the module, consider the following:

Connect the AC power adapter to the power mains before launching the optical
Jitter/wander function (see “Powering the instrument” on page 56).

Turning on the JITTER icon also automatically turns on the BERT function.

To conserve power, if you are no longer testing optical jitter or wander, turn off the
JITTER icon. All other “BERT” functions will still be available.

Turning the BERT icon ON

To turn a BERT icon ON

1

Press the ON/OFF button.

The unit loads the 8000 Base Unit or 6000A Base Unit software, and then the
following occurs:

— The screen goes blank for a few seconds.
— The Presentation page for the base unit appears.

— Ifthe Transport Module, MSAM, or CSAM was launched during your last test
session (when you turned the power OFF), the Viavi BERT MODULES
STARTUP screen appears, indicating the progress of the software load.
When the load reaches 100%, the Main screen appears. The
Transport Module, MSAM, or CSAM is launched; proceed to step 3.

— If the Transport Module, MSAM, or CSAM was not launched during your last
test session (when you turned the power OFF), the Viavi BERT MODULES
STARTUP screen appears, instructing you to press the SYSTEM/HOME
button. Proceed to step 2.

Press the SYSTEM/HOME button.

The System screen appears. The MSAM or CSAM is represented by a BERT
icon.

If the icon for the function you want to launch is not already outlined in green,
select the icon by doing one of the following:

— Use the touch screen to select the icon.

— Use the arrow key to select the icon.

The icon is highlighted in green when selected.
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4 Atfter the icon is selected (highlighted in green), do one of the following to turn the
module ON.

— Use the touch screen to select the icon a second time.
— Press the Enter key.
The interface highlights the icon in yellow, and the MSAM or CSAM launches.

5 Press the RESULTS button.

The Viavi BERT MODULES STARTUP screen appears, indicating how far the
software load has progressed. When the load reaches 100%, the Main screen
appears.

The MSAM, or CSAM is launched.

NOTE:

D After you launch the MSAM or CSAM, you can use the SYSTEM/HOME button
at any time to return to the System screen to change settings (such as the
screen saver). Pressing the SETUP or RESULTS button will then return you to
the corresponding application screen.

Navigating the user interface

The user interface lets you set up the instrument, configure tests, and display test
results. See Figure 46.

Figure 46 Main screen (Ethernet application)
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For descriptions of the physical control buttons on the front panel of the base unit, refer
to the 8000 Base Unit User Manual or the 6000A Base Unit User Manual.

Menu Bar

The menu bar provides the following menus:

Test

Use the options listed on the Test menu to select your test application.

For example, to transmit patterns in a STS-48c Bulk BERT payload over an OC-48
circuit, select:

Test> SONET> OC-48 > STS-48c Bulk BERT > Terminate

View

Use the options listed on the View menu to change the format of the Main screen.
Options are provided which allow you to change the result layout and hide or display a
variety of items on the Main screen, such as the Message bar, LED panel, Signal Struc-
ture (graphical display), and the Actions panel. An option is also available which allows
you to toggle between tests running on different ports.

Reports
Use the options on the Reports menu to create, view, and export custom reports for

your module. You can also enable and configure automatic reports and test restarts
after automatic report generation using the Automatic Reports option.

Tools
Use the options on the Tools menu to import or export saved test configurations, set up

your module to emulate the FST-2000 TestPad or ANT platform LEDs, and to activate
new test options on your module. The Clear History option clears all historical LEDs.

Help

Use the Help menu to launch a help system with each of the topics discussed in the
testing manual, or to view signal connections.

Soft keys

The soft keys located on the right side of the graphical user interface provide quick
access to setup screens and the result display.
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Setup/Results

The top key (Setup/Results) is used to toggle between the Setup screens and the Main
(Result) screen. When the Main screen is displayed, the Setup key appears; when the
setup screens are displayed, the Results key appears. For descriptions of setup
parameters and test results, refer to the testing manual for your instrument.

A Restart soft key is also provided which allows you to restart a test (and clear results).

Restart

Additional soft keys appear when appropriate for the selected test application which
allow you to run a variety of scripts designed to simplify testing.

Menu Keys

The seven menu keys located on the right side of the front panel perform the same
functions as the softkeys immediately to their left on the graphical user interface. If your
unit does not have a touch screen, use these buttons to access the setup screens,
restart tests, and perform other functions specific to your test application.

Test Bar

The Test Bar displays the current test application selected on the unit. For example, if
you selected the Layer 4 Multiple Streams application for a 10GigE LAN circuit, the

following appears in the Test Bar:
10GigE LAN Layer 4 Streams Term

If your instrument is configured with two ports for a particular rate, the currently selected
port also appears at the beginning of the text.
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Message Box

The Message Box displays the duration of the currently running test and indicates
whether any messages related to the test have been generated (for example, to alert

you that loop ups are successful, or that your instrument has been synchronized to a
particular external timing source).

’ Running

=] 2 messages
T

If messages exist, you can select the box to display the Message Log, which lists each
message.

Message log for Port 1: 10/100/1000 Eth Layer 2 Traffic Term

01/04/2011 11:20:56 PM EDT : Starting synchronization with Time of Day signal from external time
source...

01/04/2011 11:20:56 PM EDT : Successfully synchronized with Time of Day signal from external time
source.

Clear H ' oK

Quick Config settings

After you select a test application, a Quick Config tab appears to the right of the
Message Box, with key settings required to configure your test. For example, if you
selected the SONET -> OC-48 -> STS-12¢ Bulk BERT - > Terminate application, quick

configuration settings appear that allow you to automatically detect and insert a BERT
pattern. See Figure 47.

Figure 47 Quick Config Settings

Quick Config Signal Structure
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Signal Structure

If you are running a SONET, SDH, or OTN application, a Signal Structure tab appears
to the right of the Quick Config tab. When selected, the tab shows the structure of the
signal transmitted from the unit to the device under test (DUT) and then to another
device on the far end of the circuit (typically another test instrument). Figure 48 illus-
trates the signal structure when you transmit a Bulk BERT payload in an STS-12c¢ signal
carried in an OC-48 wrapper.

Figure 48 0OC-48 STS-12c Bulk BERT signal structure

Quick Config Signal Structure

ST5-12¢ 0C-48 0C-48 ST5-12¢ |
A3 A23
2 14 Bulk D = = D }L 2 14
1 Optical ® Rx1 Optical 1

LED Panel

The LEDs in the panel to the left of the Results Windows help you determine whether
a signal is present, pattern synchronization has been achieved, and other key events
have occurred when performing tests. The color of the Summary LED at the top of the
panel indicates the overall status of Summary test results supporting the application.
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You can collapse and expand an LED panel by tapping the panel name (for example,
SONET or Ethernet). Figure 49 illustrates the LEDs supporting a 1GigE Layer 4 Traffic
test application.

Figure 49 100GigE Layer 4 Traffic LEDs

Summary

Status

Ethernet

aWLAM Frame Detect
£ TCF Facket Detect
£ UDF Packet Detect
History

When you set up your instrument, you can indicate that the LEDs should emulate those
displayed on the user interface of the FST-2000 TestPad or the ANT platform.

*  Forinstructions on customizing the LED panel, see “Customizing the user inter-
face look and feel” on page 74.

e For descriptions of each of the LEDs, refer to the Test Results chapter in the
testing manual that shipped with your instrument.

Current and history LEDs

The round LEDs on the inside column provide the current state of the key event; the
square LEDs on the outside column provide the historical state (in other words, the
event occurred in the past).

LED colors

Green LEDs indicate an event occurred as expected, yellow LEDs indicate that an
event occurred that warrants additional investigation, and red LEDs indicate that an
error, anomaly, alarm, or defect has occurred.

March 2018

T-BERD/MTS/SC Getting Started Guide
22046537, Rev. 016 Page 67



Chapter 3 Getting Started
Navigating the user interface

LEDs for muxed payloads

When testing muxed payloads, panels appear for each of the payloads (in addition to
the LEDs for the interface rate). For example, if you are testing an E1 BERT payload
carried in a DS3 signal, a DS3 panel and a E1 panel appear.

10 Gigabit Ethernet WAN LEDs

When testing 10 Gigabit Ethernet WAN circuits, a SONET or SDH panel and an
Ethernet panel appear.

Actions Panel

After you select a test application (using the Test menu), an Actions Panel appears
under the LED display that provides tabs with the buttons required to perform your test.
The buttons available vary depending on the test application you select. For example,
buttons may appear that allow you to start and stop transmitting Ethernet traffic, start
and stop a local loopback, or, if you selected a SONET application, allow you to specify
error, anomaly, alarm, defect, and pointer parameters for the test.

Figure 50 Action Panel (1GigE Layer 4 Traffic application)

Laser / Tx Signal Actions ‘ Errors I
Traffic Loop Loop LLB Pause Frame || Reset Service
Started Up Down Insert Disruption Test

A blinking circle on a tab indicates that some action is required on your part. For
example, if you are running a BERT test, the Actions tab may blink indicating that you
need to start transmitting the BERT pattern.

If you select a test application for an optical rate, a Laser tab also appears, with buttons
that allow you to select an SFP connector for the test (if appropriate), specify the trans-
mitted wavelength (for OC-192, STM-64, OTU-2, and 10 Gigabit Ethernet and Fibre
Channel signals), and turn the laser on and off.

If you do not see the buttons that you need to perform a test, select

View > Actions Panel on the Menu Bar, and then select the tab with the buttons that
you need. You can also hide the Action Panel on the Main screen by clearing the
View > Actions Panel selection.

NOTE:

D The color of a button reflects its current state. Action buttons are highlighted in
yellow when they are turned on; they are grey when they are off.
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Result Buttons

Group and Category buttons are provided at the top of each result window. The Group
button on the left allows you to select the type of results you want to observe (for
example, Summary results); the Category button on the right allows you to select a
specific results category for the group you specified. By selecting a different group or
category for each pane, you can view multiple sets of results at the same time. See
Figure 51.

Figure 51 Result Group and Category Buttons (Ethernet application)

‘| Ethernet + | L2 Link Stats $

Result Windows

The test results appear in Result Windows (see Figure 52). Errors are highlighted in
red; other results appear in black.

Figure 52 Result Window (Ethernet application)
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Frame Loss Ratio 0.0
D05 Frames 0

You can change the layout of the Result Windows using options provided on the View
menu. You can also choose to show just test results on the main screen by selecting
View > Show Only Results.

For test result descriptions, refer to the Test Results chapter in the Testing Manual that
supports your instrument.
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Setting up the instrument

Setting up the instrument involves loading new software upgrades or options, setting
up the screen saver, specifying a printer for the instrument, and indicating whether you
want your LEDs displayed using the format used on the FST-2000 TestPad format, or
the format used on the ANT platform. You can also change the instrument’s default
VNC password.

The System menu provides access to regional settings, the date and time, and display
settings. The T-BERD / MTS 5800 system menu shown in Figure 53. Details
concerning the System menu for other test instruments are provided in the 6000 or
8000 Base Unit User Manual that supports the corresponding base unit.

Figure 53 T-BERD / MTS 5800, 5800-100G System Menu

T - pe——————————————— - 1
| F i - R (L) M 11:15AM
| -...- yETEm Tests Fiber Optics nc®™=d) % QB i
gSystem MTS 5800 V2 Version 6.3.0.bee6d96
' Ej h =
wd L =
Files Use Bluetooth Network Power Management
= - -
3 : W 2
©o @ c U
Date and Time Reglon Display Remaote Upgrade
i T @,‘
Test Set Lock Audio System Info StrataSync Video Flayer
‘Web Browser Job Manager

Specifying international settings

Before testing, you can specify the language and the date and time format for the user
interface.

To specify international settings

1 Select the SYSTEM/HOME icon.
The System Menu appears.

2 Do one of the following:
a T-BERD/MTS 5800
i  Select Region.

ii The System Setup screen appears, listing settings that control the
appearance and behavior of your unit.
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iii In the Language box, select the language for the user interface.
The formatting standard changes automatically.

iv In the Samples for selected formatting box, the date, time, and
number formatting appear.

v  If you want to change the formatting standard, click the Change format-
ting standard box, and then select a country.

vi If you wish to do so, click the check box next to Use 24-hour time.
vii Turn the instrument off then back on.
The user interface changes to the language you specified.
b T-BERD/MTS 8000, 6000A, and 5800

i  Press System Setup.

The System Setup screen appears, listing settings that control the appearance
and behavior of your unit.

ii  Select Language, and then select the language for the user interface.

iii Select Date Format, and then select the mm/dd/yyyy or dd/mm/yyyy
format.

iv Select Time Format, and then select the 24 hour clock or 12 hour clock
format.
A message appears indicating that you need to reboot the unit for the settings to
take effect.

v  Press the ON/OFF button to turn the unit OFF, and then press it again to
turn the unit back ON.

The unit reboots in the language you specified.

International settings are specified.

Setting the date and time

MSAM and CSAM

You can change the date and time on your instrument by editing the system settings,
and then rebooting your module. For instructions on changing the date and time, refer
to the 8000 Base Unit User Manual or 6000A Base Unit User Manual.

T-BERD / MTS 5800 and SC 4800

The T-BERD / MTS 5800 and SC 4800 have an internal clock that you can set to
provide accurate time stamps for test results.

To set the date and time

1 Select the System icon.
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The System screen appears.

2 Select Date and Time.

3 Specify the Region, Country, and Area, and if you wish to do so, click the check

box for Automatically adjust for daylight savings time.

4  Under Current Date & Time, do the following:

a Use the up and down arrows to specify the current local time. If you wish to

do so, click the check box next to Use 24-hour time.

b Use the calendar to select the current date.

Changing the remote access password

To change the default password

1 Select the System icon.
The System screen appears.

2 Select the Remote (VNC) icon.

3 Select the Change Password button, then specify a new password.

For more information, refer to the 8000 Base Unit User Manual or the 6000A Base Unit

User Manual.

Checking the battery

You can check the status of the battery in two ways:

Method 1 — The battery status indicator in the upper right corner of the screen

provides a graphic indication of the approximate battery charge.

; Battery Indicator

\ | 553 PM

/ ‘!" 016
-
Results

Method 2 — The Battery Level percentage on the Battery status page.

1 Select the System icon.

2 Select Battery.
The battery status appears.

3 View the Battery Level.
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The Battery Status page indicates the charge level (both in percentage under the
battery and the color of the battery), whether the adapter is plugged in, and indi-
cates the battery temperature range.

Setting up the display

Setting up the display includes setting the screen brightness and setting up the screen
saver.

NOTE:

D The Display menu also allows calibration of the touchscreen. See “Calibrating
the T-BERD / MTS 5800 and SC 4800 touchscreen” on page 247.

Adjusting screen brightness

The following procedure describes how to adjust the screen brightness.

To adjust the screen brightness

1 Select the System icon, then select Display.

2 Change the brightness level by moving the slider left or right.

Setting up the screen saver

If you are operating the instrument using the battery, you should set up the screen saver
to switch off the screen automatically after the unit has not been used for a specific
interval of time. For instructions on setting up the screen saver on a MSAM, refer to the
8000 Base Unit User Manual or 6000A Base Unit User Manual. For the T-BERD / MTS
5800 and SC 4800, see below.

To set up the screen saver

1 Select the System icon, and then select Display.

2 To enable the screen saver, click the check box next to Enable automatic screen
saver.

3 To change the message displayed as a screen saver, click in the Message field,
and then enter the message.

4  To specify the time to wait until the screen saver begins, do the following:

a Click on the drop down next to the Delay field, and then specify the time unit,
for example, seconds, minutes or hours.

b Click in the Delay field. A keyboard appears. Enter the amount of time, and
then click OK. For example, if you selected minutes in the previous step,
enter the number of minutes of delay.
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5 Click the check box next to Screen saver password if you wish to enable a
screen saver password (a password is required to close the screen saver and
resume using the instrument). Make a note of the password and put it somewhere
safe.

The screen saver is setup.

Customizing the user interface look and feel

You can set up the instrument to emulate the FST-2000 TestPad user interface
(TestPad mode), or the ANT platform user interface (ANT mode). This primarily impacts
the LED result format on the Main screen.

TestPad mode

If you specify TestPad mode for the LED display, the inside green LEDs illuminate
sequentially as key events occur, such as signal detection, frame synchronization, and
pattern synchronization. The Summary LED illuminates green if all summary results are
OK. If the test stops, the Summary LED is locked until you start or restart the test.

If the module loses any of the LED events, the green Status LED extinguishes, and the
red Alarm LED in the history column illuminates indicating an error condition has
occurred. For example, if the module detected a signal, but then loses it, the green
Signal Present LED extinguishes, and the red LED in the history column illuminates. If
the module then regains a signal, the green Signal Present LED illuminates, and the
red history LED stays illuminated until you clear history results or restart the test.

ANT mode

If you specify ANT mode for the LED display, the LEDs illuminate red when key events
or errors occur. For example, if the module does not detect a signal, the associated LOS
LED illuminates. When the module detects a signal, the LOS LED extinguishes.

Specifying the LED results mode

To specify the LED results mode

1 Select Tools > Customize.
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The Customize User Interface Look and Feel screen appears.

Customize User Interface Look and Feel

Settings apply to all tests running on this module and will reset all results

Result/Setup Terminology [TestPad E ]
GUI Style (requires reboot) [Dark E ]
Startup View [ Results View E ]

« Blink on Error

+ Blink Summary Results

2 Set Result/Setup Terminology to TestPad or ANT mode.

3 Select Close to store the result mode and return to the Main screen.

The test results mode is specified.

Viewing or installing options

Your instrument may come with software options installed or you may order them later
and install yourself.

To view installed options

* Select Tools > Reviewl/Install Options.
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The Software Options screen appears.

Instrument info | Options

Ethernet Interface Options

C510M1GE
10/100/1000M Electrical & 1GigE Optical Ethernet

C510GELAN
10GigE LAN Ethernet

C510GEWAN
10GigE WAN Ethernet

C5ETHLPEK
Ethernet Loopback

Additional Ethernet Options

Enter new option key below to install it.

Option Key Install

Contact VIAVI to purchase software options.
Option Challenge ID: 0x989f5c010000/001

The icon indicates whether the option is enabled.

Icon Indicates

W Option is enabled.

7 An expiring option. An “expiring option” is an option that is installed for free

= for a trial period. The time left in the trial is indicated to the right. When the
trial period ends, a warning message appears. If you are running a test
when the option expires, you can continue testing, but the expiration warn-
ing will reappear every minute until you either enter a permanent option
key or reset the module (changing applications will reset the module).

2 Option has not been enabled. If you need this option, contact Viavi Cus-
tomer Care to place an order.

To install software options

* Refer to the Software Option Installation Instruction provided with the option.

Loading upgrades

Software upgrades can be loaded from storage media such as a CD-ROM or a USB
memory key. To obtain the latest software release for your unit, contact your local Viavi
sales office.

Refer to the instructions provided with the software upgrades for details.
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Synchronizing to the StrataSync server

To automatically obtain the latest configuration settings, software options, updates and
ownership registration information, the instrument may be synchronized with a Viavi
server via the Internet with an optional subscription-based service called StrataSync.

In addition to the latest operating software, the synchronization also stores any user
files saved to the unit’s hard drive on the StrataSync server. A connection to the internet
would be provided upon receipt of the unit and on a regular (daily) basis thereafter to
ensure that it has the most currently issued options and updates and to allow all user
information to be backed up.

If an internet connection is available and contact has been made with the StrataSync
server, a message appears asking you to initiate the syncing process.

NOTE:

D Before attempting to synchronize the unit to the StrataSync server, be certain
that no applications are currently using the RJ-45 Management port.

To sync with the StrataSync Server

1 Verify that the server ID is displayed in the Server ID field -default= strata-
sync.viavisolutions.com

2 Enter the Account ID for this test instrument. No synchronization can occur
without the entry of a pre-approved, unique ID number. This ID must be obtained
from Viavi before attempting to sync to the server.

3 Enter an optional Tech ID. This will be populated by a default value representing
your test instrument, but can be changed to identify the user who is initiating the
synchronization.

4 Press the Synchronize button.

To halt the synchronization process after it has been started, select the Stop Sync
button.

NOTE:

D During Synchronization, a cloud icon will be displayed at the top of the screen
and the state of the synchronization activities will be displayed below the Syn-
chronize button. The cloud icon will also be modified to indicate the following
actions -

Up/Downloading- Cloud with arrows
Failed Sync - Cloud with ed X overlay
Sync Success - Cloud with green check mark

If an error or failure occurs, a message detailing the possible reason for the
problem will be displayed in the status message under the Start button.

The synchronization process includes:
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After syncing with the StrataSync server, your test instrument sends identifying
information about the hardware and software that currently comprise the instru-
ment.

If the configuration information contained on the server is newer than that on the
test instrument, the server will be considered to be the most up-to-date.

NOTE:

StrataSync may have difficulty determining the newest file if the system time of
the instrument has been modified.

If the server finds files that are newer than those on the test instrument, the server
sends the files to the instrument.

Each time the synchronization process modifies or copies files, a message
appears indicating the action just taken.

The test instrument will then send any reports, configuration profiles, screen
shots, and similar files that have been saved on the unit since the last configura-
tion. File names that may be included include the following:

Reports Configurations
*txt * st
*.csv *.dualtst
* pdf *.ams
*xml *.sam
*.html * truespeed
*.png *.expert_rfc
*.pcap *.cat

*xml

The server then applies any applicable Options to the unit.

NOTE:

If an Option Code was entered as a part of synchronization, your instrument
must be restarted to complete the process and initialize the option.

Anytime an option is updated, the unit will conclude the update process by
attempting to contact the StrataSyncserver. If a connection is unavailable, one
should be provide at the earliest convenience to register all installed options.

Finally, if any upgrades are available, you will be informed of their availability and
asked to verify that you want to receive the upgrade.

After synchronization is complete, the Status will indicate “Status Complete” and
the instrument will reboot. The test instrument may be disconnected from the
internet.

The test instrument has been synchronized to the StrataSync Server
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Specifying a printer for the instrument

After specifying a printer for the instrument, you can print the following for the currently
running test application:

* The display
*  The setup parameters
* The test results

To specify a printer for the instrument

1 Press the SYSTEM/HOME button.
2 Select the System Setup softkey.

3 Inthe Printer box, select Printer, and then select the type of printer you are
connecting to the unit. If you select a USB printer, you can then select the manu-
facturer for the printer.

The printer is specified. For instructions on connecting a printer to the base unit, refer
to the 8000 Base Unit User Manual or 6000A Base Unit User Manual.

Connecting your instrument to the circuit

Before connecting your instrument to the circuit for testing, consider the following:
* Older chassis for some test instruments provide internal connectors for all
supported optical line rates.

* Newer chassis require either an external optical connector or a CFP, SFP, SFP+,
XFP, or QSFP+ transceiver (and/or adapter) to test optical circuits, providing
greater flexibility. For handling guidance, see “Handling CFP adapters and trans-
ceivers” on page 43, or “Handling SFP/SFP+, XFP, and QSFP+ transceivers” on
page 48.

* If you are connecting an MSAM to the circuit, verify that the appropriate PIM (or
PIMs) are inserted into the MSAM.

*  When selecting the cable, consider the following:
— What type of connectors are required?
— Are you testing an electrical or optical circuit?
— If you are testing an optical circuit, is it a single-mode or multi-mode circuit?
— Do you need a crossover cable?
— Do you have the appropriate attenuator for the cable?

After considering the items above, these basic steps should be followed.
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To connect your instrument to the circuit

1 If you are testing on an optical circuit, insert a Viavi recommended optical
connector, transceiver and/or adapter into the supporting port on the instrument’s
connector panel (see “Viavi recommended optical adapters and transceivers” on
page 25).

2 Using the blinking yellow LEDs and labels on the connector panel as a guide,
connect one end of the selected cable to the appropriate transceiver or jack on
your instrument, and then connect the other end to the device on the circuit. If you
are connecting to an optical circuit, be certain to attenuate the signal.

NOTE: If your test instrument is configured with dual ports, flashing LEDs indicate
which connectors are used for the currently selected test; solid LEDs indicate the
connectors used for other tests.

3 If you connected to an optical circuit, determine whether you can remove the
attenuator by observing the optical Rx Level (dBm) resultin the Interface
group, Signal category. If attenuation is not necessary, remove the attenuator,
reconnect the cable to the transceiver, and then press Restart.

The instrument is connected to the circuit.

Configuring Expert Optical settings

The optics used in the CSAM ideally auto-configure upon insertion and therefore
require no user intervention.

For applications where configuration of the optics is critical, an Expert configuration is
provided. This function provides adjustments for the optics to compensate for equip-
ment variations and transmission conditions.

To configure expert settings

On the Main screen, select the Setup soft key. A series of setup tabs appear.
On the Interface tab, select the Connector tab.
Select the QSFP Expert or CFP Expert tab.

Click the box to Enable Expert Mode.

The expert mode parameters are automatically set, and are only applicable to the
CFP or QSFP modules. Therefore, the settings only appear if a valid (non-loop-
back) CFP transceiver, CFP Adapter, or QSFP+ transceiver is inserted in the
corresponding port.

A WO DN =

5 If you are testing using unreleased pluggable options (e.g., optics that are still
under development), use Ignore LOS if you receive LOS errors.
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6 If you enabled QSFP Expert mode in Step 4 and the QSFP is capable of
bypassing transmit or receive clock data recovery (CDR), if you want to bypass
CDR, do the following:

— To bypass transmit CDR, select Tx CDR bypass enable.
— To bypass receive CDR, select Rx CDR bypass enable.

NOTE: If the QSFP is not capable of bypassing CDR, these settings will be
disabled.

7 If you enabled CFP Expert mode in Step 4, adjust the Transmit (Tx) settings as
applicable:

a Specify the Pre-Emphasis setting.

Setting Description

Default Original manufacturer settings.

Low Some pre-emphasis is applied.

Nominal A moderate level of pre-emphasis is applied. This is the ideal set-
ting for most CFPs.

High A high level of pre-emphasis is applied.

The default pre-emphasis settings are set to values which are recommended
to work with all optics on the Recommended Optics List.

b Specify the Clock Divider setting.

Setting Description

Default Original manufacturer settings.
1/16 The reference clock will be set to 1/16 of the CAU line rate.
1/64 The reference clock will be set to 1/64 of the CAU line rate.

The default reference clock will be set to the default mode that the CFP is
expecting.

¢ If you are testing using serial CFP optical modules, specify the Skew Offset.

The Synchronous Transport Lane (STL) specification requires 32-byte lane
spacing but some serial CFP hardware exists that does not conform to this
specification. The CSAM is being shipped with a CFP Skew value at -32. If,
at a later time, hardware changes require it, a skew value of 32 is also avail-
able.

The Skew settings appear only for SONET applications when using single-
lambda CFPs.

d Specify whether to Invert Polarity.
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This inverts the polarity of the data from the FPGA transceiver to the CFP.
This is a special case feature that may be necessary for use with electrical-
breakout or other evaluation CFPs.

Specify whether to reset the FIFO on the transmit path (Reset Tx FIFO) of
the CFP.

This button appears only if the CFP has indicated that is supports FIFO
manual reset.Errors may be recorded after a FIFO reset. To clear the errors,
restart the test after resetting the FIFO.

If the unit is looped back to itself, reset the Tx FIFO before resetting the Rx
FIFO.

If you are using an OpNext 100G LR4 CFP, specify whether to automatically
reset the FIFO any time it has regained synchronization (lock) after having
lost it.

This is specific to the OpNext 100G LR4 CFP. Per the manufacturer's recom-
mendation, the 40G/100G Transport Module can execute software-monitored
and assisted resets of the transmit and receive FIFO.

This automatic FIFO-resetting mechanism will be gated (blocked) if
- SONET/SDH service disruption is enabled

- OTN service disruption is enabled

- Ethernet SD has decoupled TX from RX

The manual FIFO reset (specified in step €) on the expert configuration page
will not be blocked or gated.

8 If you enabled CFP Expert mode in Step 4, adjust the Receive (Rx) settings as
applicable:

a

Specify the Equalization setting.

Setting Description

Default Original manufacturer settings.

Low Minimal equalization is applied. This is the ideal setting for most
CFPs.

Nominal A moderate level of equalization is applied.

High A high level of equalization is applied.

The default Equalization settings are set to values which are recommended
to work with all optics on the Recommended Optics List.

Specify whether to activate Invert Polarity.

This inverts the polarity of the data from the CFP to the FPGA transceiver.
This is a special case feature that may be necessary for use with electrical-
breakout or other evaluation CFPs.

Specify whether to reset the FIFO on the receive path (Reset Rx FIFO) of the
CFP.

These buttons appear only if the CFP has indicated that is supports FIFO
manual reset.Errors may be recorded after a FIFO reset. To clear the errors,
restart the test after resetting the FIFO.
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If the unit is looped back to itself, reset the Tx FIFO before resetting the Rx
FIFO.

d If you are using an OpNext 100G LR4 CFP, specify whether to automatically
reset the FIFO any time it has regained synchronization (lock) after having
lost it.

This is specific to the OpNext 100G LR4 CFP. Per the manufacturer's recom-
mendation, the 40G/100G Transport Module can execute software-monitored
and assisted resets of the transmit and receive FIFO.

This automatic FIFO-resetting mechanism will be gated (blocked) if
- SONET/SDH service disruption is enabled

- OTN service disruption is enabled

- Ethernet SD has decoupled TX from RX

The manual FIFO reset (specified in step c) on the expert configuration page
will not be blocked or gated.

The Optics Expert Mode parameters are set.

Browsing the web
The T-BERD / MTS 5800v2, 5800-100G, 5882 and SC 4800/4800P include a web
browser similar to that found on a tablet. Although it is not expected to perform in all
aspects like that of a browser on a PC, it will allow access to a company intra-net or

work order system as well as access to Viavi provided web resources on the instru-
ment. It runs over the Ethernet management interface.

NOTE:
D You need access to the Internet for the web browser to function properly.
To browse the web

*  Select the System icon, then select Web Browser.
The Browser launches on your instrument.

Connecting to WiFi

The T-BERD / MTS 5800v2, 5800-100G, 5882 and SC 4800/4800P include internal
WiFi. WiFi is also available on the T-BERD / MTS 5800v1 using an external dongle.

To connect to WiFi

1 Select the System icon, then select Network.

2 On the left of the screen, select Wi-Fi.
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3 Select Enable wireless adapter.

I Estem Tests i":t:-er Optics = ( L L »znp“
@system > ? Network MTS 5800 V2 Version 6.3.0.bee6d96
N +| Enable wireless adapter MAC address: 00:80:16:92:01:6E
o TG NETGEARBO = B P address; 192.168.70.15

EAP-TESTER
VERSAR CONTROL
CiscoD4B843-guest
Other...

.
o

e VS-WIR =0
‘:“ s":“'_ T ~ @ Subnetmask: 255.255.252.0
DR o 5 Vintor = Gateway: 192.168.68.1
CBCI-1866-2.4 o
WPA2-TESTER = @ DNS server: 4.2.2.2

Status: Associated | Forget Network

4 Select the wireless network to connect to.

If it is a private network, a lock icon appears. You must enter the correct password
to access the private network.

5 If you want the instrument to forget the wireless network password as soon as it
connects, select the Forget Network button at the bottom right of the screen.

Playing videos

The T-BERD/MTS 5800v2, 5800-100G, 5882, SC 4800/4800P include a video player.
It can be used to play training videos, advertisements, or other videos. You can access
videos from USB or the file system. The player supports AVI, MP4, H.265/MPEG-4
video formats.

To play videos

1 Select the System icon, then select Video Player.
The player launches.
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: ﬂ' System B3] Tests B Fiber Optics (53 Video
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| Mo Open Media 00:00:00 / 00:00:00 -E| Quit |

2 Select Open File, then browse to locate the video that you want to play.

3  Select the video file, then select Open.
The video plays.

Setting up the Job Manager

The Job Manager allows you to specify the information to be included whenever you
run a test and generate a report. Each time you generate a report, your instrument will
automatically insert the Customer Name, Job Number, Technician ID, and Test Location
that you specified in the Job Manager into the report heading.

NOTE:

D The Job Number specified in the Job Manager will be provided as the default
Work Order Number when applicable to specific reports.

If you change the report information on the Report Info screen (before you generate a
report), the new report information will override the defaults that are specified in the Job
Manager. For example, if you change the Work Order number on the Report Info
screen, the Work Order number will be included in your report output instead of the
default Job Number.

To specify report information

1 Select the System icon, then select Job Manager.
The Job Manager screen appears.
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@System > & Job Manager

TEM Version 25.2.0.7657abb_dirty

Deactivate Job

Job Information

Customer Name
Job Number
Technidan 1D

Test Location

| VIP Customer

|123456

| germantown

Job information is automatically added to the test reports when Job Manager s active.

Test Plan

Fiber Inspection Cable: A, Connector; 123

CPRI Check

Radio: A, Band: 700

Create Summary Report

Reports

2 Specify the Customer Name, Job Number, Technician ID, and Location.

The report information is specified, and will be retained until you change it.

Job Manager Test Plan

The Test Plan section provides a list of planned test items associated with a job,
including the test type to be performed, reference information, and the pass/fail status.

If you load a test plan, you can select the test in the test list and the Launch button will
appear on the highlighted row. It will be enabled if the application is available on the
unit. Clicking the button will start the application and open its work flow screen. With the
test plan you can also automatically load the configuration and profile of the test.

Load jobs from a
file imported onto
instrument

Job information
applied to all
tests

View and launch
each required
test in the plan

sm > «kjob Manager

s 0 o

Job Information

=T Custesnier e VIP Curstoenes

b Hurmier Job baarniber 474643297
Technician s Tech
Test Logatien 10 M S

1b Infarmation Iy automatic atl saded b the LSt FEpoILs when jo8 Mankge! |3 Ktive.

Test Plan

Create a single
report containing
status of all tests

Saving test
reports moves
status of each
step from To Do
to Pass, Fail, or
Complete
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The Pass/Fail status is updated when the report for a planned test item is created. To
associate a report to a planned test item, you need to match the reference information
entered for the current test with the reference information specified in the desired
planned test item.

Selecting the Create Summary Report button allows the user to generate a report of
the test plan, including the associated report artifacts and the Pass/Fail status.

Selecting the Load Job button allows the user to load a new Job onto the instrument.
Attach a USB stick containing the job file and select Load Job to open the file dialog.
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Basic Testing

This chapter explains basic testing concepts and procedures common to each test.
Topics discussed in this chapter include the following:

“Preparing to test” on page 90

“Step 1: Selecting a test application” on page 109
“Step 2: Configuring a test” on page 113

“Step 3: Connecting the instrument to the circuit” on page 115
“Step 4: Starting the test” on page 115

“Step 5: Viewing test results” on page 118
“Running multiple tests” on page 125
“Scheduling timed tests” on page 131

“Creating and printing reports” on page 131
“Restoring test defaults” on page 138

“VT-100 emulation” on page 138

“HTML Viewer” on page 141
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Preparing to test

Before testing, Viavi recommends:
*  Verifying that you have the correct cables, connectors, transceivers, or adapters
required to connect to the circuit.

¢ Determining whether you need to synchronize near and far end instruments to a
high accuracy timing reference before beginning the test.

*  Determining whether a high accuracy timing reference is required for precise
measurements and analysis.

Understanding synchronization requirements

Some test applications will provide more accurate measurements and test results if
near and far end instruments are precisely synchronized using external high accuracy
timing references.

e The MSAM, CSAM, and 5800 can use optional, external CDMA receivers or the
optional TM4-4 GPS receiver to ensure that both instruments are synchronized,
providing measurements that are accurate within +/- 10 us. Instructions for
synchronizing test instruments using optional CDMA or GPS receivers are
provided in this manual.

* The 5800v2/100G, and 5882 can use an optional Timing Expansion Module
(TEM), to ensure that both instruments are synchronized per the same timing
reference and provide measurements that are accurate within +/- 10 ns. Instruc-
tions for synchronizing 5800v2/100G and 5882 test instruments using the optional
TEM Modules are provided in the Timing Expansion Module User Manual that
shipped with your TEM.

GPS is increasingly being used as a timing reference because it available almost every-
where and provides a common reference between various field locations. CDMA and
GPS receivers provide an accurate Time of Day (ToD) signal and 1 Pulse per Second
(PPS) signal, which, when averaged over a long time period, provide very precise
signals that can be used to create common timestamps and provide a reference clock
for instruments performing precise measurements.

When using GPS to synchronize timing on your test instruments, each instrument must
be equipped with the same type of receiver (CDMA or GPS).

ATP-GPS test packets

When your test instrument is synchronized to GPS time via the optional CDMA or
TM4-M GPS receiver (or via the optional TEM module), it tags outgoing Acterna Test
Packets (ATP) with GPS timestamps. The timestamps are required for accurate one
way delay, wander, and 1588v2 PTP, PDV, and Master-Slave delay measurements.
The receiving, synchronized instrument recognizes these packets and uses them when
performing the measurements.
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About CDMA receivers

CDMA base stations are synchronized to GPS time provided by a GPS Satellite; the
time is then broadcast to the CDMA receivers connected to your instruments. Alterna-
tively, if your instruments use GPS receivers, the receivers obtain highly accurate timing
information directly from a GPS Satellite (there is no intermediary base station).

Your instruments use the messages and signals provided by the CDMA or GPS
receivers to synchronize their internal clocks with GPS time. The receivers provide 1)
periodic messages with GPS time via the DB9, RJ-45, or USB connector on the instru-
ments, and 2) an accurate 1PPS signal into the BNC, SMA, or SMB connector.
Outgoing packets are then marked with GPS timestamps. If your instruments are
configured and optioned to do so, both test ports can be used, allowing you to measure
one way delay for two different circuits simultaneously. Connecting a CDMA Receiver

to an instrument

When you use CDMA receivers to synchronize your test instruments, the receivers
communicate with each other to establish synchronization.

Figure 54 illustrates each of the required connections for a CDMA receiver connected
to a T-BERD/MTS 5800 or a MTS6000 or MTS8000v2 base unit with a CSAM or

MSAM module.

Figure 54 CDMA connection for one way delay measurements
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To connect a CDMA receiver to your instrument

1 Connect the ToD signal between the CDMA receiver and the MST6000 or
MST8000.

a

Connect one end of the Ethernet cable to the serial RJ-45 port of the CDMA
receiver.

Connect the other end of the Ethernet cable to the RJ-45 to DB9 adapter.

Connect the other end of the cable to the instrument:

If using a DMC in an 8000v1 base unit, connect the DB9 adapter to the instru-
ment.

If using a CSAM or MSAM with a 6000A or 8000v2 base unit, do the
following:

i. Connect the DB9 end of the RJ-45 to DB9 adapter to the DB9 to USB
cable.

ii. Connect the USB end of the DB9 to USB cable to a USB port on your
instrument.

If using a CSAM, connect a SMA to SMA cable from “1PPS” output jack on
the CDMA receiver to a SMA to SMB adapter and then to the CSAM’s “CLK
OUT/1PPS” port.

2 \Verify that your instrument is synchronized with GPS time by checking the
CDMA Sync and 1PPS Sync LEDs. When synchronized, the LEDs will be illumi-
nated.

3 Repeat step 1 through step 2 on the second instrument.

The receivers are connected to your instruments, and the instruments are synchronized
with GPS time.

About GPS Receivers

Instruments using the optional TM4-M GPS receiver (instead of CDMA receivers)
communicate directly with the GPS satellite instead of via terrestrial-based radio broad-
cast by the base station. The GPS receiver will establish synchronization by using a
common signal received from a GPS satellite.

The GPS receiver provides accurate ToD and 1PPS signal, which, when averaged over
a long time period, provide very precise signals that can be used to create common
timestamps and as reference clock for other precision system measurements. The GPS
receiver provides a Time of Day (ToD) and a 1PPS signal which are used to generate
accurate time stamps that are encoded into the data transmitted between the local and
remote instruments.
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Connecting the GPS receiver to your instrument

To connect the TM4-M GPS receiver to your instrument

1 Connect the 1PPS signal between the GPS receiver and the instrument.

If you are connecting to a MSAM v1, connect the BNC to BNC cable from
“OUT B” on the GPS receiver to the J-Bullet attenuator, and then connect the
J-Bullet attenuator to the “EXT REF” connector on your instrument (see
Figure 55 on page 93, Figure 56 on page 94, or Figure 57 on page 94).

If you are connecting to a MSAMv2, connect the BNC to SMA cable from
“OUT B” on the GPS receiver to the “EXT REF” connector on your instrument
(see Figure 61 on page 97, Figure 62 on page 97, or Figure 63 on page 97).

If you are connecting to a 5800v1, connect the BNC to SMA cable from “OUT
B” on the GPS receiver to the “EXT REF” connector on your instrument (see
Figure 58 on page 95).

If you are connecting to a 5800v2, connect the BNC to SMA cable from the
“OUT B” on the GPS receiver to the SMA Timing Cable Adapter’s CLK1
connector, which is connected to the “EXT CLK” connector on your instru-
ment (see Figure 59 on page 95).

If you are connecting to a 5800-100G, connect the BNC to SMB cable from
the "OUT B" on the GPS receiver to the "EXT REF" connector on your instru-
ment.

If you are connecting to a CSAM, connect the SMA to SMB adapter to the
CSAM’s “CLK OUT/1PPS” port, then connect the SMA to BNC cable from the
adapter to “OUT B” on the GPS receiver.

Optional. Connect the DB9 to USB serial cable from the Control Port on the GPS
receiver to a PC.

Figure 55 GPS Reference Timing Connection Diagram- MSAMv1 w/ MTSG6000A

DB9-USB
(Optional GPS manitaring using
Spectrum Th-4 Control SW on PC)

BNC-BNC l

J-BULLET DBO-USE

Rightside view Top view
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Figure 56 GPS Reference Timing Connection Diagram - MSAM v1 in MTS8000v1

BNC-BNC DBY9-USB
(Optional GPS monitoring

using Spectrum Th-4 Contral
DE9-DBY SW gn PC)

J-BULLET

Top view

Figure 57 GPS Reference Timing Connection Diagram - MSAM v1 in MTS8000v2
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Figure 58 GPS Reference Timing Connection Diagram - 5800v1

DB9-USB
(Optional GPS monitoring using Spectrum
Th-4 Control 3¥W on PC)

RJ45-DB9

Right side view Top view

Figure 59 GPS Reference Timing Connection Diagram - 5800v2
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Figure 60 GPS Connection Diagram - CSAM

GPS Rubidium Receiver wi Anfenna

(Antenna)

DB-9 to USE Cable
__(Optional GPS monitoring using
= Spectrum TM-4 Control SW on PC)

SMA to BNC Cable DB-8 to USB Cable

SMA(F) to SMB(F) Adapter

%e ‘|

CSAM /O Panel 8000v2 /O Panel 6000Av2 /O Panel

2 Connect the ToD signal between the GPS receiver and the instrument.

— For an 8000v1, connect the DB9-DB9 cable from the “Time Port” on the GPS
receiver to the DB9 connector on the T-BERD/MTS 8000, 6000A, and 5800
(see Figure 56 on page 94 or Figure 62 on page 97).

— For a 5800v1, connect the DB9 to RJ-45 cable from the “Time Port” on the
GPS receiver to the RJ-45connector on the 5800 (see Figure 58 on page 95).

— For a 5800v2, 6000A or 8000v2, connect the DB9 to USB cable from the
“Time Port” on the GPS receiver to the USB port on the 6000A or 8000 (see
Figure 55 on page 93, Figure 57 on page 94, Figure 59 on page 95,

Figure 60 on page 96, Figure 61 on page 97, or Figure 63 on page 97).
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Figure 61 GPS Connection Diagram - MSAMv2 w/ MTS6000A
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Figure 62 GPS Connection Diagram - MSAM v2 in MTS8000v1
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3 Repeat step 1 and step 2 on the second instrument.

4  \Verify that it is synchronized with GPS time by checking the GPS Sync and 1 PPS
Sync LEDs. When synchronized, the LEDs will be illuminated.

Time Source

JY G

Hiztory

The 1PPS minimum pulse width that can be detected is 20us.

The GPS receivers are now connected.

Configuring GPS as the time source

After the TM4-M GPS receiver is connected to the instrument, the instrument must be
configured to use the GPS as the time source. If sync to the GPS is lost at any time, the
instrument will automatically switch to the internal oscillator as the PTP time source and
an event will be recorded in the log.

To select GPS as time source

1 If you haven’t already done so, use the Test Menu to select the test application for
the interface you are testing.
2 On the instrument, select the Setup soft key.

3 Select the Interface tab, and then on the CDMA/GPS Receiver tab, select the
Enable CDMA or GPS receiver check box.

The GPS receiver has been selected as the time source.

Understanding external high accuracy timing references

Some test applications require an external, high accuracy timing reference to provide
an accurate analysis.

If you intend to run an application using an external source of high accuracy timing (for
example, a GPS receiver such as the TM4M or the optional Timing Expansion Module/
TEM), it is important to understand the connections required to input the reference and
analyzed signals. This is especially true when providing signal input to a 5800v2 test
instrument via an SMA Timing Cable Adapter.
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Using the 5800v2 and 5800-100G to provide high accuracy
external timing

Your 5800 instrument can be used as a highly accurate external timing reference for
another device via one of the following:

* The EXT_CLK (white) cable provided on the Multi Access SMA Timing Cable
Adapter, which is connected to the EXT CLK connector on the 5800v2.

*  The 10 MHz OUT connector on the optional TEM Module if 1) the module is
connected to your 5800v2, 2) a GNSS antenna is connected to the module, and
3) the module’s rubidium oscillator has been tuned to a highly precise synchroni-
zation source. 5800-100G has a built-in GNSS receiver.

Preparing for optical testing

Before testing on optical circuits using the instrument, you should be familiar with the
following concepts.

Considerations

Before testing on optical circuits using the instrument, consider the following:

*  Only use the optical adapters and transceivers that shipped with your instrument,
or optics that you purchased from Viavi as accessories. A list of Viavi supported
optics shipped with your instrument.

* Details concerning the transceiver used for the currently selected application are
available on the Interface setup tab.

WARNING: HAZARDOUS LIGHT EXPOSURE

Do not look directly into the optical output of the unit or at the output of any
optical cable or transceiver connected to the unit. If a fiber optic cable is
removed from a transmitting connector or transceiver, cover the connector
with the safety cap to prevent inadvertent exposure to the laser output.

WARNING: RISK OF DAMAGE TO TRANSCEIVERS

When connecting the instrument to optical circuits using a transceiver, do not
apply optical power that exceeds the maximum optical power published as
permitted by the transceiver manufacturer.

If you do not know the optical power of the applied signal, use an attenuator
when you connect to the circuit for the first time, then remove the attenuator if
you determine that it was not necessary. Otherwise, the transceiver can be
permanently damaged due to the “hot signal”.

A variety of attenuators are available for purchase as options when you order
your instrument.
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Verifying supported line rates

Before testing, verify that the optic can support the line rate for the circuit that you are
testing.

1 Press the Setup soft key.

2 Select Interface, then view the Connector tab.

TigeryNC; mts5800-5201ea:0

Interface

Connector | signal | Physical Layer | Network visbility | GPS/COMA Recever |

SFP

Wavelength (nm)  1550.00 Cable Length (m) ©

Vendor FINISAR CORP. Nominal Rate (Mbits/sec) 2,500
Vendor PN FTLF1521P1BCL Min Rate (Mbits/sec)  ===-
Vendor Rev A Max Rate (Mbits/sec) ----
Power Level Type Average Power

Diagnostic Monitoring 1 Max Rx Level (dBm) -1.00015
Diagnostic Byte 88 Max Tx Level (dBm) 2.00002

e SONET/SDH OC48 IR-2; Ethernet T000BASE-LX; FC Link Length Very Long;
FC Tx Tech LL; FC Trans Media SM; FC 200 MBytes/Sec; FC 100 MBytes/Sec

CPRI: 614.4M, 1228.8M, 2457.6M, 3072.0M -- OTN; OTU1 2.7G -
SONET/SDH: OC-3/STM-1, OC-12/5TM-4, OC-48/5TM-16 -- Fibre
Recommended Rates  cpannel: 16ig, 26ig -- Ethernet: 16 - OBSAL: 768M, 1536M,
3072M

The recommended rates are listed. Press the Results soft key to return to the results
screen.

If the line rate is not supported by the transceiver, “Recommended optic rates not avail-
able” appears. Turn the instrument off and try another transceiver.

Tuning SFP+ and XFP transceivers

The ITU-T G.694.2 standard provides a frequency grid for DWDM which creates
channel spacing from 12.5 GHz to 100 GHz. The channel spacing allows different
carriers to run on the same fiber. Using a tunable SFP+ or XFP in our instrument, you

can use different channels or wavelengths. Most XFPs are designed for C-band wave-
lengths.
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To tune an SFP+ or XFP transceiver
1  Verify whether your transceiver supports tuning by viewing the Connector Setup.

dnjenyee Connector | Signal | Physical Laer | Network Visiblty | GPS/CDMA Recever

SFP
Wavelength (nm) 1550.00 Cable Length (m) 0
Vendor FINISAR CORP. Nominal Rate (Mbits/sec) 2,500
Vendor PN FTLF1521P1BCL Min Rate (Mbits/sec) ===
Vendor Rev A Max Rate [Mbits/sec) ----

Power Level Type  Average Power

Diagnostic Monitoring 1 Max Rx Level (dBm) -1.00015

Diagnostic Byte 88 Max Tx Level (dBm) 2.00002

SONET/SDH OC48 IR-2; Ethernet 1000BASE-LX; FC Link Length Very Long;
FC Tx Tech LL; FC Trans Media 5M; FC 200 MBytes/5Sec; FC 100 MBytes/Sec

CPRI: 614.4M, 1228.8M, 2457.6M, 3072.0M -- OTN: OTU1 2.7G --
SONET/SDH: OC-3/5TM-1, 0C-12/5TM-4, OC-48/5TM-16 -- Fibre
Channel: 1Gig, 2Gig -- Ethernet: 1G -- OBSAL: 768M, 1536M,
307ZM

Transceiver

Recommended Rates

This screen varies depending on the device.

The first two lines under the SFP or XFP tab relate to the tunable characteristics
of the transceiver. The first indicates that the transceiver is tunable, and may
show which wavelengths are tunable. The second line indicates which types of
tuning are supported.

2 Do one of the following:

a To specify the tuning in the Setup menu, do the following:
- Select the Signal tab.
- Select the Tuning Mode: Channel, Wavelength or Frequency.

- If you selected Wavelength, specify the wavelength. The available wave-
length range appears. If you selected Channel, specify the channel. The
available channel range appears.

- If you selected Frequency, specify the frequency. The value entered will
be converted and the available wavelength and/or channel ranges
appear.

- If the transceiver being tuned is capable of channel-only or wavelength-
only tuning, the user selected value will be translated to the appropriate
value and tuning method respectively. If the device is tunable by both
wavelength and channel, the software will determine the closest channel
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(50 GHz spacing) and wavelength (50 nm spacing) value. The tuning
method with the smallest difference to the user selected value will be
used to tune the transceiver.

b To specify the tuning on the Main screen, do the following:
- Press the Result soft key.

- Use the Laser action buttons to specify the Tuning Mode: Frequency,
Wavelength or Channel.

- If you selected Wavelength, click on the wavelength field, and use the
keypad to enter the wavelength.

- If you selected Channel, click on the channel field, and use the keypad to
enter the channel.

- If you selected Frequency, specify the frequency. The value entered will
be converted and the available wavelength and/or channel ranges
appear.

If the transceiver being tuned is capable of channel only or wavelength only
tuning, the user selected value will be translated to the appropriate value and
tuning method respectively. If the device is tunable by both wavelength and
channel, the software will determine the closest channel (50 GHz spacing)
and wavelength(50 nm spacing) value. The tuning method with the smallest
difference to the user selected value will be used to tune the transceiver.

The transceiver is tuned.

Testing Optics and Cables

The Optics Self-Test and the Cable Test scripts are available for all 10G/25G/40G/100G
interfaces on T-BERD/MTS. They allow users to verify the proper operation and stability
of the CFP, CFP2, CFP4, QSFP28, QSFP+, SFP+, or SFP28 transceiver(s) connected
to their 5800v2, 5800-100G, or CSAM. The Optics Self-Test and Cable Test applications
appear as the topmost entries in the Start Test menu.

The Optics Self-Test or Cable Test verify signal presence, level (at all possible rates),
and rejection of excessive skew. They also allow you to specify a BER threshold and
maximum Offset (in PPM). You can save and reload the test configuration, and observe
results for the underlying application while the test is running using the Go To... button.
The Cable Test enables users to test optical or copper cables terminated by SFP or
QSFP cages in a 5800v2 and 5800-100G.
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Testing Active Optical Cables and Direct Attach Copper cables using T-
BERD/MTS 5800-100G and 5800v2

An active optical cable (AOC) is a multimode fiberized cable with pluggable optic cages
such as QSFP or SFP, permanently mated to both ends.

Figure 64 AOC Cable

= i

Direct Attach Copper (DAC) is a similar device but with copper cables. These AOC/
DAC cables are used inside data centers to, for example, connect a TOR (Top of Rack)
switch to a Leaf/Spine. These cables may cause errors due to manufacturing defects
such as reversed polarities or potentially crushed or squeezed optical fibers. Errors can
be identified before cables are laid avoiding extra effort to replace the cable, or to
prevent discarding a good cable by mistake. The T-BERD/MTS 5800-100G and 5800v2
enable technicians to test such cables quickly and easily via a built-in script.

AOC and DAC cables testing includes the following features:

— Cable Test script built into the T-BERD/MTS 5800-100G or 5800v2

— Test reports capture the serial number of the cable tested, as well as the
setup and results

— Pass/fail results against adjustable bit error rate threshold
—  Choice of five report file formats

— Available for tests at 10GigE LAN (for T-BERD/MTS 5800v2, 5800-100G, and
CSAM); 25GigE (for 5800-100G); 40GigE, 100GigE, and 100 GigE RS-FEC
(for CSAM and 5800-100G)

— User can save and reuse configuration files

Running the Optics Self-Test and Cable Test

To run the tests:

1 For the Cable Test, connect the AOC or DAC cable between 2 ports. For the
Optics Self-Test, connect an optical cable between the interface input and output
ports.

2 Use the Test Menu screen to select the Optics Self-Test or Cable Test (located
under it in the image below) application for the interface you are testing.
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Figure 65 Selecting Optics Self-Test.

#- 1006 'i Optics SelfTest . .‘ P1 Optics Self-Test :
; [l cable Test *| ] _ 2
i &= 2561 gl QuickCheck »  LayeraPIPmsEs »
Ethernet [l oi00ri000 »| M RFC2544 » © Layer 4TCP Wirespeed
Fibre Channel * 1Gigk Optical * S8 S ComaIRte o
OTN » 10GIELAN  » ad RFC 6349 TrueSpeed » .
Timing * 10GIgE WAN Layer 1 BERT » I
25GigE ¥
4 Load TesL.. s0cigE . Layer 2 Traffic »
! Save Test As... 100GigE » Layer 2 Multiple Streams  *
Q +|  100GigE Rs.FEC »|  Layer 2 Triple Play '
@ Remove Test » LA 2 s e ¥
Layer 2 MPLS-TP Traffic L4
Layer 2 PTP/1588 "
Layer 3 Ping »
Layer 3 Traceroute 4
| &< Hide Menu i Tramlc ' | €3 dose |
L | Layer 3 Multiple Streams * | - .

3 Onthe next screen you have three configuration options: Edit Previous Configu-
ration, Load Configuration from a Profile, and Start a New Configuration
(reset to defaults), each with a Go button. Pick your option by clicking the Go
next to it.

Configure

1L Netmunneg

-ﬁ Configure

" Edtprevious Configuration G wmp
[ Load Configuration from a Profile 6o -p|
L]

4 Start a New Configuration (reset to defaults) | Go = |

4 The next screen for the Optics Self-Test has one pane (the right one in the image
below). The Cable Test screen has an additional Test Topology pane. The two-
ports test is run by the Launch Other Port button and is only available on
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correctly optioned dual port units. It launches the appropriate test application to
test a cable from port 1 to port 2. Any application already running on the other port
will be closed.

' System Tes[s F|her Optics ne ™ o iSP PM

Cable Test Port 1: 10GigE LAN Layer 2 Traffic Term

o[

m Configure

Test Duration Recommended =

Launch Other Port
The recommended time for this configuration Is 1 minute(s).
BER Threshold 1%10~-8

b Stop on Error

Configure Repor Info

5 For both the Cables test and Optics Self-Test, specify the following:

— Test Duration. If you set test duration to User Defined, you can define your
value in minutes or seconds.

— BER Threshold. If you are running the cable test for 25GigE (where RS-FEC
is implicit) or for 100GigE RS-FEC, there is a BER Threshold Type selection
of Pre-FEC (default) or Post-FEC.

NOTE:

b The recommended test times are calculated using BER theory based on the
following:

» confidence level (CL) set to 95%
e the user-defined BER threshold
* the duration depends on the line rate selected from the applications menu

— Stop on Error. If enabled, the test stops immediately upon discovery of an
out-of-parameter result.

— Once you have configured your test, you can create a saved profile by
clicking the blue Save Profiles link. Afterwards you can load these profiles by
pressing the Go To button and clicking Configure to return to the earlier test
configuration screen where you can restart the tests.
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6 On the next Report Info screen, fill out all entries and press Next.

Report Info
T wetmaning

& Test Report Information

Customer Name: |Demo

Technician ID: [

Test Location: -

Work Order: |a

Comments/Notes: |-

None selected...
Report Logo

Clear |WJ

7 On the Run Test screen, start your test by clicking the test button (Test SFP
Cable on the screen below). You will see the results overview on the left pane.

.];'-: 3
i

Ru.n Test
|79 [ et manieg

Connect an Active Optical Cable (AOQ) or Direct Attach Copper (DAC) between 2 SFP ports including this port.

Results Overview
1 o S
Optics/Slot Type: SFP 5 Test SFP
Signal Presence Test: None &@ | Cab_l'e l
Optical Signal Level Test: None
Excessive Skew Test: None
Current PPM Offset: o
BER Threshold Test: None
Current BER: 0.00E+00
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8 Optional. To verify the specifics of the optic being tested, select the ﬂ
symbol next to the graphic of the transceiver. A list of specifications (including the
SN) similar to the following will appear.

Mominal Wavelength (nm) 0 Power Level Type OMA

Yendor ELPEUS TECHMOLOG Rx hax Lambda Power (dBm)  -0.849169
Yendor P QSFP-LB T Max Lambda Power (dBm)  Unavail
Yendor SN P32331000026

“Yendor Rew 00 Mominal Bit Rate (Mbits/sec) —

[Date Code 110407

Lot Code Diagnostic Byte 0

Transceiver 00 00 00 00 00 00 00 00 59

Select the Back button to return to the test.

9 If you are testing a QSFP+/QSFP28 on CSAM and the transceiver is capable of
bypassing transmit or receive clock data recovery (CDR), you can bypass CDR.
Do the following:

— To bypass transmit CDR, select Tx CDR bypass enable.
— To bypass receive CDR, select Rx CDR bypass enable.

NOTE: If the QSFP is not capable of bypassing CDR, these settings will be
disabled.

10 Click Next to proceed to the Report screen.

Generating Reports

1 After the Optics Self-Test or Cable Test have concluded, select the Next arrow at
the bottom of the screen.

The Report screen appears.

‘g System l] Tests Fiber Optics
ble Test

Report

» PDF csv Text HTML XML
File Name
Cable_Test-2017-10-20T18.07.10 select... |
¥ View report after creation - » Create r=) View

Include message log 4 Report * Report

Skip Report Creation,

Cable Test Cable Test
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Select the report format in the Format pane.
To view the report without saving it, select the View Report button.
To save a report, do the following:

a Enter the filename of the report to be saved. File names of other saved
reports are accessible via the Select button after the File Name box.

b Click the Create Report button. If the View Report after Creation check box
was checked, the report appears. If not checked, a message appears
confirming that the report was saved. Select OK.

¢ If checked, the Include message log box will add a message log to the
report.

If Job Manager was activated in the System page, the generated report will be
available in the report section of the Job Manager application. The reference infor-
mation lists the Serial Number, Optics type and Vendor for SFP and SFP28 optics
along with the tests results. Job Manager activation is recommended for the
Cable Test. Note: Job Number in Job Manager is the same as the Work Order
(number) in the report information.

A summary Job Manager report can be generated to provide the summary of all
the cable and optics tests performed.
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Step 1: Selecting a test application

There are two methods available for selecting a test application. The first method uses
the Quick Launch screen, which lists pinned (saved) and recently run tests. The second
method uses the Test Menu, which lists every available test for the currently installed
options and configuration of your instrument.

NOTE:

D Some tests (for example, the NextGen GFP tests) only appear if you pur-
chased the associated testing options for your instrument.

When testing using an MSAM, only the tests supported by currently inserted
PIMs will appear on the Test menu. For example, if an SFP and XFP PIM are
inserted in the MSAM chassis, you will not see DS1 applications.

About the Quick Launch screen

The Quick Launch screen allows you to select and run pinned and recently run tests
quickly without navigating through the Test Menu. Instead of selecting the technology,
signal, payload, and test mode from the Test Menu, you can launch a previously config-
ured test directly from the Quick Launch screen in a single step.

Figure 66 shows a Quick Launch Screen with a number of commonly used Ethernet
applications pinned to the screen, and three applications that were recently selected.
The Test Menu also appears to the left of the screen; you can hide it if you want to using
the Hide Menu button (provided at the bottom of the screen).

Figure 66 Quick Launch Screen (with Test Menu shown)

i3] Teors, 0 ; 2 =d 1034 AM
© system | [ Tests | G Fiver Optic @08 BTN
Select . port 1:10/100/1000 Eth Layer 2 Traffic Term
DS1/DS3 »
EvEEd  »| AN
SONET ]
i
SDH (]
Ethernet 2 e
Fibre Channel »
CPRI y|
DBSAL »
oTN » £
Optical BERT » ﬁ
Timing »
¢
& Load Test..
.
Il Save Test As...
.
Iy Add Test *
< Hide Menu Customize €3 Close
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Pinned tests

An icon appears to the left of each pinned test representing the application or tech-
nology that is supported by the test. Table 11 lists the icons used to represent key appli-

cations.

Table 11 Quick Launch Icons

IP Video

Y.1564 SAMComplete

Application Icon Application Icon
1 PPS Analysis or J-Profiler
Wander Analysis — .E
CPRI/ OBSAI Multiple Streams —
hAI’.-r m—
—
DS1 and ISDN PRI DS PTP/1588 i
1 e
DS3 - RFC 2544 m
DS3
E1 and ISDN PRA . RFC 6349 Truespeed
E. (g
E3 g SDH and OTN E_,..n-l"_'_..---
a
E4 g SONET and OTN e
i
Ethernet Quick Check ﬁ' TCP Wirespeed @
Ethernet Traffic TrueSAM
- -a
Fiber Channel Traffic S VolP
> "
N S

Recently selected tests

Up to three recently selected tests are also identified on the Quick Launch screen using
a pin icon:
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You can run the tests from the Quick Launch screen (without pinning them), or you can
pin a test to the Quick Launch screen by 1) selecting the pin icon, and then 2) either
accepting the default test name or entering a different test name for the test when
prompted. This allows you to be more descriptive about the test configuration. For
example, if you pin a 1 GigE Layer 2 Ethernet test that is configured to transmit VLAN
tagged frames, you can append the default test name with “VLAN” to indicate that the
test was configured for VLAN tagged traffic.

Launching a test from the Quick Launch screen

To launch a test from the Quick Launch screen

1 If the Quick Launch screen did not appear by default when you turned on your
instrument, on the Main screen, click Select Test.

The Quick Launch screen appears.

The All Tests and Hide Tests buttons are used to display or hide the Test Menu to
the left of the screen; the Customize button is used to maintain and customize the
list of tests that appear on the screen.

2 If the test you want to launch appears on the screen, select the test; otherwise,
customize the screen to add the test (see “Customizing the Quick Launch screen”
on page 111), then select the test on the Quick Launch screen.

3 Wait for the test to launch and appear on the Main screen, then proceed to “Step
2: Configuring a test” on page 113.

The test is launched.

Customizing the Quick Launch screen

Using the Customize Test List dialog box, you can add shortcuts to new tests, add
saved tests, and rearrange, rename, or delete existing tests that appear on the screen.

To customize the Quick Launch screen

1 On the Main screen, click Select Test.
The Quick Launch screen appears.

2 Select the Customize button at the bottom center of the screen. The Customize
Test List dialog box appears.
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4

Do the following to customize the Quick Launch screen:

— To add a shortcut: Select the Add Shortcut button, then use the Test Menu
that appears to navigate to and select the test that you want to save as a
shortcut on the Quick Launch screen.

— To add a saved test: Select the Add Saved Test button, then select a previ-
ously saved test from the Select Saved Test dialog box. Press Ok to save the
selected saved test - it will appear as a favorite on the Quick Launch screen.

— To delete one or more tests: Use the Delete button to delete a single selected
test, or the Delete All button to delete all selected tests. You will be prompted
to confirm the deletion before the tests are deleted from the Quick Launch
screen.

— Torename a test: Select the test that you want to rename, then select the
Rename button. Enter a new name for the test, then select Ok.

— To rearrange the tests: Use the Move Up and Move Down buttons to move
the selected test to a new position within the list of tests.

— Toinsert a separator between two tests: Select the test under which you want
to insert the separator, then select the Separator button. This allows you to
group tests on the screen by technology, line rate, technician, customer, or
any manner that is helpful to you.

If you want the Main screen to appear by default when you start your test instru-
ment (instead of the Quick Launch screen), select Show results at startup.

The Quick Launch screen is customized.

Launching a test using the Test Menu

Tests are grouped and listed on the Test Menu by technology (for example, Ethernet or
SONET), signal, payload, and test mode.

NOTE:

D If the Test Menu is not displayed, select the All Tests button (located at the bot-

tom left of the Quick Launch screen). The Test Menu will appear.

To select a test using the Test Menu

1

On the Main screen, click Select Test.
The Quick Launch screen appears.
— If the Test Menu appears to the left of the screen, proceed to step 2.

— If the Test Menu does not appear, select the All Tests button (located at the
bottom left of the Quick Launch screen). The Test Menu will appear.

Using the Test Menu, select the technology, signal, payload, and test mode for
your test.

The instrument displays a message asking you to wait while it loads the test.

Wait for the Main screen to appear, and then proceed to “Step 2: Configuring a
test” on page 113.
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The test is selected.

Step 2: Configuring a test

Configuring a test involves displaying the setup screens, specifying test settings, and
optionally saving the test setup.

Key settings are also available on the Main screen, on the Quick Config tabs. Changing
key settings while running a test (for example, changing the pattern transmitted) trig-
gers an automatic restart of the test.

Displaying the setup screens

To display the setup screens

1 Using the Test menu or Quick Launch screen, select a test application (see “Step
1: Selecting a test application” on page 109).

2 Select the Setup soft key.

The setup page appears and typically includes a series of tabs. The tabs
displayed vary based on the test application you selected. See Figure 67.

Figure 67 Setup Screen (Ethernet Settings tab for GFP testing)

mterface] SDH\ Lcas | Grp Ethernet| Trafﬁcl Filtersl Timed Test}

Encapsulation
Frame Type
Frame Size (Bytes) 312 -
DA SA Twpe Data

3 To navigate to a different setup screen, select the corresponding tab at the top of
the screen. For example, to display the Traffic setup screen, select the Traffic tab.
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4  After you finish specifying the test settings (see “Entering data in the setup fields”
on page 114), select the Results soft key to return to the Main screen.

TIP:

D If you want to provide a screen shots of a configuration tab (and the settings
that you specified on the tab), on the Main screen, select

Tools > Capture Screenshot. A screen shot will be captured and stored as
a JPG file in the

/acterna/user/storage/bert/images folder. You can include the
screen shot when you create reports.

Entering data in the setup fields

When specifying test settings, you can either select a value from a drop-down menu,
or tap the field to launch a keypad, then type a value.

To select a value from a drop-down menu

* Select the arrow icon to the right of the field, and then highlight the value for the
setting.

To type text or numeric values

* Select the field to launch a keypad, type the value, and then select OK.
The value appears in the field.

NOTE:

D The valid ranges and values for user-specified settings appear at the top of
the keypad. For example, if you configure a constant traffic load for a 10 GigE
LAN circuit, 0.001 .. 100.000 appears at the top of the keypad, indicat-
ing that a number ranging from 0.001 to 100.000 is a valid value for the
load percentage.

Saving setups

After you specify your test settings, you can save the setup (configuration) to use it
again for future tests.

To save a setup (configuration)

1 On the menu bar of the Main screen, select Test > Save Test Config As...
The Save Test Configuration screen appears, listing existing saved setup files.

2 Select the arrow icon to the right of the Look in: field, and then highlight the direc-
tory where you want to save the configuration.
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7
8

Select the Save Config soft key.
The File Name dialog box appears.

Select the keypad icon directly to the right of the Enter a name for the test: field.
A keyboard appears on the screen.

Use the keyboard to type a name for the saved setup file. You do not need to
enter the .tst extension; the module automatically appends the extension to the
name.

If you want to secure the setup so other technicians can not modify it (or delete it
using the Delete All button), select Save as read-only.

Select OK to save the setup.

To return to the Main screen, select the Exit soft key.

The setup is saved and the file appears on the screen with the other saved setups.

If you setup multiple tests, the settings are saved in a dual configuration file. For more
information, see “Running multiple tests” on page 125.

Understanding write-protected configurations

If you indicate that you want to save a configuration (setup) as read-only, the following
OCCUrs:

Any custom result categories defined for the configuration are also protected.
The configuration can not be deleted using the Delete All button.
The configuration can be deleted using the Delete button.

When you import a read-only configuration file onto your instrument, the instru-
ment will retain the read-only permissions. Any custom categories defined for the
configuration will also be imported.

Step 3: Connecting the instrument to the circuit

For detailed instructions on connecting your instrument to the circuit, refer to the appro-
priate testing manual for the circuit you are testing. Basic instructions are provided in
Chapter 3 “Getting Started” of this manual.

When connecting the unit to optical circuits, bear in mind that applied power must not
exceed the power level specified on the panel for each optical connector.

Step 4: Starting the test

After you configure a test and connect the unit to the circuit, the following occurs:

If you are running a PDH, or classic SONET or SDH application, and you are
testing an optical circuit, you must turn the laser ON. The test starts automatically,
and test results immediately accumulate.
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* If you are running an Ethernet, OTN, Fibre Channel, or NextGen application
(launched from the SONET or SDH test menu options), and you are testing an
optical circuit, you must turn the laser ON, then actively Start Traffic (using the
corresponding action button).

* If you are running an Ethernet or Fibre Channel application, and you would like
your unit to transmit traffic automatically, you can enable the automatic traffic
generation feature. For details, refer to the Ethernet and Fibre Channel Testing
Manual that shipped with your instrument or upgrade.

NOTE: Temperature stabilized lasers

D When testing 10 Gigabit, 40 Gigabit or 100 Gigabit optical circuits, some lasers
(particularly 1550 nm lasers) are temperature stabilized; therefore, they need to
reach a certain temperature before you can use them to transmit a signal. This is
expected behavior, and does not indicate that there is something wrong with the
laser or test instrument.

It typically takes up to one minute for the temperature to stabilize. If you have turned
the laser on, but no signal is present on the receiving instrument or device, simply
wait for one minute.

Using the Action buttons

After you start a test, use the buttons at the bottom of the screen to perform actions
such as turning the laser on and off, starting and stopping traffic, starting and stopping
a local loopback, and inserting errors, anomalies, alarms, or defects.

Table 12 lists some common Action buttons.

Table 12 Action buttons

Button Action

Laser On/Off' Turns the laser on or off when testing optical rates.
Insert Error/Anomaly Inserts an error or anomaly into the transmitted traffic.
Insert Alarm/Defect Inserts an alarm or defect into the transmitted traffic.

Start Traffic/Stop Traffic Starts or stops transmission of Ethernet, IP, Fibre Chan-
nel, OTN, TCP/UDP, or GFP traffic over the circuit.

1. You can optionally configure optical standard Ethernet and Fibre Channel applications to automatically transmit
traffic after you turn the laser ON.

Controlling laser transmission

Some optical transceivers are capable of transmitting signals from different lanes. If you
are testing using a CSAM and your transceiver has this capability, after you turn the
laser on, you can “poke” the A013 register to turn lasers off for specific lanes within the
register.
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The “poke” function is only available for the A013 register, which is dedicated to the
control of the transceiver’s lasers. A related “peek” function allows you to determine the
status of any valid register by reading the corresponding peek value.

To turn off laser transmission for a specific lane or lanes
1 Select your test application, configure the test, connect your instrument to the
circuit, then turn the laser ON.
2 From the main menu, select the Setup soft key. A series of setup tabs appear.
On the Interface tab, select the Connector tab, then select the MDIO tab.
4 To turn lasers OFF for a specific register, under Poke, do the following:
In PokeRegAddr, enter the register address (A013).

b In Poke Value, enter the bit value representing the lane for which the laser
will be turned off:

- 0001 indicates that the laser in the first lane should be turned off.
- 0002 indicates that the laser in the second lane should be turned off.
- 0003 indicates that the lasers in both lanes should be turned off.

¢ Select Poke.

The lasers are turned off for the specified lanes.

To check the current status of a register

1 Select your test application, configure the test, connect your instrument to the
circuit, then turn the laser ON.

2 From the main menu, select the Setup soft key. A series of setup tabs appear.
On the Interface tab, select the Connector tab, then select the MDIO tab.

4 Under Peek, do the following:
a In PeekRegAddr, enter the register address.
b Select Peek.

The displayed Peek Value indicates the status of the register.

Restarting a test

To restart a test

* Press the Restart soft key.

The unit clears your test results, and then the test restarts.
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Stopping a test

When you stop a test, test results immediately stop accumulating, but remain on the
display until you start the test again.

Tos

The

>

top a test
Press the START/STOP button.

test stops. To start the test again, you must press the START/STOP button.

NOTE:

If you scheduled a timed test, the test stops automatically after running for the
duration you specified.

Step 5: Viewing test results

Test

Setting th

Tos

1

results appear in the Results Windows of the Main screen.

e result group and category

et the result group and category

Using the Test menu or Quick Launch screen, select a test application see “Step
1: Selecting a test application” on page 109), and then configure your test (see
“Step 2: Configuring a test” on page 113).

Select the Results soft key to return to the Main screen.

Connect your module to the circuit. For details, refer to the testing manual for the
circuit you are connecting to.

If you are testing an optical interface, select the Laser button.

If you selected an Ethernet, Fibre Channel, or SONET/SDH GFP test application,
select the Start Traffic button to start generating and analyzing traffic.

Results appear in the Results Windows.
Optional. Insert errors or anomalies into the traffic stream, or use the Action

buttons to perform other actions. These buttons only appear if applicable to your
test application.

Use the Group and Category buttons to specify the type of results you want to
observe. Figure 68 illustrates buttons for a standard SONET application.

Figure 68 Result Group and Category buttons

Ak

Interface :ISignaI
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Results for the category you selected appear in the result window.

8 Optional. To observe results for a different group or category in another result
window, press the buttons at the top of the window to specify the group and cate-

gory.

For descriptions of each result, refer to the testing manual for the technology you are
testing.

TIP:

D If you want to provide a screen shot of key test results, on the Main screen,
select Tools > Capture Screenshot. A screen shot will be captured and
stored as a JPG file in the /acterna/user/disk/bert/images folder.
You can include the screen shot when you create reports.

Expanding and collapsing result measurements

Certain test results for which a variety of measurements are made (such as current,
average, minimum, or peak throughput measurements) can now be expanded (to see
all measurements for the test result), or collapsed (to hide measurements for the test
result). When multiple measurements exist for a result, a plus or minus sign appears to
the right of the result name.

Collapsing the results that you are not interested in reduces scrolling, and allows you
to observe more results that you are interested in simultaneously.

To expand result measurements

*  Select the plus sign to the right of the result name, or

e Select the plus sign at the bottom or the result window to expand all expandable
results.

To collapse result measurements

«  Select the minus sign = to the right of the result name, or

e Select the minus sign at the bottom or the result window to collapse all collapsible
results.

Changing the result layout

You can change the default layout of the test results on the Main screen. In many
instances it is helpful to use the Full Size layout.

To change the default result layout

1 Select View > Result Windows.
A menu listing the available layouts appears.
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2 Select a new layout.

The Result Windows appear using the layout you selected.

Using the entire screen for results

You can expand a single result pane to use the entire screen by selecting the Full
Screen button at the bottom of the pane.

To use the entire screen

1 Use the Group and Category buttons to specify the type of results you want to
observe.

2 Select the Full Screen [I' button provided at the bottom of the results
pane.

The pane expands to use the entire screen, and the result layout options provided
by selecting View > Result Windows are disabled.

To restore the screen to its original layout, select . After returning the screen to
its original layout, the layouts available from the View menu will be enabled.

Setting the blink option on errors

To alert the user to an error condition, the tab at the top of the screen, indicating the
current application, can be configured to blink when there is an error condition.The
Summary results background can also be configured to blink if a more obvious indicator
is helpful.
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Configuring the blink option

1 Select Tools > Customize from the menu bar.The Customize User Look and Feel
window appears.

Customize User Interface Look and Feel

Settings apply to all tests running on this module and will reset all results

Result/Setup Terminology [TestPad = ]
GUI Style (requires reboot) [ Dark = ]
Startup View [ Results View = ]

+| Blink on Error

+ Blink Summary Results

2 Select the check boxes for Blink on Error to have the tab blink and Blink
Summary Results to have the Summary background blink. Blink on Error must
be checked to activate the Blink Summary results option.

3 Select Close.

The blink on error option is activated.

About histogram results
A histogram is a display or print output of test results in a bar graph format. Histograms

enable you to quickly identify spikes and patterns of errors or anomalies over a specific
interval of time (seconds, minutes, or hours).

Viewing a histogram

To view a histogram

1 Set one of your result groups to Summary, and then select the Histogram cate-
gory.
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The Histogram display appears.

Figure 69 Histogram display (full size)
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2 You can modify the default display as follows:

— To view the complete histogram, select Full Size view (see “Changing the result layout”
on page 119).

— To scroll horizontally through the display, use the arrow keys at the top of the pane.

— To change the histogram interval, select the arrow keys to the right of the interval button
(illustrated as “Sec” in Figure 69), and then select the new interval (Min, Hour, or Day).

NOTE:

>

Histograms are not available when running IP Video applications; however, an
event log is available.

About the Event log

An event log is a display listing any errors, anomalies, alarms, or defects that occur

during the course of your test. The log displays the value for each event, and provides
the date and time that the event occurred.

Viewing an event log

To view an event log

1 Select the Summary group, and then select the Event Log category.
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The associated Event Log appears.

Figure 70 Event Log display (SONET application)

Summary il Event Log ij
Mo, Event Date Start Stop Duar fal.
2| Fattern Sync Loss 0272002007 | 0204535 pm| In progress On
3| Frm Syn Loss 0272002007 |020453 .58 pr| In progress On
4| LOF-F 0202002007 | 0204535 pm| In progress On
5| Fath Ftr Loss 0272002007 | 0204535 pm| In progress Onj|
G| Frame "Wd Errs 0272002007 | 0204535 pm|02:04:53.9 pm 28 —

2 To scroll through the display, use the arrow keys at the top of the pane.

The event log is displayed.

About result graphs

You can observe a some results graphically, such as frame loss, packet jitter,
throughput, or errors. Each graph provides a legend underneath the results to help you
interpret the graph, and controls above the results that allow you to customize the scale
and indicate whether you want to observe the mean, minimum, or maximum value for
the results.

Viewing graphs

To view a graph

1 Select the Graph group, and then select the category for the results you want to
observe.
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The associated Graph appears.

Figure 71 Graph display (Ethernet application)
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2 To scroll through the display, use the arrow keys at the top of the pane.

The graph is displayed. You can optionally save the data by selecting the Save Plot
Data icon at the top of the graph.

Clearing History results

To clear history results

* Select Tools > Clear History.

Historical LED results are cleared.

Creating and maintaining Custom result groups

For each available test application on your unit, you can create Custom result groups
with results from a variety of categories. This allows you to quickly view certain results
on a single result pane without navigating through each individual category. You can
add up to 50 results to each Custom group.
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To create or maintain custom result groups

1 Set one of your result groups to Custom. If this is the first time you are creating a
group, the Custom result pane is empty.

2 Do one of the following:
— To add a new group, select New ....

— To update an existing group, select the check box to the left of the group
name, then select the wrench icon.

The Configure Custom Results Category screen appears. Summary results
appear in the pane on the left of the screen, and buttons appear at the top of the
pane which allow you to display and then select results from any category for your
application.

3 Do one of the following:

— To add results, use the buttons at the top of the left pane to specify the group
and category for the results you want to add, then highlight the result you
want to add to the category.

Select the right arrow key to move the result to the Selected Results pane.

— To remove results, select the result you don’t want on the Selected Results
pane, then select the left arrow key to move the result back to the left pane. If
you want to delete all of the results in the category, select Clear.

4 Repeat step 2 and step 3 for each custom group that you want to add or maintain.

After you finish populating the custom category with results (or modifying the
results), press Save to store the category and return to the Main screen.

The Custom result group is populated.

You can use the Delete button on the result pane (on the Main screen) to delete a group
at any time.

NOTE: Protecting Custom Result Groups

D When you protect a saved test configuration by making it read-only, the asso-
ciated custom result group is also saved and is protected.

Running multiple tests

If your instrument is configured and optioned to do so, you can significantly reduce your
testing time by terminating traffic over multiple circuits simultaneously. When running
multiple tests, you should power your instrument using the AC power adapter that
shipped with the instrument. If the instrument loses power while running multiple tests,
when you restore power, the instrument will only restore the last active test application.

NOTE:

D Only one application can be run at a time using the CSAM, or single port
5800.
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Restrictions

Certain applications require more system resources; therefore, your instrument may
not be able to run more than one application simultaneously, or you may need to
consider the temperature before running the tests. Table 13 lists the applications that
are limited to a single test, or should be run at lower temperatures.

Table 13 Multiple Test Restrictions

Assembly Application Restriction
T-BERD / MTS Dual 100GE Maximum operating temperature:
5800-100G 0-40°C

Dual 10GE 0-50°C

MSAM in 6000A
Base Unit

Ethernet Applica-
tions in Dual Term
or Dual Through
Mode

VolP

IP Video

L3 Triple Play
PRI ISDN

TCP Wirespeed
J-Profiler

OTN

Data communica-
tions or Diphase

Any other applica-
tion at a line rate
less than 10 Gbps

Two SFP PIMs are required when running applications
in Dual Term or Dual Through mode; therefore, you can
only run one application at a time (using both PIMs).

Additional tests can not be run when running a VolP
test.

Additional tests can not be run when running an IP
Video test.

Additional tests can not be run when running a layer 3
Triple Play test.

Additional tests can not be run when running a PRI
ISDN test.

Additional tests can not be run when running a TCP
Wirespeed test.

Additional tests can not be run when running a J-Profiler
test.

Additional tests can not be run when running an OTN
test.

The HS Datacom and Diphase PIMs require both PIM
ports on the MSAM chassis; therefore, you can only run
one application at a time (using a single PIM).

When running any application at a line rate less than
10 Gbps, you can run one additional test at a line rate
less than 10 Gbps while operating the instrument at:

— 32°F to 104°F (0°C to +40°C)
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Table 13 Multiple Test Restrictions

Assembly Application Restriction
10 Gbps When running a 10 GigE Ethernet, 10 Gig Fibre Chan-
applications nel, OC-192, or STM-64 test, you can run one additional

MSAMs in 8000

Dual Module

Carrier (DMC)

10 Gbps Packet
Capture

NextGen applica-
tions (launched
from the standard
SONET or SDH
test menu)

All

test (at a lower line rate) while operating the instrument
at:

— 32°F to 95°F (0°C to +35°C)

Your battery will not charge while running multiple tests
with one application at a 10 Gbps line rate. For details,
see the section on charging your battery in the Getting
Started Manual that shipped with your instrument or
upgrade.

When running a 10 GigE LAN or WAN application, and
capturing data on Port #1, you can not run a 1 GigE
application from Port #2. If you want to run a 1 GigE
application on Port #2, you must first disable packet
capture for the 10 GigE application running on Port #1.
You can run applications for lower line rates (for exam-
ple, 10/100/10000 Mbps Ethernet) on Port #2 when
capturing packets on Port #1 for a 10 GigE application.

Additional tests can not be run when running a NextGen
application, and if you are using an MSAM, you must
use the PIM in port 1. You can not run a second test on
port 2, and you can not run NextGen tests from port 2.

Please contact your local sales office or technical assis-
tance representative for a list of restrictions when run-
ning multiple tests using this assembly.

Running multiple tests

To run multiple tests you need to have a dual port unit:

1 Verify that your instrument is powered using the adapter that shipped with it.

2  Start the first test by doing the following:

a

d

Using the Test menu, select a test application see “Step 1: Selecting a test
application” on page 109).

Configure the test (see “Step 2: Configuring a test” on page 113).

Connect the module to the circuit (refer to your instrument’s Getting Started

Manual).

Start the test (see “Step 4: Starting the test” on page 115).

3 Torun a second test, do the following:
Select Test > Add Test.

a
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A a menu appears listing the rates still available for testing. These rates will
vary depending on the rates you are already testing, and on the remaining
resources available on your unit.

Using the MSAM as an example, if you are currently running a DS1 test using
a DS1 PIM on port 1, the DS1 rate is disabled for port 1 because the port is

already used. If you are running an OTN test from port 1, you can not add a

second test, even if a PIM is connected to port 2 because the MSAM needs

the resources for the OTN test application.

b Select an application, and then configure the test, connect to the circuit, and
start the test.

You are running multiple tests.

Two tabs appear on the menu bar of the Main screen (as shown in Figure 72), one for
each test.

Figure 72 Multiple test tabs, MSAM

B F1: 100K Optical Eth Layer 3 Traffic Term

A tab also indicates which slot (or application module) and port the currently selected
testis running on. The large tab indicates the currently selected test. Click the other tab
to view the results for the second test.

A green tab indicates no errors, anomalies, alarms, or defects have been detected for
a test.

A red tab indicates errors, anomalies, alarms, or defects have been detected for a test.

A yellow tab indicates you should research the conditions displayed in the Summary
result category. In some instances, the conditions constitute errors; in other instances,
they are expected and should not be interpreted as errors. For details, refer to the
supporting testing manual.

A blue tab indicates some action is required on your part before the test can proceed.
Typically a dialog box will indicate the type of action required.

The LEDs, results, and tabs applicable to the currently selected test appear on the Main
screen. Each of the other tests is still actively running in the background.

A blue arrow under the tabs indicate that the currently selected test is running:

Figure 73 Test Elapsed Time

0 Running 3m:13s
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Viewing both tests

When running multiple tests, you can view results side-by-side using the Dual Test View
button.

Figure 74 Dual Test View button

Dual Test

View
Q=

The Dual Test View button appears when one of the following occurs:

e asecond test is launched.
¢ you select Enable Dual Test from the View menu.

To view both tests

*  Press the Dual Test View button.
The tests are displayed side-by-side.

If Dual Test View is launched with only one test active, the display will look similar to
Figure 75.

Figure 75 Dual Test view with one active test

O Test| View Reports Help

+ 100M Optical Eth Layer 3 Trafic Tenm
&= P 100k Optical Eth Layer 3 Traffic Term Add Test
Lewel (dBm ) 32
Freg Dev (ppm) 0.0 # Restart
Summary E ]Status ] l
Acterna Test Packet Detect QOFF
[ eBrutver | esew |

Use the Add Test button to launch a second test as described in “Running multiple
tests” on page 125.

If a second test is active when viewing both tests, the display will look similar to
Figure 76.
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Figure 76 Dual Test view with two active tests

CiTest | View Reports Help [ 4 Restart Both Tests ]

&= P1: 100k Optical Eth Layer 3 Traffic Term = P2 10GigE LAN Layer 3 Traffic Term

T e
Summary = lStatus - ] [Summary - ]Status = ]
Acterna Test Packet Detect OFF
L3
ALL SUMMARY
RESULTS
0] ¢
[ ]
| sRrunvier || Qeseup | | fleat | | ePrulview || Qesetp |

The buttons included in each side represent the buttons available for that test. For
example, pressing the Restart (at the top) on the left side restarts the 100M Optical
Eth Layer 3 Traffic Term test; similarly, pressing the Config button on the right will
display the configurable parameters bar related to the 10GigE LAN Layer 3 Traffic Term
test (see Figure 77), allowing changes to parameters such as “Destination IP” or
“Packet Size”. Every tab, when expanded, changes color and the text changes to
“Hide”. Pressing the Hide tab will remove the expanded bar. Only one tab can be
expanded at a time from either side.

Figure 77 Right Window Config Tab expanded

Tools:

Ethernet Payload
18216815 v Z56 B
Ping Fasket Size

Destination IP

If you want to simultaneously restart both tests, use the Restart Both Tests button in
the upper right.

Use the Test menu to save the dual test configurations or to load a previously saved
dual test configuration.

Use the Reports menu to save (create) a dual test report or to view a previous report.
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Scheduling timed tests

When you setup a test, you can indicate that the test should run for a specific period of
time (Timed Tests), or you can schedule tests to begin at a specific time (Delayed-start
Timed Test).

To schedule a timed test

1 Using the Test menu, select a test application (see “Step 1: Selecting a test appli-
cation” on page 109).

2 Select the Setup soft key.
A setup screen with a series of tabs appears.

3 Select the Timed Test tab, and then select one of the following test types:

— Timed Test. If you want the test to start immediately and run for a specific interval of
time, select Timed Test, and then specify the duration for the test in the corresponding
fields.

— Delayed-start Timed Test. If you want the test to start at a specific time, and then run
for a specific interval of time, select Delayed-start Timed Test, specify the duration for
the test, and then specify the date and time you want the test to begin in the corre-
sponding fields.

In Timed Test Enable, select ON.

o b

Specify the timed test duration in the fields provided. Use the up and down arrows
to increase or decrease the intervals, or select a field, and then select the keypad
icon to type in a value.

The test duration is specified. The test will run for the interval you specified when you
press START or Restart to begin your test.

NOTE: J-Connect

D Do not run timed tests when using J-Connect to detect other Viavi test instru-
ments on a subnet. For details, see the Ethernet and Fibre Channel Testing
Manual that shipped with your instrument or upgrade.

Creating and printing reports

Use the Reports option on the Menu bar or the PRINT/EXPORT key on the front panel
of your unit to format, create, store, and print reports detailing the current setup and test
results. You can also optionally include screen shots in your reports.

NOTE:

D Depending on the version of T-BERD/MTS 8000 base unit you have, the key
may be labeled PRINT or may be labeled EXPORT (on UIMv2).
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Including a logo in your reports

If you want to include a logo in your report, do the following:

1 Load the logo graphic in a .png, .jpg, or .jpeg format into the following folder on
your unit;

/acterna/user/disk/bert/images

NOTE:

D The file must be no larger than 1900 x 1200 resolution. If importing a file larger
than this, the graphic may not appear on the report.

For details concerning loading files onto your unit, refer to the 6000A Base Unit
User Manual.

2 Select Reports > Edit User Info, and then press Select logo ... to navigate to the
cflash/bert/images folder, select the logo graphic, and then press Select.

The logo is selected, and you return to the Edit User Info screen.

NOTE:

D Some automated test applications allow you to save the report details as a pro-
file. This includes the directory path for the logo. However, if you move the pro-
file from one unit to another, you must ensure that the logo file is in the same
directory on the unit that you are using.

Specifying report details

Before creating a report, you can specify details that will be captured in the report
header, such as the name, model, software revision, serial number of the device under
test, or the name of the technician running the test. You can also import your company
logo to include it in the report.

To specify details about the report

1 From the menu bar, select Reports > Edit User Info.
The Edit User Info screen appears.

T-BERD/MTS/SC Getting Started Guide
Page 132 22046537, Rev. 016 March 2018



Chapter 4 Basic Testing
Creating and printing reports

5

To specify information about the device you are currently testing, select the
Device Under Test tab (if it isn’t already displayed), and then use the keypads
provided to type the following:

—  Owner (represents the owner of the device).
— Device Under Test (represents the name or model of the device).

— Software Revision (represents the software revision the device is currently
running).

—  Serial Number.
— Comment.
If you want to specify additional comments concerning test results or the tester,

select the Tester Comments tab, and use the keypads provided to type additional
information.

If you want to change the default name for your Dual Module Carrier,
Transport Module, and MSAM as provided in the report, select the Test Instru-
ment tab, and then type the revised model name.

Select Ok to store the report details and return to the Main Screen.

Report details are specified.

Creating a report

You can create reports in a PDF, CSV, Text, HTML, or XML format. Before creating a
report, you can choose the type of content provided in the report. For example, you can
include the details you specified as the User Info, select specific configuration groups
(corresponding to the information that you specified on the setup tabs), and select key
result groups that you want to review in detail.

You can also indicate whether you want to include captured screen shots in the report.

To create a report

1

On the Main screen, select Reports > Create Report ...
The Create Report dialog box appears.

Your unit will automatically assign a default file name to your report as follows:

— The port number (if applicable) appears at the beginning of the name. For
example, if you are creating a report while running a test on Port 1, “P1_”
appears at the beginning of the name.

— The interface appears next. For example, if you are currently running a test
on a 1 Gigabit Ethernet circuit, “1GigE” appears after “P1_.

— The date and time, expressed per ISO 8601, appear after the interface.
— Finally, a “report” suffix ends the filename.

— The appropriate extension for the file format that you specify will be assigned
when the report is created. For example, if you select the Text format, a “txt”
extension will automatically be assigned to the file name.
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If you do not want to use the default filename, launch the keypad for the File
Name field, and then type a name using up to 60 characters.

In Format, select PDF, CSV, Text, HTML, or XML.

4 Select Choose Contents, and then expand each of the following report informa-

tion groups by selecting the plus sign to the left.
— User Info

—  Configuration Groups

— Results Groups

— Event Loggers

— Histograms

— Screenshots

Review each of the reportable elements, and then select the elements you want to
report, or clear those you do not want to include in the report output.

If you want to unselect all Report Groups or Screenshots, use the Unselect All or
Unselect Screenshots button.

If you want to select all Report Groups or Screenshots, use the Select All or
Select Screenshots button.

5 If you want to view the report after it is created, select the checkbox to the left of
View report after creation.

6 Select Create Report.

A watch icon appears indicating that you should wait for the report to be created. If you
selected View report after creation, the report appears automatically; otherwise, it is
stored in the following folder and can be viewed at any time:

acterna/user/disk/bert/reports

Printing reports

If using a T-BERD/MTS 8000 base unit, you can print reports. If using a T-BERD/MTS
6000A base unit, use the Export Report to USB command and transfer the file to a PC
for printing.

Before printing a report, verify that you specified a printer when you set up your unit. If
you need to specify a printer, refer to the Base Unit User Manual that shipped with your
instrument.

To print a report

1 From the menu bar, select Reports > View Report.
The View Reports dialog box appears.

2 Select the report that you want to print, then press View.
Press the PRINT/EXPORT key on the front panel of your unit.

4  Specify the print rate (the entire report, or the current page).
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The unit sends the report to the printer.

Generating reports automatically

You can set up your instrument to automatically generate reports at specific intervals.
When you set up automatic reports, you can specify a suffix to append to each report,
indicate the file format for the reports, and select the content for automatically gener-
ated reports.

To setup your module to generate reports automatically

1

ALERT:
0 If you are running two tests when your instrument is configured to automati-

From the menu bar, select Reports > Automatic Reports.

The Automatic Report Settings screen appears.

Select the Enable automatic reports check box.

If you want to restart the test after an automatic report is generated, select the
corresponding check box.

NOTE:

When running automated scripts, tests will not restart automatically after
reports are generated.

cally generate reports and restart after the reports are generated, both tests
will restart.

Using the keypads and arrows provided, specify the reporting period in hours and
minutes.

In Mode, specify whether you’d like the module to overwrite the previous auto-
matic report each time it generates an automatic report, or create a new, separate
report file.

By default, “AutoReport” is appended to the end of the filename of each automati-
cally generated report. If you'd like to use a different suffix, in Report Name, type a
new suffix.

In Report Format, select PDF, CSV, Text, HTML, or XML.

Select Choose Contents, and then expand each of the following report informa-
tion groups by selecting the plus sign to the left.

— User Info

—  Configuration Groups

— Results Groups

— Event Loggers

— Histograms

— Screenshots
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Review each of the reportable elements, and then select the elements you want to
report, or clear those you do not want to include in the report output.

9 Select OK to store the automatic report settings and return to the Main Screen.

Reports will be automatically generated at the intervals you specified as the reporting
period. When the module generates an automatic report, a dialog box will briefly appear
indicating that a report is being generated.

Viewing a report

To view a report

1 On the Menu bar, select Reports > View.
The Reports screen appears, listing the contents of:
acterna/user/harddisk/bert/reports

2 To display the report on the user interface of your module, select the report file
from the list, and then select View Report.
The report viewer appears, providing:
— Arrows that allow you to navigate through the contents of the report.

— Abinoculars (lookup) button that allows you to search for key terms in the
report.

— Arrotate button that rotates the display of your report, and changes the default
report orientation from landscape to portrait.

— Afolder button that allows you to rename the report and store it in a different
folder.

— An X button that closes the report viewer and returns you to the Reports
screen.

3 To print the report you are viewing, press the PRINT/EXPORT key (located on the
front of your T-BERD/MTS 8000 base unit).

The instrument sends the report to the printer.
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Accessing test reports remotely

Using FTP, you can view, print, or save the test reports on your unit from a remote work-
station.

NOTE:

D *  Verify that your system’s Security Mode is set to Standard. You cannot
access the test reports remotely if the mode is set to Enhanced.

*  When using your unit remotely, it is helpful to lock the screen to prevent
other users from disrupting your testing.

For details on locking the screen or specifying the system’s security mode,
refer to the base unit manual for your instrument.

To access test reports using FTP

1 Launch your web browser, and then go to the following address:
ftp://xXxXX.xXXX.xXX.xxx/disk/

where xxx . xxx . xxx . xxx represents the static or DHCP assigned IP address of
the Base unit.

A log on screen appears.
2 Do the following:

a In User name, do one of the following:

- If you are using an MSAM, enter t-berd6000 or mts6000 using lower
case characters.

b In Password, enter acterna using lower case characters.

¢ Select Log On.
The bert directory (folder) appears in your browser window.

3 Open the bert directory, and then open the reports directory.
The reports that are stored on your unit appear.

4 Select, and then save the report to a directory on your workstation, or simply open
the report and view it remotely.

Exporting reports

After generating a report, you can export the report file to a USB memory key. Two USB
slots are provided on the top panel of your base unit.

To export a report to a USB memory key

1 Insert a USB memory key into one of the two slots provided on the top panel of
the base unit.

2 On the Menu Bar, select Reports > Export Report to USB.
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The Reports screen appears, listing the contents of:
acterna/user/disk/bert/reports

3  Select the report you want to export, and then select the Export button.
The File Export dialog box appears, indicating that the unit is copying the selected
report file to the USB memory key.

The report is exported.

Before removing the USB key, you must eject the USB.
View the File Manager (using the File key), and then select the Eject USB soft key.
After the Eject USB soft key disappears, it is safe to remove the USB.

Restoring test defaults

You can restore test settings to the factory defaults at any time.

To restore test defaults

¢ On the Main screen, select Tools > Reset Test to Defaults.

The default settings are restored.

VT-100 emulation

If your instrument is optioned to do so, you can use it to emulate a VT-100 terminal, and
then connect it to a network element (such as an HTU-R, HTU-C, HRE, or SmartJack
(NIU)) via a serial interface to gather information about the element. When emulating a
VT-100 terminal, data from the network element appears on the Dual Module Carrier,
Transport Module, and MSAM screen. You can save this information to an ASCII file,
print it, or export it. Information gathered typically includes loss, margin, synchroniza-
tion, performance (SES, ES, UAS, etc.), and alarm information.

During a VT100 session, you can also configure and provision the accessed network
element from the Dual Module Carrier, Transport Module, and MSAM. When using
VT-100 emulation, you must connect the optional USB keyboard to the instrument to
issue queries and commands.

Establishing a serial connection

When you order the VT-100 Emulation option, Viavi ships a USB to serial (DB-9) cable
with the instrument or option. This cable has been tested for use with the Dual Module
Carrier, Transport Module, and MSAM, and should be used whenever you connect the
Dual Module Carrier, Transport Module, and MSAM to a network element for VT-100
communication.
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To establish a serial connection for VT-100 emulation

1  Turn the Dual Module Carrier, Transport Module, and MSAM ON.

2 Verify that you have the Viavi supplied cable that shipped with the VT-100 option
or with your test instrument.

3  Connect the USB connector to one of the USB slots on the top panel of your test
instrument.

4 Connect the DB-9 serial connector to the network element.

A connection is established.

Running a VT-100 session

After establishing a serial connection to the network element, you can run a VT-100
terminal emulation session to query or configure the element.

To run a VT-100 terminal emulation session

1 If you haven't already done so, turn the Dual Module Carrier, Transport Module,
and MSAM ON, and establish a connection to the network element (see “Estab-
lishing a serial connection” on page 138).

2 From the Menu Bar, select Tools > VT-100 Emulation.

The VT-100 Terminal screen appears, with softkeys to the right that allow you to
do the following:

— VT-100 Setup. Use this softkey to specify values for the session (as
described in step 3 on page 140.

— Clear Screen. Use this softkey to clear the data currently displayed on the
terminal screen.

— Hide Keyboard. Use this softkey to hide the keyboard. This is helpful when
using a USB keyboard, or if you want to observe more data on the terminal
screen.

— Move Keyboard. Use this softkey to move the keyboard to the top or bottom
of the terminal screen. This is helpful if the keyboard is blocking the display of
key data.

— Autobaud. Use this softkey to send a series of sequential space characters
to force the network element to re-evaluate its baud rate.

— Capture Screen. Use this softkey to capture the data on the terminal screen
and save it in an ASCII file.

— Exit. Use this softkey to end the session and return to the Main screen.
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3 To specify the settings required for the session, select VT-100 Setup. The VT-100
Setup screen appears.

a Under Port Settings, specify values for the following:

Setting Value

Baud Rate Select one of the predefined baud rates ranging from 50 to
115200 Kbps.

Data Bits Select the number of data bits (ranging from 5 to 8) that

contain information. These are the bits that are not used to
start, stop, or provide checksum values.

Parity Indicate whether no parity check will be performed (None),
or whether the instrument will use odd or even bits for par-
ity checking.

Stop Bits Indicate whether bit 1 or bit 2 will be used as the stop bit.

Flow Control Indicate whether the instrument will use software (X ON /

X OFF codes), hardware, or no flow control (None).

b Under Terminal Settings, specify values for the following:

Setting Value

Enter/Return Select CR to send a carriage return every time you
press Enter, LF to send a line feed, or CR + LF to send
both.

Local Echo If you want to echo the characters you type on the
MSAM screen, select ON; otherwise, select OFF.

Enable Reserved If you want to use the keyboard’s function keys when

Keys communicating with the network element, select
Enable; otherwise, select Disable.
NOTE:

If you enable reserved keys, the buttons on your instru-
ment will be disabled. Be certain to change this setting
back to Disable when you are done with your VT-100
session.

4 Select the Terminal Window softkey to return to the VT-100 Terminal screen,
then use the keyboard to issue commands just as you would on a VT-100
terminal.

You are running a VT-100 session.

Saving terminal screen data

When running a VT-100 session, you can capture the data on the terminal screen. The
instrument saves the data to an ASCII file; you can export the file just as you would any
other report on the instrument (see “Exporting reports” on page 137).
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To save terminal screen data

*  Select the Capture Screen softkey. The instrument captures the data on the
terminal screen and saves it in an ASCII file in the following location:

/acterna/user/disk/bert/reports

The data on the screen is saved.

HTML Viewer

An HTML viewer is available on your instrument which allows you to view and navigate
through the help topics and any reports that you stored in an HTML format. When used
to display help topics, the viewer remembers and returns you to the last help topic you
visited for a specific test application while you are actively running the application. You
can return to the Contents page at any time by selecting the Home soft key. If you
change test applications, the last help topic is no longer stored because the viewer will
track the topics visited for the new application.

For specifics on using the viewer, see:

e “Launching the viewer” on page 141
*  “Navigating using the viewer” on page 141
*  “Exiting the viewer” on page 142

Launching the viewer

The viewer is launched automatically whenever you do one of the following:

e Select Help > User Manual to view the topics in the testing manual for your
instrument on the unit itself.

e Select Reports > View Report, and then select an HTML file.

Navigating using the viewer
The viewer provides softkeys that allow you to navigate through a series of HTML

pages.

Scrolling

A scroll bar appears on the right of the viewer window; select and then drag it down to
move to the bottom of the page, or drag it up to move to the top of the page.

Finding text on a page

You can search for a specific term on a page using the Find in page feature.
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HTML Viewer

To find a specific term

1 Select the Find in page field. A keypad appears.

2 Type the term you want to search for, and then select OK. The keypad closes,
and the term appears in the field.

3 Select Find. The viewer scrolls to and highlights the first instance of the term on
the page.

Selecting links

Links to other help topics or HTML pages appear in blue. To jump to another topic or
page from a link, simply or select tap the link.

Going back or forward one pages

Softkeys are provided that allow you to move Back and Forward through a series of
previously visited pages

Going home

The Home softkey takes you to the home page. For example, if you are browsing
through the HTML help topics, pressing Home returns you to the Contents page.

Exiting the viewer

To exit the viewer, use the Results or Setup soft key, or the Results of Setup hard key
on the right of the front panel. You will return to the last Result view (on the Main screen)
or the Setup tab that you visited before launching the HTML viewer.
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Smart Access Anywhere

This chapter explains how to configure and use the Smart Access Anywhere utility.
Additional details concerning the utility are provided in the applicable Base Unit User
Manual for all instruments except the 5800 and 4800, which do not use a base unit.

The topics discussed in this chapter are as follows:

“About Smart Access Anywhere” on page 144

“Licensing” on page 144

“‘Downloading and extracting the utility” on page 144
“Establishing a connection” on page 145

“Launching the utility” on page 147

“Displaying the instrument’s user interface” on page 148
“Transferring files” on page 149

“Displaying and modifying connection settings” on page 149
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About Smart Access Anywhere

About Smart Access Anywhere

Smart Access Anywhere allows you to view and control the instrument’s user interface
from a remote location using a workstation. In addition to configuring the instrument and
performing tests, you can transfer files to and from the instrument using the instru-
ment’s file manager utility. You can also rename and delete files, or create, rename, and
delete directories.

Licensing

If you are using the Smart Access Anywhere utility to remotely access a 5800/4800 test
instrument, you do not need a license. If you want to remotely access any other instru-
ment (for example, a CSAM or MSAM), you must specify a license key before using the
utility.

The following licenses are available:

* License 1 (reference SAA-6K-L1): for Smart Access Anywhere using an Ethernet
or Wifi hotspot connection.

* License 2 (reference SAA-6K-L2): for Smart Access Anywhere using an Ethernet,
Wifi hotspot, or USB / Wifi connection via a 3G smart phone.

Downloading and extracting the utility

The Smart Access Anywhere utility must be downloaded and extracted on the work-
station that you intend to use to connect remotely to the test instrument.

NOTE:

D You do not need administrator privileges to install the utility on your worksta-
tion. The utility will be downloaded as a zip file.

To download the utility

1 On your workstation, open a browser and type the following address:
http://smartaccess.updatemyunit.net

2 Click on the SmartAccessAnywhere_Vxx.xx.xx.zip link.

3 Select Save in the dialog box.
After the download is complete, the browser can be closed.

4 Go to the download directory, then extract the files in the zip file into the desired
destination directory.

The utility is downloaded and extracted.

Page 144

T-BERD/MTS/SC Getting Started Guide
22046537, Rev. 016 March 2018



Chapter 5 Smart Access Anywhere
Establishing a connection

Establishing a connection

You can connect remotely to your test instrument using a 1) wired Ethernet connection,
2) WiFi connection, or 3) Smartphone with Data Tethering. Before establishing a
connection to the instrument, verify that port 22 (SSH) or 443 (HTTS) is open on your

workstation.

NOTE:

& To connect using WiFi, the WiFi option must be installed on the target test
instrument. To order the option, or to determine whether a particular Smart-
phone has been qualified by Viavi for the purpose of establishing remote con-
nections to the instrument, contact Viavi Customer Care at 1-866-228-3762 or
www.viavisolutions.com.

Although Figure 78 through Figure 81 show a T-BERD / MTS 6000 test instrument, all
supported instruments can be accessed remotely using each illustrated connection

mode.

Wired Ethernet Connection

Figure 78 illustrates a test instrument connected to a workstation via a wired Ethernet
connection to the Internet. Before establishing a wired connection, you need to 1) deter-
mine the instruments IP address and, 2) configure the network proxy (if a proxy is

used).

Figure 78 Wired Ethernet Connection
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Establishing a connection

WiFi Connection

Figure 79 illustrates a test instrument connected to a workstation using a WiFi connec-
tion.

Figure 79 WiFi Connection

Smartphone with Data Tethering

You can remotely connect to a test instrument using a Smartphone capable of data teth-
ering and a WiFi hotspot or USB cabile.

Figure 80 illustrates a test instrument connected to a workstation using a WiFi hotspot
provided by a Smartphone that supports data tethering.

Figure 80 WiFi Connection using Smartphone
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Launching the utility

Figure 81 illustrates a test instrument connected to a workstation using a USB connec-
tion to a Smartphone that supports data tethering.

Figure 81 USB Connection using Smartphone

-
-
-
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-
-

Launching the utility

To use the Smart Access Anywhere utility, you must 1) establish a connect from your
workstation to the test instrument, 2) launch the utility on the test instrument to obtain
the required remote access code, and then 3) launch the utility on your workstation, and
enter the remote access code that was obtained from the instrument.

Launching the utility on the instrument

To launch the utility on your instrument

1 On the System page, select Remote.
2 Press Connect next to the SmartAccess Anywhere icon.
The connection to SmartAccess Anywhere Server will initiate.

3 After a connection is established to the server, the instrument displays a message
with the code that is required to access to the equipment remotely.

4 If you will be accessing the instrument remotely from your workstation, write down
or capture the code in some manner so you have it when you return to your work-
station. If another individual will be accessing the instrument remotely, provide the

code to the individual.

Testing your connection

Before launching the utility on your workstation, you can also optionally test the connec-
tion between the workstation and target test instrument.
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Displaying the instrument’s user interface

To test your connection

1
2

On your workstation, launch the Smart Access Anywhere utility.

Select Test connection.
The test automatically launches.

To display connection log details in real time, select the See full logs button.
The connection log appears, and provides the following information:

— Upload and Download speed (in Kbyte/s) from Device to server.

— Latency between Device and server (in ms).

After analyzing the results, do one of the following:

— Select the Clear test results button to delete the current table, and retest the
connection if desired.

— If connection is deemed to be valid, enter the access code and establish
connection.

Launching the utility on your workstation

After you establish a connection to your test instrument, you can launch the Smart
Access Anywhere utility to update your instrument.

1

3

On your workstation, go to the directory where you installed the utility, then double
click SmartAccessAnywhere.exe.

The utility opens.

Enter the access code that was provided to you in the field provided on the upper
part of the screen.

Click Connect to validate the code.

The Smart Access Anywhere screen appears.

>

NOTE:

After upgrading or rebooting a remote instrument, please wait at least two
minutes before re-establishing the link between your workstation and the test
instrument.

Displaying the instrument’s user interface

After you launch the utility on your workstation, you can display the remote instrument’s
user interface on your workstation’s display.

To display the instrument’s user interface

On the Introduction page, click Remote Screen.
The user interface for the instrument appears on your workstation’s display.
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The VNC icon in the system tray indicates that the remote screen is active.

Transferring files

Single files can be transfered one by one from your workstation to the instrument, or
from the instrument to your workstation.

To transfer a file to or from the workstation or instrument:

1 On the Introduction page, click File Transfer.

A two-pane window appears, showing the workstation directories (or storage
devices) in one pane, and the instrument directories (or storage devices) in the
other pane.

2 Inthe “source” pane (the pane that has the file that you want to transfer), double
click on the directory or storage device, then select the file to be transferred.

3 Inthe “destination” pane (the pane with the directory that you want to transfer the
file to, select the destination directory for the file.
4 Do one of the following:

— If you are transferring a file from your workstation to the instrument, click
Upload.

— If you are transferring a file from your instrument to the workstation, click
Download.

A dialog box appears asking you to verify the destination that you selected for the
transferred file. If it is the correct destination, click OK.

5 Click Save to transfer the file.

A message will appear at the bottom of the screen providing details concerning the
status of the file transfer. After the transfer is complete, the message disappears and
the transferred file is underlined in the workstation or instrument’s file manager.

Displaying and modifying connection settings

You can review information about the current remote session at any time.

To display session information

* Select the Session icon key.

Session details appear. This page gives information on the connection in real time.

To modify connection settings

1 Select the Session icon.
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2 Disconnect the session using the Disconnect button.

3 On the session screen, select the Network Settings icon.
The connection settings screen appears. The default connection is defined as
Smart-guess (default).

4  To modify the settings, select Forced settings, and then modify SSI tunnel port
and/or Internet proxy as needed.

The Internet proxy configuration is available exclusively if the port selected is
Alternative port (443) and if HTTPS packing is selected.

NOTE:

D If the default parameters need to be modified, it is recommended you discuss
it with your local network administrator.

5 After configuring the settings, select Back to main page.

T-BERD/MTS/SC Getting Started Guide
Page 150 22046537, Rev. 016 March 2018



Using Bluetooth Connections

This chapter explains how to configure and use the Bluetooth® option on your
T-BERD/MTS 5800 and SC 4800. The Bluetooth application is available as a factory
installed option on the instrument. If using Bluetooth on another device (for example,
the CSAM or MSAM), refer to the applicable Base Unit User Manual.

The topics discussed in this chapter are as follows:

e “Setting up a Bluetooth connection” on page 152

*  “Transferring files via Bluetooth” on page 153

*  “Using a Bluetooth audio device” on page 154

*  “Disconnecting and unpairing Bluetooth devices” on page 155
e  “Deactivating Bluetooth” on page 156
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Setting up a Bluetooth connection

Setting up a Bluetooth connection

The Bluetooth option allows file transfers between the 5800 or 4800 and another device
and the use of audio devices.

To set up a Bluetooth connection

1 On the System page, select the Bluetooth icon.

o System "IESI:S

2 System 'MTS 5800 Version 0.0.0.58135 \)
- A
- : ' =
=
Files Use Bluetooth Network Battery
” .. 7 | '
e ) i “ L W
0 mm—m w’
Date and Time Region Display Remote Upgrade
A — o,
. i e (9
Test Set Lock Audio System Info StrataSync Video Player
Web Browser

2 Place a check in the boxes next to the settings for this session; Enable Blue-
tooth, Allow other devices to pair with this device and/or enter a Device
Name for identifying this device.

The Bluetooth icon appears in the system tray.

3 Activate Bluetooth on the equipment that needs to be paired with the 5800 or
4800.

4 Press the Start Scanning soft key to find any devices in range.

9 9:42 PM
nc®) § L 2P

¥ System @ Tests Fll:-ert_}pucs

#System > [j Bluetooth MTS 5800 V2 Version 3.0.0.62272 \')

_S-t;rg.cannlni_' Settings
- — ¥| Enable Bluetooth

Paired devices | Aliow other devices to pair with this device
n PLT_M25-M29 Device Name | TBS800v2
n PLT VoyagerPRO
n 9xxPlantronics

Discovered devices

ger-sardesh-linux-1.ds.jdsu.net-0

LAB-PC

T-BERD GDOOA V2 (00143)

TB5800v2
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All detectable devices that are within range appear in the Discovered Devices
area.

Previously paired devices appear in the Paired Devices area.

From the list of Discovered devices, select the device to pair with the 5800 or
4800.

If prompted to do so, enter a pairing code on the remote equipment.

Press Pair to validate.
The devices are paired.

If you have paired with an audio device, e.g. headphones, you are able to connect it for
use with your applications, see “Using a Bluetooth audio device” on page 154.

If you paired with another unit or a computer, you are able to connect it for file transfers.
For details, see “Transferring files via Bluetooth” on page 153.

Transferring files via Bluetooth

The Bluetooth option allows file transfers between the 5800/4800 and another device.
File transfer between devices via Bluetooth requires that the devices be paired - see
“Setting up a Bluetooth connection” on page 152. Files may be transferred from the
5800/4800 to paired devices.

To transfer files

1
2

On the System page, select the Bluetooth icon.

Select the target device (the recipient) from the Paired devices list.

When the device is selected, a panel appears at the bottom-left of the screen,
displaying information about that device.

Click the Send File button.
A dialog appears listing the files that can be sent.

Click on the desired file to be transferred and then click the Send button.
The file is sent to the target device.

NOTE:

Using an audio device while transferring files is not recommended. The perfor-
mance of either may be degraded.
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Using a Bluetooth audio device

Using a Bluetooth audio device

The Bluetooth option allows the use of audio devices. Before the devices are used, they
must be paired - see “Setting up a Bluetooth connection” on page 152.

NOTE:

D While support for Bluetooth headsets and loudspeakers is supported, Viavi
does not guarantee correct operation with all off-the-shelf commercially avail-
able devices. The user/owner of the 5800/4800 should verify whether it will
work with the 5800/4800 before regular use.

To connect to a Bluetooth audio device

1 On the System page, select the Bluetooth icon.

2 Select a device in the Paired devices list. If no devices appear, see “Setting up a
Bluetooth connection” on page 152.

Paired devices

Discovered devices
ger-sardesh-linux-1.ds.jdsu.net-0

LAB-PC

Paired Device Details
Name PLT_VoyagerPRO
MAC Address 0C:E0:E4:39:8C:6E

The Name and the MAC Address for that device will display in the Paired Device
Details box.

NOTE:
D Only one Bluetooth audio device can be connected at a time.

3 Select the Connect button.
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Disconnecting and unpairing Bluetooth devices

The icon for the device will turn blue and the Disconnect button appears.

Paired devices

n PLT_M25-M29

n 9xxPlantronics

Discovered devices
ger-sardesh-linux-1.ds.jdsu.net-0

LAB-PC

Paired Device Details
Name PLT_VoyagerPRO

MAC Address 0C:E0:E4:39:8C:6E

The devices are connected.

NOTE:

D Using an audio device while transferring files is not recommended. The perfor-
mance of either may be degraded.

Disconnecting and unpairing Bluetooth devices

If you want to stop using the device, you should disconnect it and then remove pairing.

To disconnect from a paired device

1 On the System page, select the Bluetooth icon.
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2 Select the device that is currently connected (blue icon) from the Paired Devices
list.

Paired devices
'@ :
') PLT_M25-M29
'@ "
'R 9xxPlantronics
Discovered devices
ger-sardesh-linux-1.ds.jdsu.net-0

LAB-PC

Paired Device Details
Name PLT_VoyagerPRO

MAC Address 0C:E0:E4:39:8C:6E

3 Select the Disconnect button.
The devices are no longer connected but are still paired.

After disconnecting a Bluetooth device, you should remove the pairing.

To remove pairing

1 On the System page, select the Bluetooth icon.
2 Select the device, from the Paired Devices List, you would like to unpair.

3 Click on the Forget button.

The devices are no longer paired.

Deactivating Bluetooth

After disconnecting and removing pairing, the Bluetooth application can be deactivated.

To deactivate Bluetooth communication

1 On the System page, select the Bluetooth icon.
2 Uncheck Enable Bluetooth.

The Bluetooth icon will be removed from the system tray as the Bluetooth option is no
longer active.
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Optical Tools

This chapter describes the optical tools on your T-BERD/MTS 5800 and SC 4800 plat-
forms. If using the optical tools on another device (for example, a CSAM or MSAM),
refer to the applicable Base Unit User Manual.

Topics discussed in this chapter include the following:
e “About the optical tools” on page 158

* ‘“Inspecting fiber’ on page 158

*  “Measuring optical power” on page 160
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About the optical tools

Two USB optical accessories are available for the T-BERD/MTS 5800 and SC 4800/
4800P:
*  Fiber Microscope

— Inspect both the bulkhead (female) and patch cord (male) sides of fiber inter-
connect as well as optical devices located in hard-to-reach places (trans-
ceivers).

— Inspect both simplex connectors.
— Use with a comprehensive selection of precision FBPT tips.
e Optical Power Meter

— Takes power measurements for all single-mode and multi-mode connectors
via USB 2.0 connection.

— Measures optical power with multiple pre-calibrated wavelengths (850, 980,
1300, 1310, 1490, 1550 and 1625 nm).

— Integrates digital power measurements, fiber inspection, and analysis into a
single, unified work sequence.

In addition to the two USB accessories, you can connect an optional 4100-Series
OTDR module to the 5800 to support the installation, turn up, and troubleshooting of
optical networks. For instructions on using the OTDR modules, refer to the MTS 2000/
4000 OTDR User Manual.

Inspecting fiber

The Viavi fiber microscope accessory is used to view a live video of a simplex fiber to
determine if the fiber is clean. It can also capture a snapshot and provide pass/fail anal-
ysis.

To inspect fiber

1 Connect the fiber microscope to a USB connector on the right side of the instru-
ment.

A MicroScope icon appears in the title bar.
NOTE:
D The Microscope icon only appears if the microscope is connected.

Wl Microscope
¥System
B
)
' A i
Files USB Bluetooth
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Inspecting fiber

Select the MicroScope icon.
The Fiber Microscope screen appears.

Connect the microscope to the optical patch cord or bulkhead.

NOTE:

Although some microscopes can inspect multi-fiber or ribbon fiber (depending
on the microscope and the tip used) the T-BERD/MTS 5800’s microscope
application supports simplex fiber only.

The video of the fiber appears.
Specify which Tip is being used on the microscope.

Adjust the focus as needed using the wheel on the microscope. The color of the
vertical bar on the left indicates the quality of the focus: green is good, yellow is
ok, red is poor. Older microscopes have a blue bar only.

Optional. To verify which version you have, use the Viavi FiberChek Pro desktop
application.

Select the inspection Profile.
If you have a custom profile, do one of the following:

— Use the file manager to put the file into the disk/bert/scope/profiles/ folder,
and it will appear in the P5000i viewer the next time it is launched (if it is
already running, it will need to be closed and reopened).

—  Click the Import from USB button next to the profile list to import your
custom profile. Once imported it may be selected in the viewer.

Select Other settings and then check the Auto-center check box. If checked, the
live picture automatically centers on the fiber center. If not checked, the picture
will center at the last location of a fiber center following an analysis. High magnifi-
cation is always automatically centered.

To manually inspect the fiber, do the following:

a Observe the video of the fiber, and if desired, magnify the image by selecting
the Zoom In button.

b Select Other settings and then specify Freezes as the Test Button setting.
This captures a snapshot.

¢ Select the Test button.

d To compare the current capture to the live feed, select Overlay

e Toreturn to the live video, select the Live button.

To test the fiber, do the following:

a Select Other settings and then specify Tests as the Test Button setting.
b Select the Test button.

NOTE:

D The test will fail if the focus quality is poor (vertical bar is red).
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The T-BERD/MTS 5800 captures an image, and then analyzes it using the
profile specified. The test result will highlight particles or spots where defects are
present and provide a PASS/FAIL indication.

10 After running a test, you can save a PDF report by selecting Save PDF, and, if
desired, specify the job ticket details such as the company name, technician, loca-
tion, and job number. If the fields are left blank, they will not be included in the
PDF report.

Select the Quit button to exit the test.

Measuring optical power

The Optical Power Meter is a Viavi accessory used to measure optical power.

*  The MP-60 meter measures 850, 1300, 1310,1490, and 1550 nm wavelengths
*  The MP-80 meter measures 980, 1310,1480, and 1550 nm wavelengths

To measure optical power

1 Connect the Optical Power Meter to a USB connector on the right side of the
instrument.

The USB Power Meter Summary screen appears.

2 Connect the optical patch cord to the power meter.
The measurement appears.

To measure a specific wavelength, select the Wavelength.

4 Use the Display Type drop-down box to specify Power Meter Summary or Graph.
NOTE: The graph shows the dB result only (not available for dBm or mW).

5 Use the Display Units drop-down box to specify the measurement mode.

Setting Description

dBm Absolute mode, displayed as dBm.The default setting.

mwW Absolute mode, displayed as mW.

dB Relative measurement mode. The received signal is compared

to the reference value, and displays the difference in dB. NOTE:
If no reference value has been stored, 0.00 dBm will be used as
reference value.

SET REF Used in relative measurement mode (dB), to set the reference
value. When selected, the current absolute power level is stored
as new reference value.

6 To save results, select the Save Results button.
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Specifications

This appendix contains specifications for the T-BERD / MTS 5800, Dual Module
Carrier, MSAM, and CSAM. Specifications for the optional OTDR and TEM Modules
are provided in their respective user manuals.

Topics discussed in this appendix include the following:

* “T-BERD /MTS 5800 and Smart Class 4800 specifications” on page 162
*  “MSAM specifications” on page 177

« ‘“Jitter and Wander specifications” on page 224

e “CSAM specifications” on page 239

* “Transceiver and adapter specifications” on page 242

*  “Environmental specifications” on page 242
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T-BERD / MTS 5800 and Smart Class 4800 specifications

Refer to the following sections for specifications for the T-BERD / MTS 5800 and SC
4800:

Physical specifications

“Physical specifications” on page 162

“Power specifications” on page 163

“Electrical Ethernet specifications” on page 163

“Clock source (Timing) specifications” on page 163

“‘DS1 specifications” on page 164

“E1 specifications” on page 166
“E3/DS3/STS-1 specifications (5800 family of instruments only)” on page 168
“E4/STM-1e specifications (5800 family of instruments only)” on page 172
“SFP/SFP+/SFP28 specifications” on page 175
“Optional expansion module specifications” on page 177

The physical characteristics for the T-BERD / MTS 5800 and Smart Class 4800 are
listed in Table 14.

Table 14 Physical specifications

So1ipGisszzp 58001000/
Dimension 5801/5802/5812 5801P/5802P/5812P 5800-100GG
5822PG/4800/ 5882
4800P
Height 6.7 inches/17.02cm 6.7 inches/17.02cm 7 inches/17.78 cm 7.6 inches/
19.23 cm
Width 8.4 inches/21.34 cm 8.4 inches/21.34 cm  9.5inches/24.13cm 9.5 inches/
24.13 cm
Depth 2.75 inches/7.00 cm 3.5 inches/8.90 cm 3 inches/7.62 cm 3.2 inches/
8.1 cm
Weight 3.25 1b/1.47 kg 3.8 1b/1.72 kg 4.2 1b/1.9 kg 5.4 Ib/
2.5 kg
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Power specifications

Although battery life varies depending on the type of test, Table 15 provides specifica-
tions for the battery life and the specifications for the AC adapter.

Table 15 Power specifications

Parameter 5800v1 and v2, 4800 5800-100G, 5882

Battery operating time  2-5 hours depending on the For 5800-100G: 1-3 hours.
application For 5882: 2-5 hours.

Battery charging time  Approximately 7 hours from empty  Approximately 3 hours from empty

Unit power input 12VDC, 60 Watt Max 19VDC, 160 Watt

Power supply input 100 to 240 VAC, 50/60 Hz, 100 to 240 VAC, 50/60 Hz, auto-
auto-sensing sensing

Power supply output 12VDC, 5 AMP Max 19VDC, 8.5 AMP

Electrical Ethernet specifications

The electrical Ethernet applications use the RJ-45 jacks. The 10/100/1000 Base-T/Tx
interfaces conform to the IEEE 802.3 electrical requirements.

Table 16 lists the electrical specifications for the 10/100/1000 Mb/s interface.
Table 16 10/100/1000 Mb/s interface specifications

Specification Description
Cable CAT5e 100-Ohm STP cable, < 100 meters

Table 17 lists the electrical Ethernet rates supported.

Table 17 Electrical rates

Rate Mbps
10Base-T Ethernet 10
100Base-T Ethernet 100
1000Base-T Ethernet 1000

Clock source (Timing) specifications

Table 18 lists internal and external timing specifications for 4800.

Table 18 Timing specifications for SC 4800

Clock Source Description

Internal reference accuracy 1.5 ppm, £1 ppm per year aging

March 2018

T-BERD/MTS/SC Getting Started Guide
22046537, Rev. 016 Page 163



Appendix A Specifications
T-BERD / MTS 5800 and Smart Class 4800 specifications

Table 19 lists internal and external timing specifications for 5800.

Table 19 Timing specifications for 5800

Clock Source Description
Internal reference accuracy 1.5 ppm, £1 ppm per year aging
5800 v Thas SMA from BITS, SETS, or CLOCK
5800 v 2 has DIN with adapter - BITS
cables to SMA 1.544 Mbps DS1/T1 signal
- SETS
2.048 Mbps E1 signal
- 2MClock

2.048 MHz +£100 ppm G.703 sync clock
(square wave)

10M Clock
10.000 MHz £100 ppm square clock

5800-100G and 5882 have -BITS

SMB 1.544 Mbps DS1/T1 signal
- SETS
2.048 Mbps E1 signal

- 2MClock
2.048 MHz £100 ppm G.703 sync clock
(square wave)

10M Clock
10.000 MHz £100 ppm square clock

DS1 specifications

Table 20 through Table 23 on page 166 list specifications for the DS1 interface.

NOTE:

D For the 5800 v1 and v2, the E1 and DS1 interfaces should not be connected
at the same time. Multiple connections can influence the integrity of the sig-
nal under test. After running your test, disconnect from one interface before
connecting to the other interface.
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Receiver
Table 20 lists specifications for the DS1 receivers.

Table 20 DS1 receiver specifications

Parameter Specification
Connector For the 5800 v1 and v2, one RX1 Bantam Jack, and one TX/RX2
Bantam jack; both jacks can be used as receivers.

For 5800-100G, 5882 and 4800, T1 and E1 interfaces are com-
bined in one RJ48 connector. Adapter cable (part # 80-41645-
01) should be used to convert to Bantam connector.

Bit rate 1544 kbps £250 ppm
Line coding AMI, B8ZS

Table 21 lists the input sensitivity specifications for the DS1 receiver.

Table 21 DS1 receiver sensitivity specifications

Termination

Type Impedance Input Range

Bridge >1000 Q +6 to -35.0 dBdsx due to cable loss
Terminate 100 Q nom +6 to -35.0 dBdsx due to cable loss

DSX monitor 100 Q nom -20 dBdsx due to resistive loss in addition

to 0 to -6 dB due to cable loss

Transmitter
Table 22 lists specifications for the DS1 transmitter.

Table 22 DS1 transmitter specifications

Parameter Specification

Connector For 5800 v1 and v2, one TX/RX2 Bantam jack; only the TX/
RX2 jack can be used as a transmitter.
For 5800-100G, 5882 and 4800, T1 and E1 interfaces are
combined in one RJ48 connector. Adapter cable (part # 80-
41645-01) should be used to convert to Bantam connector.

Output 6 Vnom peak-peak into 100 Q

Complies with ANSI T1.403-1999.
Line build out 0dB, -7.5dB, -15.0 dB or -22.5 dB due to cable loss at 772
(LBO) level kHz

LBO level accuracy At 772 kHz relative to the signal at 0 dBdsx:
— +25dBfor-7.5dB
— 3 dB for-15.0 dB and -22.5 dB

Line code AMI, B8ZS
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Table 22 DS1 transmitter specifications (Continued)

Parameter Specification
Clock source — Internal reference clock with accuracy £1.5 ppm, 1 ppm
(Timing) per year aging

— Recovered from RX1
— External from BITS, SETS, or CLOCK

Frequency offset +100 ppm, in 1 ppm steps

Pulse shape Terminated with 100 Q resistive load and 0 dB LBO
selected, the interface meets ITU-T Recommendation
G.703 (11/01) and ANSI T1.102-1993

Physical measurements

Table 23 lists frequency and level measurement specifications when running DS1 appli-
cations.

Table 23 DS1 frequency and level measurement specifications

Parameter Specification

Level V p-p Range: 8.0 V t0 0.06 V
Accuracy: + 0.04 V £ 10%
Resolution: 0.01 V

Frequency Range: 1.544 MHz +250 ppm
Accuracy: £ 1.5 ppm, £ 1 ppm per year aging
Resolution: 1 Hz or 1 ppm

Level dBdsx’ Range: +2.5 dBdsx to -37 dBdsx
Resolution: 0.1 dB
Level dBm? Range: +19.0 dBm to -10.5 dBm

Resolution: 0.1 dB

1. The designation dBdsx is a level measurement in dB relative to dsx level, which is 6 V peak-peak. A signal with a
peak-peak level of 6V corresponds to 0 dBdsx.

2. Available only when unframed all ones (AIS) signal is detected.

E1 specifications

When testing E1 circuits, either BNC or RJ48 connectors can be used. 5882 supports
E1 only on RJ48.

NOTE:

D For the 5800 v1, 5811P and 5822P, the E1 and DS1 interfaces should not be
connected at the same time. Multiple connections can influence the integrity of
the signal under test. After running your test, disconnect from one interface
before connecting to the other interface.
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E1(RJ-48) specifications

Table 24 through Table 26 on page 167 list specifications for the E1 (RJ-48) connector.

Receiver (RJ-48)

The E1 receiver operates as per ITU-G.703 (11/01). Table 24 lists the receiver specifi-
cations.

Table 24 E1 RJ-48 receiver specifications

Parameter Specification

Connector Balanced RJ-48

Bit rate 2.048 Mbps

Frequency measure- Range: 2.048 MHz 250 ppm

ment Accuracy: £1.5 ppm, £1 ppm per year aging
Resolution: 1 Hz

Level Measurement Level Vp

(Balanced) Range: +4 V to 0.03 V

Accuracy: £0.02 V £ 10%
Resolution: 0.01 V

Level dBnom:
Range: +2.5 dBnom to -37 dBnom
Resolution: 0.1 dB

1. The designation in dBnom is relative to nominal signal 3 Vp.

Table 25 lists the input sensitivity specifications for the E1 receiver.

Table 25 E1 RJ-48 receiver sensitivity specifications

Termination

Type Impedance Input Range

Bridge (HI-2Z) >1200 Q +2.5 to -35 dBnom due to cable loss
Terminate 120 Q balanced +2.5 to -35 dBnom due to cable loss
PMP 120 Q balanced -20 dBnom due to resistive loss in addi-

tion to 0 to -6 dB due to cable loss

Transmitter (RJ-48)

The E1 transmitter operates as per ITU-G.703 (11/01). Table 26 lists the transmitter
specifications.

Table 26 E1 RJ-48 transmitter specifications

Parameter Specification
Connector Balanced RJ-48
Line code HDB3 or AMI
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Table 26 E1 RJ-48 transmitter specifications (Continued)

Parameter Specification

Bit rate Nominal: 2.048 Mbps
Accuracy: £1.5 ppm, +1 ppm per year aging
Frequency offset: 100 ppm in 1 ppm steps
Clock Source — Internal reference clock with accuracy +1.5 ppm,
(Timing) 1 ppm per year aging
— Recovered from E1 RX1
— External from BITS, SETS, or CLOCK
Frequency offset 100 ppm in 1 ppm steps

Pulse shape Complies with ITU-T G.703 (11/01)

E3/DS3/STS-1 specifications (5800 family of instruments only)

NOTE:
D These specifications are not applicable to Smart Class 4800/4800P.

Refer to these tables for specifications for the E3/DS3/STS-1 connectors:

* Table 27 on page 168 through Table 29 on page 169 list specifications when
running E3 applications.

* Table 30 on page 169 through Table 32 on page 171 list specifications when
running DS3 applications.

* Table 33 on page 171 through Table 35 on page 172 list specifications when
running STS-1 applications.

Receiver (E3 circuits)

Table 27 lists specifications for the receiver when running applications for E3 circuits.

Table 27 E3 receiver specifications

Parameter Specification
Connector For 5800 v1 and v2, one BNC (RX1)
For 5800-100G and 5882, one HD-BNC (RX1)
Bit rate 34.368 Mbps
Impedance Nominal 75 Q at 17 MHz, unbalanced
Input Range Term: 0 to 12 dBnom due to cable loss at 17 MHz, from a

nominal signal

PMP: -20 dB due to resistive loss in addition to 0 to 12 dB
due to cable loss at 17 MHz, from a nominal signal
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Transmitter (E3 circuits)

Table 28 lists specifications for the transmitter when running applications for E3 circuits.

Table 28 E3 transmitter specifications

Parameter Specification

Connector For 5800 v1 and v2, one BNC (TX/RX2); used as transmit-
ter only. For 5800-100G and 5882, one HD-BNC (TX/RX2)

Bit rate 34.368 Mbps

Line coding HDB3

Clock Source (Tim-
ing)

Frequency offset
Pulse
Impedance

— Internal reference clock with accuracy +1.5 ppm,
1 ppm per year aging

— Recovered from E3 Rx

— External from BITS, SETS, or CLOCK

+100 ppm, in 1 ppm steps

Nominal 1.0 Vp Complies with ITU-T G.703 (11/01)

Nominal 75 Q

Level measurements (E3 circuits)

Table 29 lists frequency and level measurement specifications when running applica-

tions for E3 circuits.

Table 29 E3 frequency and level measurement specifications

Parameter Specification

Tx and Rx Fre- Range: 34.368 MHz 100 ppm

quency Accuracy: £1.5 ppm, £1 ppm per year aging
Resolution: 1 Hz or 1 ppm

Level Vp Range: 1.6 V10 0.01V

Resolution: 0.01 V
Accuracy: £0.02 V £10%

Receiver (DS3 circuits)

Table 30 lists specifications for the receivers when running DS3 applications.

Table 30 DS3 receiver specifications

Parameter Specification

Connector For 5800 v1 and v2, one RX1 BNC, and one TX/RX2 BNC; both
BNCs can be used as receivers. For 5800-100G and 5882, one
RX1 HD-BNC and one TX/RX2 HD-BNC can be used as receiv-

ers.

Bit rate 44.736 Mbps
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Table 30 DS3 receiver specifications (Continued)

Parameter Specification
Impedance Nominal 75 Q at 22 MHz unbalanced
Input Range High/Low: 0 to 12 dB due to cable loss at 22 MHz, from a high

signal
DSX/Monitor: -20 dB due to resistive loss in addition to 0 to 9 dB
due to cable loss at 22MHz, from a High signal

Transmitter (DS3 circuits)

Table 31 lists specifications for the transmitter when running DS3 applications.

Table 31 DS3 transmitter specifications

Parameter Specification

Output For 5800 v1 and v2, one BNC (TX/RX2) can be used as
transmitter or receiver. For 5800-100G and 5882, one HD-
BNC (TX\RX2) can be used as transmitter or receiver.

Bit rate 44.736 Mbps

Line coding B3ZS

Clock Source
(Timing)

Frequency offset
Pulse (high)

Pulse (DSX)

Pulse (low)
Pulse shape

Impedance

— Internal reference clock with accuracy £1.5 ppm, £1 ppm
per year aging

— Recovered from DS3 Rx1

— External from BITS, SETS, or CLOCK

+100 ppm, in 1 ppm steps

Nominal 1.15 Vp. Complies with ANS/ T1.102-1993 and ITU-
T G.703 (11/01) after passing through 450 feet of RG59B/U
cable.

Nominal 0.6 Vp. Complies with ANSI/ T1.102-1993 and ITU-
T G703 (11/01).

Nominal 0.35 Vp

With output terminated in 75 Q resistive load and DSX
selected, the T-BERD/MTS 8000, 6000A, and 5800 meets
ITU-T Recommendation G.703 (11/01) and ANSI T1.102-
1993

Nominal 75 Q
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Physical measurements (DS3 circuits)

Table 32 lists frequency, level, and jitter measurement specifications when running DS3
applications.

Table 32 DS3 frequency and level measurement specifications

Parameter Specification

Tx and Rx — Range: 44.736 MHz +100 ppm

frequency — Accuracy: £1.5 ppm, £1 ppm per year aging
— Resolution: 1 Hz or 1 ppm

Level Vp — Range: 1.6 Vt0 0.01V

— Resolution: 0.01 V
— Accuracy: £0.02 V £10%

Receiver (STS-1 circuits)
Table 33 lists specifications for the receivers when running STS-1 applications.

Table 33 STS-1 receiver specifications

Parameter Specification
Connector For 5800 v1 and v2, one BNC (RX1).
For 5800-100G and 5882, one HD-BNC (RX1).
Bit rate 51.84 Mbps
Impedance Nominal 75 Q at 26 MHz unbalanced
Range — High/Low: 0 to 12 dB due to cable loss at 26 MHz, from a
high signal

— DSX/Monitor: -20 dB due to resistive loss in addition to 0 to
9 dB due to cable loss at 26 MHz, from a High signal

Transmitter (STS-1 circuits)
Table 34 lists specifications for the transmitter when running STS-1 applications.

Table 34 STS-1 transmitter specifications

Parameter Specification

Connector For 5800 v1 and v2, one BNC (TX/RX2); used as transmitter
only. For 5800-100G and 5882, one HD-BNC (TX/RX2); used
as transmitter only.

Bit rate 51.84 Mbps

Line coding B3ZS

Clock Source — Internal reference clock with accuracy £1.5 ppm, £1 ppm
(Timing) per year aging

— Recovered from STS-1 Rx1
— External from BITS, SETS, or CLOCK
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Table 34 STS-1 transmitter specifications (Continued)

Parameter Specification

Frequency offset 50 ppm, in 1 ppm steps

Pulse (high) Nominal 1.15 Vp. Complies with ANS/ T1.102-1993 and ITU-
T G.703 (11/01) after passing through 450 feet of RG59B/U
cable.

Pulse (DSX) Nominal 0.6 Vp. Complies with ANSI/ T1.102-1993 and ITU-T
G.703 (11/01).

Pulse (low) Nominal 0.32 Vp

Pulse shape With output terminated in 75 Q resistive load and DSX

selected, the Dual Module Carrier, Transport Module, and
MSAM meets ITU-T Recommendation G.703 (11/01) and
ANSI T1.102-1993

Impedance Nominal 75 Q

Physical measurements (STS-1 circuits)

Table 35 lists frequency and level measurement specifications when running STS-1
applications.

Table 35 STS-1 frequency and level measurement specifications

Parameter Specification

Tx and Rx Range: 51.84 MHz 50 ppm

frequency Accuracy: £1.5 ppm, £1 ppm per year aging
Resolution: 1 Hz or 1 ppm

Level Vp Range: 1.6 V10 0.01V

Resolution: 0.01 V
Accuracy: £0.02 V £10%

E4/STM-1e specifications (5800 family of instruments only)

Refer to these tables for specifications for the E4/STM-1e connector:
* Table 36 through Table 38 on page 173 list specifications for E4 receivers, trans-
mitters, and frequency and level measurements.

* Table 39 on page 174 through Table 41 on page 175 list specifications for STM-1e
receivers, transmitters, and frequency and level measurements.
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Receiver (E4 circuits)
Table 36 lists specifications for the receiver when running E4 applications.

Table 36 E4 receiver specifications

Parameter Specification

Connector For 5800 v1 and v2, one BNC (RX1). For 5800-100G and
5882, one HD-BNC (RX1).

Bit rate 139.264 Mbps

Impedance Nominal 75 Q at 70 MHz unbalanced

Range — Term: 0 to 12 dB due to cable loss at 70 MHz, from a

nominal signal

— Monitor: -20 dB due to resistive loss in addition to 0 to 12
dB due to cable loss at 70 MHz, from a nominal signal

Transmitter (E4 circuits)
Table 37 lists specifications for the transmitter when running E4 applications.

Table 37 E4 transmitter specifications

Parameter Specification

Connector For 5800 v1 and v2, one BNC (TX/RX2); used as transmitter
only. For 5800-100G and 5882, one HD-BNC (TX/RX2); used
as transmitter only.

Bit rate 139.264 Mbps

Line coding CMI

Tx clock — Internal reference clock with accuracy £1.5 ppm, £1 ppm
(Timing) per year aging

— Recovered from E4 RX1
— External from BITS, SETS, or CLOCK

Frequency offset 50 ppm, in 1 ppm steps
Pulse Nominal 1.0 Vpp Complies with ITU-T G.703 (11/01)
Impedance Nominal 75 Q

Physical measurements (E4 circuits)

Table 38 lists frequency and level measurement specifications when running E4 appli-
cations.

Table 38 E4 frequency and level measurement specifications

Parameter Specification
Tx and Rx — Range: 139.264 MHz +100 ppm
Frequency — Accuracy: £1.5 ppm, £1 ppm per year aging

— Resolution: 1 Hz, or 1 ppm
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Table 38 E4 frequency and level measurement specifications (Continued)

Parameter Specification

Level Vpp — Range: 1.4V 1t00.01V
— Resolution: 0.01 V
— Accuracy: £0.02 V £10%

Receiver (STM-1e circuits)

Table 39 lists specifications for the receiver when running STM-1e applications.

Table 39 STM-1e receiver specifications

Parameter Specification
Connector For 5800 v1 and v2, one BNC (RX1).
For 5800-100G and 5882, one HD-BNC (RX1).
Bit rate 155.52 Mbps
Impedance Nominal 75 Q at 78 MHz unbalanced
Range Term: 0 to 12.7 dB due to cable loss at 78 MHz, from a

nominal signal

PMP: -20 dB due to resistive loss in addition to 0 to 12.7 dB
due to cable loss at 70 MHz, from a nominal signal

Transmitter (STM-1e circuits)

Table 40 lists specifications for the transmitter when running STM-1e applications.

Table 40 STM-1e transmitter specifications

Parameter Specification

Connector For 5800 v1 and v2, one BNC (TX/RX2); used as transmit-
ter only. For 5800-100G and 5882, one HD-BNC TX/(RX2);
used as transmitter only.

Bit rate 155.52 Mbps

Line coding CMI

Tx clock — Internal reference clock with accuracy 1.5 ppm, £1 ppm
(Timing) per year aging

— Recovered from STM-1e RX1
— External from BITS, SETS, or CLOCK

Frequency offset 150 ppm, in 1 ppm steps
Pulse Nominal 1.0 Vpp Complies with ITU-T G.703 (11/01)
Impedance Nominal 75 Q
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Physical measurements (STM-1e circuits)

Table 41 lists frequency and level measurement specifications when running STM-1e

applications.

Table 41 STM-1e frequency and level measurement specifications

Parameter

Specification

Tx and Rx Frequency -

Level Vpp

Range: 155.52 MHz +50 ppm

Accuracy: £1.5 ppm, £1 ppm per year aging
Resolution: 1 Hz or 1 ppm

Range: 1.4V t0 0.01V

Resolution: 0.01 V

Accuracy: £0.02 V £10%

SFP/SFP+/SFP28 specifications

The interfaces of the SFP comply with INF-8074i, Rev 1.0 published on May 12, 2001.

The interfaces of the SFP+ comply with SFF-8431, Rev 4.1 published July 6, 2009.

The interfaces of the SFP28 comply with SFF-8436 and SFF-8402. Note: SFP28 is for
T-BERD/MTS 5800-100G only.

Performance is only guaranteed when using Viavi Recommended Optics.

Supported optical rates

Table 42 provides the optical SONET, SDH, and Ethernet rates supported by the SFP/

SFP+.

Table 42 SONET, SDH, and Ethernet rates

Rate SONET SDH Ethernet
4 Gbps N/A N/A N/A

2.5 Gbps 0C-48 STM-16 N/A

2 Gbps N/A N/A N/A

1 Gbps N/A N/A 1 GigE
10 Gbps N/A N/A 10 GigE
622 Mbps 0C-12 STM-4 N/A

155 Mbps OC-3 STM-1 N/A

100 Mbps N/A N/A 100M
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CFP4 and QSFP+/QSFP28 specifications for 5800-100G
T-BERD/MTS 5800-100G has three types of physical optical ports: CFP4, QSFP28 and
SFP28.

CFP4 Interface

The optical specifications for the CFP4 module interface are detailed in Table 43.

Table 43 CFP4 Optical Module interface specifications

Module Specification

CFP4, hot-pluggable compliant with CFP MSA, CFP4 Hardware Specifica-
tion Rev 1.1, E 802.3ba

QSFP+/QSFP28 Interface

The optical specifications for the QSFP28 interface are detailed in Table 44.
Table 44 QSFP28 Optical module interface specifications

Module Specification
QSFP+/QSFP28, compliant with QSFP28 MSA(SFF-8679), IEEE
hot-pluggable P802.3ba

Optical specifications
Table 45 lists specifications when testing optical circuits.

Table 45 Optical specifications

Item Description

Clock frequency accuracy 1.5 ppm £1 ppm per year aging

Transmitter frequency offset 150 ppm from the nominal rate, in 1 ppm
steps

Frequency measurement accuracy +1.5 ppm =1 ppm per year aging

APS'

resolution Tms

accuracy Tms

RTD

resolution 1us

accuracy 2 us

1. Published resolution and accuracy only ensured when using Viavi recommended transceivers (optics).
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Optional expansion module specifications

NOTE:
D These specifications are not applicable to Smart Class 4800/4800P.

Specifications for optional expansion modules are provided in the user manuals and
data sheets that support the modules.

OTDR Modules

For OTDR Module specifications, refer to the T-BERD / MTS 2000/ 4000 OTDR User
Manual. Supporting data sheets are available at www.viavisolutions.com.

TEM Module

For TEM Module specifications, refer to the T-BERD / MTS 5800 GNSS and Timing
Expansion Module User Manual. Supporting data sheets are available at www.viaviso-
lutions.com.

Internal GNSS application for T-BERD / MTS 5800-100G and 5882

T-BERD / MTS 5800-100G and 5882 support an internal GNSS that can be used when
the TEM module is not available. For more information refer to the T-BERD /MTS 5800
GNSS and Timing Expansion Module User Manual.

MSAM specifications

Refer to the following sections for specifications for the MSAM and each of the available
PIMs:

*  “Physical specifications” on page 178

*  “Power supply specifications” on page 178

*  “Battery specifications” on page 178

* “HS Datacom PIM specifications” on page 178

* “Diphase PIM specifications” on page 198

« “DS1 PIM specifications” on page 199

* “E1 (BNC) PIM specifications” on page 201

*  “E1 (RJ-48) PIM specifications” on page 202

« “E3/DS3/STS-1 PIM specifications” on page 204

* “E4/STM-1e PIM specifications” on page 207

* “Interface Specifications- Jitter and Wander applications” on page 210
*  “SFP PIM specifications” on page 210

«  “XFP PIM specifications” on page 211
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e  “Optical specifications” on page 212
¢ “Clock source (Timing) specifications” on page 212

Physical specifications

The physical characteristics for the MSAM chassis are listed in Table 46.
Table 46 MSAM physical specifications

Item Description

Height 1.25inches / 3.17 cm
Width 4.87 inches / 12.38 cm
Depth 9.12 inches / 23.49 cm
Weight (MSAM only) 1.8 Ibs /0.82 kg
Combined Weight (MSAM, 6000A Base Unit, 8.21bs/3.72 kg

one SFP PIM, and one XFP PIM)

Power supply specifications

Refer to the 6000A Base Unit User Manual for power supply specifications.

Battery specifications

Typical battery life when testing a single interface using a MSAM (inserted in a base
unit) with a single PIM ranges from at least one hour to two hours depending on the
selected interface and test application.

For detailed battery information, refer to the 6000A Base Unit User Manual.

HS Datacom PIM specifications

Table 47 on page 179 through Table 83 on page 197 provide specifications for the HS
Datacom PIM, and for each of the supported interfaces.

Clock input interface specifications

The clock input interface is a BNC connector that allows you to provide a clock from an
external source into the MSAM for interface timing. The external clock does not affect
the MSAM’s internal clock when measuring frequency. You can verify the clock in
frequency by viewing the associated result in the Signal test result category.
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Table 47 provides specifications for the clock input interface.

Table 47 Clock input interface specifications

Item Description

Outer shell Ground

Inner conductor Clock input signal

Acceptable wave signals Square or sine waves

Minimum input 1.5 Vpp

Maximum input 5 Vpp with DC offset of 0 V

Termination 50 Ohm AC termination impedance

Frequency1 5 Hz to 25 MHz

Async signal frequency 16 times the baud rate. For example, an external

clock generator set to 153,600 Hz results in a 9600
baud signal out of the MSAM.

1. Line interfaces may not operate properly if the external clock is outside the supported frequency range for the
interface.

Clock output interface specifications

The clock output interface is a BNC connector that allows you to provide a clock for
interface timing from the MSAM. Table 48 provides specifications for the clock output
interface.

Table 48 Clock output interface specifications

Item Description

Outer shell Ground

Inner conductor Clock output signal

Output signal’ Square wave
Minimum high level From 25 MHz:

— 2 Vpp into a 50 Ohm (+/-1%) load
— 4 Vpp unterminated

Maximum low level 600 mV when sinking 1 mA DC

Async signal frequency 16 times the baud rate. For example, an internally
generated line rate of 9600 baud causes a BNC
clock out signal of 153,600 Hz.

1. Alimited current is supplied to protect against short circuits.
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Internal synthesizer specifications
Table 49 provides specifications for the MSAM’s internal synthesizer.

Table 49 Internal synthesizer specifications

Item Description

Accuracy +/-1,5 ppm

+/- 1 ppm per year aging

Resolution 1 Hz

Synchronous data rate User selectable from 0.005 kHz to 20000 kHz, with a
resolution of 1 Hz. See the Data Communications and

Diphase Testing Manual for the synthesizer frequencies
supported for each interface.

X.21 interface specifications

Recommendation X.21 describes a data communications interface that uses balanced
X.26 circuits (equivalent to V.11) and unbalanced X.27 circuits (equivalent to V.10)
circuits. The MSAM X.21 interface uses V.11 amplifiers.

Table 50 lists the MSAM X.21 interface specifications.

Table 50 X.21 interface specifications

Specification Description
Termination impedance 100 Ohm for balanced circuits, with 10% tolerance.
Timing modes Synchronous
Maximum speed 20 Mbps
Minimum output range +/- 2 'V terminated
Maximum input range +-12V
Rise/Fall times — Clock/data: 6 ns
— Signaling: 10 ns
Receiver minimum input +/- 200 mV
sensitivity
Hysteresis Meets minimum input range

Supported circuits

Table 51 lists the X.21 circuits supported by the MSAM.
Table 51 X.21 circuits

Supported Circuits

C Request to Send
I Clear to Send
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Table 51 X.21 circuits (Continued)

Supported Circuits

R Receive Data

S Receiver Signal Element Timing1
Shield

G Signal Ground

T Transmit Data

X Transmitter Signal Element Timing2

1. The equivalent of an STC circuit is not available in X.21; when testing a X.21 interface, select S instead.
2. Interchange Circuit X (DTE signal element timing = Transmit Clock) is provided per ISO 4903.

DTE emulation

Table 52 lists specifications for X.21 testing in DTE emulation mode.

Table 52 X.21 DTE emulation specifications

Specification Description

User controllable lead C (Control lead)
Sync Timing Mode
Rx Timing Sources — Interface (from the S circuit)
— Interface Recovered
Sync Timing Mode
Tx Timing Sources — Interface (from the S circuit)
— Interface Recovered
— Internal Synthesizer
— External Clock

DCE emulation

Table 53 lists specifications for X.21 testing in DCE emulation mode.

Table 53 X.21 DCE emulation specifications

Specification Description

User controllable lead I (Indication lead)

Sync Timing Mode

Rx Timing Sources Interface (from the X circuit)
Internal Synthesizer
External Clock

Interface Recovered
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Table 53 X.21 DCE emulation specifications (Continued)

Specification

Description

Sync Timing Mode

Tx Timing Sources

Interface (from the X circuit)
Internal Synthesizer
External Clock

Interface Recovered

RS-232/V.24 interface specifications

Recommendation V.24 (equivalent to RS-232D and EIA-232D) describes a data
communications interface that uses unbalanced, bipolar, slew rate limited, V.28 ampli-
fiers. Table 54 lists the MSAM V.24 specifications.

Table 54 V.24 specifications

Specification Description
Termination source V.28 receiver
Timing modes — Synchronous

— Asynchronous
Maximum speed 256 Kbps
Minimum output range +/- 5V loaded
Maximum input range +/-15V
Rise/Fall times 1.5uS

Receiver minimum input sensitivity <0.8V,>3.0V

Hysteresis

Meets minimum input range

Supported circuits

Table 55 lists the V.24 circuits supported by the MSAM.

Table 55 V.24 circuits

Supported Circuits

RTS
ST
D
DTR
RD
RI
LL

1T

Request to Send

Transmitter Element Signal Timing from DCE
Transmit Data

Data Terminal Ready

Receive Data

Ring Indicator

Local Loopback

Signal Ground

Transmitter Element Signal Timing to DCE
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Table 55 V.24 circuits (Continued)

Supported Circuits

DSR Data Set Ready

RT Receiver Signal Element Timing
RLSD Receiver Line Signal Detect

RL Remote Loopback

™ Test Mode

DTE emulation

Table 56 lists specifications for V.24 testing in DTE emulation mode.

Table 56 V.24 DTE emulation specifications

Specification Description
User controllable leads - RTS

- DTR

- LL

- RL

Sync Timing Mode
Rx Timing Sources — Interface (from the RT circuit)
— Interface Recovered
Sync Timing Mode
Tx Timing Sources — Interface (from the RT circuit)
— Interface (from the ST circuit)
— Interface Recovered
— Internal Synthesizer
— External Clock

DCE emulation

Table 57 lists specifications for V.24 testing in DCE emulation mode.

Table 57 V.24 DCE emulation specifications

Specification Description

User controllable leads — RLSD
- DSR
- CTS
- RI
- ™
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Table 57 V.24 DCE emulation specifications (Continued)

Specification Description
Sync Timing Mode
Rx Timing Sources — Interface (from the TT circuit)

Sync Timing Mode

— Internal Synthesizer
— External Clock
— Interface Recovered

Tx Timing Sources — Interface (from the TT circuit)

— Internal Synthesizer
— External Clock
— Interface Recovered

EIA-530/EIA-530A balanced interface specifications

Recommendation EIA-530/EIA-530A describes a data communications interface that
uses balanced V.11 amplifiers for clock and data circuits, and unbalanced V.10 ampli-
fiers for signaling circuits. Table 58 lists EIA-530/EIA-530A specifications for both

balanced and unbalanced circuits.

Table 58 EIA-530/EIA-530A specifications

Specification Description
Timing modes Synchronous
Maximum speed 20 Mbps

Minimum output range

V.11 +/- 2 V terminated
V.10 +/- 4 V unterminated
Maximum input range
V.11 +/-10V
V.10 +/-10V
Rise/Fall times
V.11 10 nS
V.10 500 nS
Receiver minimum input sensitivity
V.11
+/- 200 mV
V.10
+/- 200 mV
Hysteresis Meets minimum input range
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Table 59 lists the EIA-530/EIA-530A termination specifications for balanced circuits.
Table 59 EIA-530/EIA-530A balanced circuit termination specifications

Specification Description
Termination options — unterminated
— 78 Ohm
— 100 Ohm
— 124 Ohm
Impedance — >4 k Ohms unterminated circuits

— 10% tolerance, terminated

Supported circuits

Table 60 lists the EIA-530/EIA-530A circuits supported by the MSAM in balanced
mode.

Table 60 EIA-530/EIA-530A balanced circuits

Supported Circuits

RTS Request to Send
ST Transmitter Element Signal Timing from DCE
TD Transmit Data
DTR Data Terminal Ready
RD Receive Data
RL Remote Loopback
™ Test Mode
Shield
CTS Clear to Send
TT Transmitter Element Signal Timing to DCE
DSR Data Set Ready
RT Receiver Signal Element Timing
RLSD Receiver Line Signal Detect
LL Local Loopback

Signal Ground
RI Ring Indicator (for EIA-530A only)

T-BERD/MTS/SC Getting Started Guide
March 2018 22046537, Rev. 016 Page 185



Appendix A Specifications
MSAM specifications

DTE emulation

Table 61 lists specifications for EIA-530/EIA-530A balanced testing in DTE emulation

mode.

Table 61 EIA-530/EIA-530A balanced DTE emulation specifications

Specification Description
User controllable leads - RTS

- DTR

- LL

- RL

Sync Timing Mode
Rx Timing Sources

Sync Timing Mode
Tx Timing Sources

Interface (from the RT circuit)
Interface Recovered

Interface (from the RT circuit)
Interface (from the ST circuit)
Interface Recovered

Internal Synthesizer

External Clock

DCE emulation

Table 62 lists specifications for balanced EIA-530/EIA-530A testing in DCE emulation

mode.

Table 62 EIA-530/EIA-530A balanced DCE emulation specifications

Specification Description
User controllable leads — RLSD

- DSR

- CTS

- T™M

Sync Timing Mode
Rx Timing Sources

Sync Timing Mode
Tx Timing Sources

RI (for EIA-530A only)

Interface (from the TT circuit)
Internal Synthesizer

External Clock

Interface Recovered

Interface (from the TT circuit)
Internal Synthesizer

External Clock

Interface Recovered
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EIA-530/EIA-530A unbalanced interface specifications

Recommendation EIA-530/EIA-530A describes a data communications interface that
uses unbalanced V.10 amplifiers for all circuits. Table 63 lists the MSAM EIA-530/EIA-
530A unbalanced termination source and timing modes.

Table 63 EIA-530/EIA-530A unbalanced termination and timing modes

Specification Description
Maximum speed 256 Kbps
Termination V.10 amplifier
Timing modes Synchronous

Supported circuits

Table 64 lists the EIA-530/EIA-530A circuits supported by the MSAM in unbalanced
mode.

Table 64 EIA-530/EIA-530A unbalanced mode circuits

Supported Circuits

RTS Request to Send
ST Transmitter Element Signal Timing from DCE
TD Transmit Data
DTR Data Terminal Ready
RD Receive Data
RL Remote Loopback
™ Test Mode
Shield
CTS Clear to Send
TT Transmitter Element Signal Timing to DCE
DSR Data Set Ready
RT Receiver Signal Element Timing
RLSD Receiver Line Signal Detect
LL Local Loopback

Signal Ground
RI Ring Indicator (for EIA-530A only)
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DTE emulation

Table 65 lists specifications for EIA-530/EIA-530A unbalanced testing in DTE emula-

tion mode.

Table 65 EIA-530/EIA-530A unbalanced DTE emulation specifications

Specification Description
User controllable leads - RTS

- DTR

- LL

- RL

Sync Timing Mode
Rx Timing Sources

Sync Timing Mode
Tx Timing Sources

Interface (from the RT circuit)
Interface Recovered

Interface (from the RT circuit)
Interface (from the TT circuit)
Interface Recovered

Internal Synthesizer

External Clock

DCE emulation

Table 66 lists specifications for unbalanced EIA-530/EIA-530A testing in DCE emula-

tion mode.

Table 66 EIA-530/EIA-530A unbalanced DCE emulation specifications

Specification Description
User controllable leads — RLSD

- DSR

- CTS

- ™

Sync Timing Mode
Rx Timing Sources

Sync Timing Mode
Tx Timing Sources

RI (for EIA-530A only)

Interface (from the TT circuit)
Internal Synthesizer

External Clock

Interface Recovered

Interface (from the TT circuit)
Internal Synthesizer

External Clock

Interface Recovered
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MIL-188c interface specifications

Specification MIL-188c, published in 1969, describes a data communications interface
that uses a 25 pin connector, and unbalanced MIL-188c amplifiers for all circuits. The

MSAM supports
specifications.

testing of unterminated MIL-188c circuits. Table 67 lists the MIL-188c

Table 67 MIL-188c specifications

Specification Description
Timing Modes Synchronous
Maximum speed 64 Kbps
Minimum output range +/- 5V loaded
Maximum input range +/-15V
Rise/Fall times 1.5uS

Receiver minimum input sen- <08V,>3.0V

sitivity
Hysteresis

Meets minimum input range

Supported circuits

Table 68 lists the unbalanced MIL-188c circuits supported by the MSAM.

Table 68 Unbalanced MIL-188c circuits

Supported Circuits

RTS
ST
D
DTR
RD
RL
™

CTS
T
DSR
RT
RLSD
LL

RI

Request to Send

Transmitter Element Signal Timing from DCE
Transmit Data

Data Terminal Ready

Receive Data

Remote Loopback

Test Mode

Shield

Clear to Send

Transmitter Element Signal Timing to DCE
Data Set Ready

Receiver Signal Element Timing

Receiver Line Signal Detect

Local Loopback

Signal Ground

Ring Indicator
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DTE emulation

Table 69 lists specifications for MIL-188c testing in DTE emulation mode.

Table 69 MIL-188c DTE emulation specifications

Specification Description
User controllable leads — RTS

- DTR

— LL

- RL

Sync Timing Mode
Rx Timing Sources

Sync Timing Mode
Tx Timing Sources

Interface (from the RT circuit)
Interface Recovered

Interface (from the RT circuit)
Interface (from the ST circuit)
Interface Recovered

Internal Synthesizer

External Clock

DCE emulation

Table 70 lists specifications for MIL-188c testing in DCE emulation mode.

Table 70 MIL-188c DCE emulation specifications

Specification

Description

User controllable leads

Sync Timing Mode
Rx Timing Sources

Sync Timing Mode
Tx Timing Sources

RLSD
DSR
CTS
™

RI

Interface (from the TT circuit)
Internal Synthesizer

External Clock

Interface Recovered

Interface (from the TT circuit)
Internal Synthesizer

External Clock

Interface Recovered
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V.35 interface specifications

Recommendation V.35 is primarily a modem specification; however, it also describes a
data communications interface that uses balanced V.35 amplifiers for clock and data
circuits, and unbalanced V.28 amplifiers for signaling circuits. Table 71 lists the V.35
specifications for balanced and unbalanced circuits.

Table 71 V.35 specifications

Specification Description
Timing modes Synchronous
Maximum speed 15 Mbps

Minimum output range
V.35

V.28

Rise/Fall times
V.35

V.28
Receiver minimum input sensitiv-

ity
V.35
V.28

Hysteresis

+/- 0.44 V terminated

+-5V

<10nS

1.5uS

+/- 200 mV

<08V,>3.0V
Meets minimum input range

Table 72 lists the MSAM V.35 termination specifications.

Table 72 V.35 circuit termination specifications

Specification Description
Balanced receivers
Termination 100 Ohm
Impedance +/- 20%

Unbalanced receivers
Load impedance
Maximum input voltage

Signaling polarity

3k to 7 k Ohms
+/-15V

ON: greater than +3 V dc
OFF: open or less than -3 V dc
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Supported circuits

Table 73 lists the V.35 circuits supported by the MSAM.

Table 73 V.35 circuits

Supported Circuits

RTS
SCT
SD
DTR
RD
RL
™

CTS
SCTE
DSR
SCR
RLSD
LL

RI

Request to Send

Transmitter Element Signal Timing from DCE
Transmit Data

Data Terminal Ready

Receive Data

Remote Loopback

Test Mode

Shield

Clear to Send

Transmitter Element Signal Timing to DCE
Data Set Ready

Receiver Signal Element Timing

Receiver Line Signal Detect

Local Loopback

Signal Ground

Ring

DTE emulation

Table 74 lists specifications for V.35 testing in DTE emulation mode.

Table 74 V.35 DTE emulation specifications

Specification Description
User controllable leads — RTS
- DTR
- LL
- RL
Sync Timing Mode
Rx Timing Sources — Interface (from the SCR circuit)

Sync Timing Mode

— Interface Recovered

Tx Timing Sources — Interface (from the SCT circuit)

— Interface (from the SCR circuit)
— Interface Recovered

— Internal Synthesizer

— External Clock
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DCE emulation

Table 75 lists specifications for V.35 testing in DCE emulation mode.

Table 75 V.35 DCE emulation specifications

Specification Description

User controllable leads - RLSD
- DSR
- CTS
- ™
- CI

Sync Timing Mode
Rx Timing Sources — Interface (from the SCTE-306 circuit)
— Internal Synthesizer
— External Clock
— Interface Recovered
Sync Timing Mode
Tx Timing Sources — Interface (from the SCTE-306 circuit)
— Internal Synthesizer
— External Clock
— Interface Recovered

RS-449/V.36 specifications

Recommendation V.36 (equivalent to RS-449) is primarily a modem specification;
however, it also describes a data communications interface that uses balanced

V.11 amplifiers for all circuits except test mode circuits. The V.36 test mode circuits use
unbalanced V.10 amplifiers. V.10 amplifiers can also be used for signaling circuits.
When V.10 amplifiers are used for signaling, the B lead is grounded internally in the
MSAM.

Table 76 lists the MSAM V.36 specifications.
Table 76 V.36 specifications

Specification Description

Maximum speed Balanced
— 20 Mbps
Unbalanced
— 64 Kbps
Termination options — unterminated
— 78 Ohm
— 100 Ohm
— 124 Ohm

Impedance — >4 k Ohm, unterminated circuits
— 10% tolerance, terminated
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Table 76 V.36 specifications (Continued)

Specification

Description

Minimum output range
V.11

V.10

Maximum input range
V.11

V.10

Rise/Fall times
V.11

V.10

Receiver minimum input sensitivity
V.1

V.10
Hysteresis

+/- 2 V terminated

+/- 4 \/ unterminated

+-10V

+-10V

10 nS

500 nS

+/- 200 mV

+/- 200 mV
Meets minimum input range

S

upported circuits

Table 77 lists the V.36 circuits supported by the MSAM.

Table 77 V.36 circuits

Supported Circuits

Transmitter Element Signal Timing from DCE

Transmitter Element Signal Timing to DCE

RS Request to Send
ST
SD Transmit Data
TR Data Terminal Ready
RD Receive Data
RL Remote Loopback
™ Test Mode
Shield
CS Clear to Send
TT
DM Data Set Ready
RT Receiver Signal Element Timing
RR Receiver Line Signal Detect
LL Local Loopback

Signal Ground
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Table 77 V.36 circuits (Continued)

Supported Circuits

IC Ring Indicator

DTE emulation

Table 78 lists specifications for V.36 testing in DTE emulation mode.

Table 78 V.36 DTE emulation specifications

Specification Description
User controllable leads - RS

- TR

- LL

- RL

Sync Timing Mode
Rx Timing Sources — Interface (from the RT circuit)
— Interface Recovered
Sync Timing Mode
Tx Timing Sources — Interface (from the RT circuit)
— Interface (from the ST circuit)
— Interface Recovered
— Internal Synthesizer
— External Clock

DCE emulation

Table 79 lists specifications for V.36 testing in DCE emulation mode.

Table 79 V.36 DCE emulation specifications

Specification Description
User controllable leads - RR

- DM

- CS

- ™

— IC (37 pin connector only)
Sync Timing Mode
Rx Timing Sources — Interface (from the TT circuit)
— Internal Synthesizer
— External Clock
— Interface Recovered
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Table 79 V.36 DCE emulation specifications (Continued)

Specification Description

Sync Timing Mode
Tx Timing Sources

Interface (from the TT circuit)
Internal Synthesizer

External Clock

Interface Recovered

MIL-188-114 interface specifications

Specification MIL-188-114 describes a data communications interface that uses
DB-25 connector or DB-37 connectors using balanced or unbalanced MIL-188-114
amplifiers for all circuits. The MSAM supports testing of MIL-188-114 circuits in asyn-
chronous or synchronous mode. Table 80 lists the MIL-188-114 specifications.

Table 80 MIL-188-114 specifications

Specification Description
Timing modes Synchronous
Maximum speed
Balanced 20 Mbps
Unbalanced 256 Kbps
Minimum output range +/- 2 V terminated
Rise/Fall times 10 nS

Receiver minimum input sensitivity +/- 200 mV
Hysteresis Meets minimum input range

Supported circuits

Table 81 lists the unbalanced MIL-188-114 circuits supported by the MSAM.
Table 81 Unbalanced MIL-188-114 circuits

Supported Circuits

RS Request to Send
ST Transmitter Element Signal Timing from DCE
SD Transmit Data
TR Data Terminal Ready
RD Receive Data
RL Remote Loopback
™ Test Mode
Shield
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Table 81 Unbalanced MIL-188-114 circuits (Continued)

Supported Circuits

CS Clear to Send

TT Transmitter Element Signal Timing to DCE
DM Data Set Ready

RT Receiver Signal Element Timing

RR Receiver Line Signal Detect

LL Local Loopback

Signal Ground
IC Ring Indicator

DTE emulation

Table 82 lists specifications for MIL-188-114 testing in DTE emulation mode.
Table 82 MIL-188-114 DTE emulation specifications

Specification Description
User controllable leads - RS

- TR

- LL

- RL

Sync Timing Mode
Rx Timing Sources — Interface (from the RT circuit)
— Interface Recovered
Sync Timing Mode
Tx Timing Sources — Interface (from the RT circuit)
— Interface (from the ST circuit)
— Interface Recovered
— Internal Synthesizer
— External Clock

DCE emulation

Table 83 lists specifications for MIL-188-114 testing in DCE emulation mode.
Table 83 MIL-188-114 DCE emulation specifications

Specification Description
User controllable leads - RR

- DM

- CS

- ™

— IC (37 pin connector only)
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Table 83 MIL-188-114 DCE emulation specifications (Continued)

Specification

Description

Sync Timing Mode
Rx Timing Sources

Sync Timing Mode
Tx Timing Sources

— Interface (from the TT circuit)
— Internal Synthesizer

— External Clock

— Interface Recovered

— Interface (from the TT circuit)
— Internal Synthesizer

— External Clock

— Interface Recovered

Diphase PIM specifications

Table 84 on page 198 and Table 85 on page 199 provide specifications for the Diphase

PIM.

Receiver specifications

Table 84 lists receiver specifications for the Conditioned Diphase PIM.

Table 84 Receiver specifications

Item Description
Signal level 6.0 Vrms (+6 dB) to 90 mVrms (-30 dB)
Termination User selectable, +/- 20%
— 58 Ohms
— 130 Ohms
— Bridge (>2 Kohms)
Pull range +/- 600 ppm

Signal recovery
(per MIL-188-202)

Cable loss
compensation

NOTE: The Frequency History result appears in the Sum-
mary result category if the measured receive frequency
deviates +/- 150 ppm from the expected frequency.
128/256/512 kbps

— 3.2 Km of coaxial cable

2048 kbps

— 1.6 Km of coaxial cable

64 Kbps

— 2 Km of twisted pair cable

Up to 30 dB at all data rates
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Table 84 Receiver specifications (Continued)

Item

Description

Signal present

Declared if transitions are > +/- 90 mV.

NOTE: Valid signal indication is guaranteed if frequency
offset is <600 ppm.

Transmitter specifications

Table 85 lists transmitter specifications for the Conditioned Diphase interface module.

Table 85 Transmitter specifications

Item

Description

Timing source

Output level

User selectable
— Rx (Recovered)
— Internal (Rate)

+/- 3 Vp +/-15% when terminated into 58 or 130 Ohms

DS1PIM specifications

Table 86 on page 199 through Table 89 on page 200 list specifications for the DS1 PIM.

Receiver

Table 86 lists specifications for the DS1 receivers.

Table 86 DS1 receiver specifications

Parameter Specification

Connector One RX1 Bantam Jack, and one TX/RX2 Bantam jack;
both jacks can be used as receivers

Bit rate 1544 kbps £250 ppm

Line coding AMI, B8ZS

Table 87 lists the input sensitivity specifications for the DS1 receiver.

Table 87 DS1 receiver sensitivity specifications

Termination Type Impedance Input Range

Bridge >1000 Q +6 to -35.0 dBdsx due to cable loss
Terminate 100 Q nom +6 to -35.0 dBdsx due to cable loss

DSX monitor 100 Q nom -20 dBdsx due to resistive loss in addition to

0 to -6 dB due to cable loss
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Transmitter

Table 88 lists specifications for the DS1 transmitter.

Table 88 DS1 transmitter specifications

Parameter Specification

Connector One TX/RX2 Bantam jack; only the TX/RX2 jack can be used as
a transmitter

Output 6 Vnom peak-peak into 100 Q

Line build out
(LBO) level

LBO level
accuracy

Line code

Clock source
(Timing)

Frequency off-
set

Pulse shape

Complies with ANSI T1.403-1999.
0dB, -7.5dB, -15.0 dB or -22.5 dB due to cable loss at 772 kHz

At 772 kHz relative to the signal at 0 dBdsx:
- +25dBfor-7.5dB
— 13 dBfor-15.0 dB and -22.5 dB

AMI, B8ZS

— Internal reference clock with accuracy 1.5 ppm, £1 ppm per
year aging

— Recovered from RX1

— External from BITS, SETS, or CLOCK

100 ppm, in 1 ppm steps

Terminated with 100 Q resistive load and 0 dB LBO selected, the
interface meets ITU-T Recommendation G.703 (11/01) and
ANSI T1.102-1993

Physical measurements

Table 89 lists frequency and level measurement specifications when running DS1 appli-

cations.

Table 89 DS1 frequency and level measurement specifications

Parameter Specification

Level V p-p Range: 8.0 V t0 0.06 V
Accuracy: + 0.04 V £ 10%
Resolution: 0.01 V

Frequency Range: 1.544 MHz +250 ppm

Level dBdsx'

Level dBm?2

Accuracy: £ 1.5 ppm, £ 1 ppm per year aging
Resolution: 1 Hz or 1 ppm

Range: +2.5 dBdsx to -37 dBdsx
Resolution: 0.1 dB

Range: +19.0 dBm to -10.5 dBm
Resolution: 0.1 dB
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1. The designation dBdsx is a level measurement in dB relative to dsx level, which is 6 V peak-peak. A signal with a
peak-peak level of 6V corresponds to 0 dBdsx.
2. Available only when unframed all ones (AIS) signal is detected.

E1(BNC) PIM specifications

Table 90 on page 201 through Table 93 on page 202 list specifications for the E1 (BNC)
PIM.

Receiver (BNC)

The E1 receiver operates as per ITU-G.703 (11/01). Table 90 lists the receiver specifi-
cations.

Table 90 E1 BNC receiver specifications

Parameter Specification

Connector One unbalanced RX1 BNC, and one unbalanced TX/RX2
BNC; both BNCs can be used as receivers

Bit rate 2.048 Mbps

Frequency measure- Range: 2.048 MHz £250 ppm

ment Accuracy: £1.5 ppm, £1 ppm per year aging

Resolution: 1 Hz

Level Measurement Level Vp
(Unbalanced) Range: +4.0 VV to 0.03 V
Accuracy: £0.02 V £ 10%
Resolution: 0.01 V
Level dBnom:
Range: 4.5 dBnom to -37 dBnom
Resolution: 0.1 dB

1. The designation in dBnom is relative to nominal signal 2.37 Vp.

Table 91 lists the input sensitivity specifications for the E1 receiver.

Table 91 E1 receiver sensitivity specifications

Termination Type Impedance Input Range

Bridge (HI-Z) >750 Q +4 to -35 dBnom due to cable loss
Terminate 75 Q unbalanced +4 to -35 dBnom due to cable loss
PMP 75 Q unbalanced -20 dBnom due to resistive loss in

addition to 0 to -6 dB due to cable loss
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Transmitter (BNC)

The E1 transmitter operates as per ITU-G.703 (11/01). Table 92 lists the transmitter

specifications.

Table 92 E1 BNC transmitter specifications

Parameter Specification

Connector One unbalanced BNC/ 75 Q; only the TX/RX2 BNC can be
used as a transmitter

Line code HDB3 or AMI

Bit rate Nominal: 2.048 Mbps

Clock Source
(Timing)

Frequency offset
Pulse shape

Accuracy: £1.5 ppm, +1 ppm per year aging
Frequency offset: £100 ppm in 1 ppm steps

Internal reference clock with accuracy 1.5 ppm,
+1 ppm per year aging

Recovered from Rx1

External from BITS, SETS, or CLOCK

BITS

1.544 Mbps DS1/T1 signal

SETS

2.048 Mbps E1 signal

2MClock

2.048 MHz G.703 sync clock (square wave)

10M Clock
10.000 MHz square clock

+100 ppm in 1 ppm steps
Complies with ITU-T G.703 (11/01)

E1(RJ-48) PIM specifications

Table 93 on page 202 through Table 95 on page 203 list specifications for the E1 (BNC)

PIM.

Receiver (RJ-48)

The E1 receiver operates as per ITU-G.703 (11/01). Table 93 lists the receiver specifi-

cations.

Table 93 E1 RJ-48 receiver specifications

Parameter Specification
Connector Balanced RJ-48
Bit rate 2.048 Mbps
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Table 93 E1 RJ-48 receiver specifications (Continued)

Parameter Specification

Frequency measurement Range: 2.048 MHz +250 ppm
Accuracy: £1.5 ppm, +1 ppm per year aging
Resolution: 1 Hz

Level Measurement Level Vp
(Balanced) Range: +4 V to 0.03 V
Accuracy: £0.02 V £ 10%
Resolution: 0.01 V
Level dBnom:
Range: +2.5 dBnom to -37 dBnom
Resolution: 0.1 dB

1. The designation in dBnom is relative to nominal signal 3 Vp.

Table 94 lists the input sensitivity specifications for the E1 receiver.

Table 94 E1 RJ-48 receiver sensitivity specifications

Termination Type Impedance Input Range

Bridge (HI-Z) >1200 Q +2.5 to -35 dBnom due to cable loss
Terminate 120 Q balanced +2.5 to -35 dBnom due to cable loss
PMP 120 Q balanced -20 dBnom due to resistive loss in

addition to 0 to -6 dB due to cable loss

Transmitter (RJ-48)

The E1 transmitter operates as per ITU-G.703 (11/01). Table 95 lists the transmitter
specifications.

Table 95 E1 RJ-48 transmitter specifications

Parameter Specification
Connector Balanced RJ-48

Line code HDB3 or AMI

Bit rate Nominal: 2.048 Mbps

Accuracy: +1.5 ppm, £1 ppm per year aging

Frequency offset: £100 ppm in 1 ppm steps
Clock Source — Internal reference clock with accuracy £1.5 ppm,
(Timing) +1 ppm per year aging

— Recovered from Rx1

— External from BITS, SETS, or CLOCK
Frequency offset 100 ppm in 1 ppm steps

Pulse shape Complies with ITU-T G.703 (11/01)
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E3/DS3/STS-1 PIM specifications

Refer to these tables for specifications for the E3/DS3/STS-1 PIM:

* Table 96 on page 204 through Table 97 on page 204 list specifications when

running E3 applications.

* Table 99 on page 205 through Table 101 on page 206 list specifications when
running DS3 applications.

e Table 102 on page 206 through Table 104 on page 207 list specifications when
running STS-1 applications.

Receiver (E3 circuits)

Table 96 lists specifications for the receiver when running applications for E3 circuits.

Table 96 E3 receiver specifications

Parameter Specification

Connector One BNC (RX1)

Bit rate 34.368 Mbps

Impedance Nominal 75 Q at 17 MHz, unbalanced

Input Range Term: 0 to 12 dBnom due to cable loss at 17 MHz, from a

nominal signal

PMP: -20 dB due to resistive loss in addition to 0 to 12 dB
due to cable loss at 17 MHz, from a nominal signal

Transmitter (E3 circuits)

Table 97 lists specifications for the transmitter when running applications for E3 circuits.

Table 97 E3 transmitter specifications

Parameter Specification

Connector One BNC (TX/RX2); used as transmitter only
Bit rate 34.368 Mbps

Line coding HDB3

Clock Source (Timing)

Frequency offset
Pulse
Impedance

Internal reference clock with accuracy 1.5 ppm,
+1 ppm per year aging

— Recovered from E3 Rx

— External from BITS, SETS, or CLOCK

+100 ppm, in 1 ppm steps

Nominal 1.0 Vp Complies with ITU-T G.703 (11/01)
Nominal 75 Q
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Level measurements (E3 circuits)

Table 98 lists frequency and level measurement specifications when running applica-

tions for E3 circuits.

Table 98 E3 frequency and level measurement specifications

Parameter

Specification

Tx and Rx Frequency Range: 34.368 MHz +100 ppm

Level Vp

Accuracy: £1.5 ppm, £1 ppm per year aging
Resolution: 1 Hz or 1 ppm

Range: 1.6 V10 0.01V

Resolution: 0.01 V

Accuracy: £+0.05 V £10%

Receiver (DS3 circuits)

Table 99 lists specifications for the receivers when running DS3 applications.

Table 99 DS3 receiver specifications

Parameter Specification

Connector One RX1 BNC, and one TX/RX2 BNC; both BNCs can be used
as receivers

Bit rate 44.736 Mbps

Impedance Nominal 75 Q at 22 MHz unbalanced

Input Range High/Low: 0 to 12 dB due to cable loss at 22 MHz, from a high

signal
DSX/Monitor: -20 dB due to resistive loss in addition to 0 to 9 dB
due to cable loss at 22MHz, from a High signal

Transmitter (DS3 circuits)

Table 100 lists specifications for the transmitter when running DS3 applications.

Table 100 DS3 transmitter specifications

Parameter Specification

Output One BNC (TX/RX2); can be used as transmitter or receiver.
Bit rate 44,736 Mbps

Line coding B3ZS

Clock Source
(Timing)

Frequency offset

— Internal reference clock with accuracy £1.5 ppm,
+1 ppm per year aging

— Recovered from DS3 Rx1

— External from BITS, SETS, or CLOCK

100 ppm, in 1 ppm steps
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Table 100 DS3 transmitter specifications (Continued)

Parameter

Specification

Pulse (high)

Pulse (DSX)

Pulse (low)
Pulse shape

Impedance

Nominal 1.15 Vp. Complies with ANS/ T1.102-1993 and ITU-T
G.703 (11/01) after passing through 450 feet of RG59B/U
cable.

Nominal 0.6 Vp. Complies with ANSI T1.102-1993 and ITU-T
G.703 (11/01).

Nominal 0.35 Vp

With output terminated in 75 Q resistive load and DSX
selected, the T-BERD/MTS 8000, 6000A, and 5800 meets
ITU-T Recommendation G.703 (11/01) and ANSI T1.102-1993

Nominal 75 Q

Physical measurements (DS3 circuits)

Table 101 lists frequency, level, and jitter measurement specifications when running

DS3 applications.

Table 101 DS3 frequency and level measurement specifications

Parameter

Specification

Tx and Rx
frequency

Level Vp

— Range: 44.736 MHz £100 ppm

— Accuracy: £1.5 ppm, £1 ppm per year aging
— Resolution: 1 Hz or 1 ppm

— Range: 1.6 Vto 0.01V

— Resolution: 0.01 V

— Accuracy: £0.05V £10%

Receiver (STS-1 circuits)

Table 102 lists specifications for the receivers when running STS-1 applications.

Table 102 STS-1 receiver specifications

Parameter

Specification

Connector
Bit rate
Impedance
Range

One BNC (RX1)
51.84 Mbps
Nominal 75 Q at 26 MHz unbalanced

— High/Low: 0 to 12 dB due to cable loss at 26 MHz, from a
high signal

— DSX/Monitor: -20 dB due to resistive loss in addition to 0 to
9 dB due to cable loss at 26 MHz, from a High signal
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Transmitter (STS-1 circuits)
Table 103 lists specifications for the transmitter when running STS-1 applications.

Table 103 STS-1 transmitter specifications

Parameter Specification

Connector One BNC (TX/RX2); used as transmitter only
Bit rate 51.84 Mbps

Line coding B3ZS

Clock Source
(Timing)

Frequency offset

— Internal reference clock with accuracy £1.5 ppm,
11 ppm per year aging

— Recovered from STS-1 Rx1

— External from BITS, SETS, or CLOCK

+50 ppm, in 1 ppm steps

Pulse (high) Nominal 1.15 Vp. Complies with ANS/ T1.102-1993 and ITU-T
G.703 (11/01) after passing through 450 feet of RG59B/U
cable.

Pulse (DSX) Nominal 0.6 Vp. Complies with ANSI T1.102-1993 and ITU-T
G.703 (11/01).

Pulse (low) Nominal 0.32 Vp

Pulse shape With output terminated in 75 Q resistive load and DSX
selected, the Dual Module Carrier, Transport Module, and
MSAM meets ITU-T Recommendation G.703 (11/01) and ANS/
T1.102-1993

Impedance Nominal 75 Q

Physical measurements (STS-1 circuits)

Table 104 lists frequency and level measurement specifications when running STS-1
applications.

Table 104 STS-1 frequency and level measurement specifications

Parameter Specification

Range: 51.84 MHz 50 ppm

Accuracy: +1.5 ppm, £1 ppm per year aging
Resolution: 1 Hz or 1 ppm

Range: 1.6 V10 0.01V

Resolution: 0.01 V

Accuracy: £0.05 V £10%

Tx and Rx frequency

Level Vp

E4/STM-1e PIM specifications

Refer to these tables for specifications for the E4/STM-1e PIM:
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* Table 105 on page 208 through Table 107 on page 209 list specifications for E4
receivers, transmitters, and frequency and level measurements.

* Table 108 on page 209 through Table 110 on page 210 list specifications for STM-
1 receivers, transmitters, and frequency and level measurements.

Receiver (E4 circuits)

Table 105 lists specifications for the receiver when running E4 applications.

Table 105E4 receiver specifications

Parameter Specification

Connector One BNC

Bit rate 139.264 Mbps

Impedance Nominal 75 Q at 70 MHz unbalanced

Range — Term: 0 to 12 dB due to cable loss at 70 MHz, from a

nominal signal

— PMP: -20 dB due to resistive loss in additionto 0 to 12 dB

due to cable loss at 70 MHz, from a nominal signal

Transmitter (E4 circuits)

Table 106 lists specifications for the transmitter when running E4 applications.

Table 106 E4 transmitter specifications

Parameter Specification

Connector One BNC

Bit rate 139.264 Mbps

Line coding CMI

Tx clock — Internal reference clock with accuracy +1.5 ppm,
(Timing) +1 ppm per year aging

Frequency offset
Pulse
Impedance

— Recovered from E4 Rx
— External from BITS, SETS, or CLOCK

50 ppm, in 1 ppm steps
Nominal 1.0 Vpp Complies with ITU-T G.703 (11/01)
Nominal 75 Q
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Physical measurements (E4 circuits)

Table 107 lists frequency and level measurement specifications when running E4 appli-
cations.

Table 107 E4 frequency and level measurement specifications

Parameter Specification

Tx and Rx — Range: 139.264 MHz 100 ppm

Frequency — Accuracy: £1.5 ppm, £1 ppm per year aging
— Resolution: 1 Hz, or 1 ppm

Level Vpp — Range: 1.4V t00.01V

— Resolution: 0.01 V
— Accuracy: £0.05V £10%

Receiver (STM-1e circuits)
Table 108 lists specifications for the receiver when running STM-1e applications.

Table 108 STM-1e receiver specifications

Parameter Specification

Connector One BNC

Bit rate 155.52 Mbps

Impedance Nominal 75 Q at 78 MHz unbalanced

Range Term: O to 12.7 dB due to cable loss at 78 MHz, from a

nominal signal

PMP: -20 dB due to resistive loss in addition to 0 to 12.7 dB
due to cable loss at 70 MHz, from a nominal signal

Transmitter (STM-1e circuits)
Table 109 lists specifications for the transmitter when running STM-1e applications.

Table 109 STM-1e transmitter specifications

Parameter Specification

Connector One BNC

Bit rate 155.52 Mbps

Line coding CMI

Tx clock — Internal reference clock with accuracy £1.5 ppm,
(Timing) +1 ppm per year aging

— Recovered from Rx1
— External from BITS, SETS, or CLOCK

Frequency offset 50 ppm, in 1 ppm steps
Pulse Nominal 1.0 Vpp Complies with ITU-T G.703 (11/01)
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Table 109 STM-1e transmitter specifications (Continued)

Parameter Specification

Impedance Nominal 75 Q

Physical measurements (STM-1e circuits)

Table 110 lists frequency and level measurement specifications when running STM-1e
applications.

Table 110 STM-1e frequency and level measurement specifications

Parameter Specification

Tx and Rx — Range: 155.52 MHz +50 ppm

Frequency — Accuracy: £1.5 ppm, £1 ppm per year aging
— Resolution: 1 Hz or 1 ppm

Level Vpp — Range: 14V 1t00.01V

— Resolution: 0.01 V
— Accuracy: £0.05V £10%

Interface Specifications- Jitter and Wander applications

The electrical and optical interface specifications for MSAM Jitter and Wander applica-
tions are detailed in “Jitter and Wander specifications” on page 224.

SFP PIM specifications

The interfaces of the SFP PIM comply with INF-8074i, Rev 1.0 published on May 12,
2001. Performance is only guaranteed when using Viavi Recommended Optics.

Supported electrical rates

The 10/100/1000 Base-T/Tx interfaces conform to the IEEE 802.3 electrical require-
ments.

Table 111 lists the electrical rates supported by the SFP PIM.

Table 111 Electrical rates

Rate Mbps
10Base-T Ethernet 10
100Base-T Ethernet 100
1000Base-T Ethernet 1000
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Electrical interface specifications

Table 112 lists the electrical specifications for the 10/100/
1000 Mb/s interface.

Table 112 10/100/1000 Mb/s interface specifications

Specification Description
Cable CAT5e 100-Ohm STP cable, < 100 meters

Supported optical rates

Table 113 provides the optical SONET, SDH, OTN, Ethernet, and Fibre Channel rates
supported by the SFP PIM.

Table 113 SONET, SDH, OTN, Ethernet, and Fibre Channel rates

Rate SONET  SDH OTN Ethernet  (ro
4 Gbps N/A N/A N/A N/A 4Gig
25Gbps  OC-48 STM-16  2.7Gbps  N/A N/A
2 Gbps N/A N/A N/A N/A 2Gig
1 Gbps N/A N/A N/A 1GigE  1Gig
622 Mbps ~ OC-12 STM4 N N/A N/A
155 Mbps ~ OC-3 STM-1 N/A N/A N/A
100 Mbps ~ N/A N/A N/A 100M N/A
XFP PIM specifications

The interface of the XFP PIM complies with INF-8077i, Rev 4.5 published on August
31, 2005. Performance is only guaranteed when using Viavi Recommended Optics.

Supported optical rates

The XFP PIM supports the 10 Gigabit optical interfaces listed in Table 114.
Table 114 SONET, SDH, OTN, Ethernet, and Fibre Channel rates

Rate SONET SDH OTN Ethernet Fibre Channel
10 Gbps 0C-192 STM-64 10.7 Gbps 10GigE 8Gig

11.1 Gbps 10Gig

11.05 Gbps
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Optical specifications
Table 115 lists specifications for the available PIMs when testing optical circuits.

Table 115 Optical specifications

Item Description

Clock frequency accuracy 1.5 ppm £1 ppm per year aging
Transmitter frequency offset 150 ppm from the nominal rate, in 1 ppm steps
Frequency measurement 1.5 ppm £1 ppm per year aging
accuracy

APS'

resolution 1ms

accuracy 1ms

RTD

resolution 1us

accuracy 2us

1. Published resolution and accuracy only ensured when using Viavi recommended transceivers (optics).

Clock source (Timing) specifications

Table 116 lists internal and external timing specifications for the MSAM chassis.

Table 116 Timing specifications

Clock Source Description
Internal reference accuracy =1.5 ppm, £1 ppm per year aging
External BNC from BITS, SETS, or CLOCK

DS1 electrical specifications

Table 117 on page 212 through Table 120 on page 213 list specifications for DS1
receivers, transmitters, and frequency and level measurements.

Receivers
Table 117 lists specifications for the Primary and Secondary DS1 receivers.

Table 117 DS1 receiver specifications

Parameter Specification
Connectors Two bantam jacks
Bit rate 1544 kbps £250 ppm
Line coding AMI, B8ZS
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Table 118 lists the input sensitivity specifications for the Primary and Secondary DS1
receivers.

Table 118 DS1 receiver sensitivity specifications

Termination Type Impedance Input Range

Bridge >1000 Q +6 to -35.0 dBdsx due to cable loss
Terminate 100 Q 5% +6 to -35.0 dBdsx due to cable loss
DSX monitor 100 Q 5% -20 dBdsx due to resistive loss in

addition to 0 to -6 dB due to cable loss

Transmitter

Table 119 lists specifications for the DS1 transmitter.

Table 119 DS1 transmitter specifications

Parameter Specification

Connector Bantam jack

Output 6 V peak-peak into 100 Q

Line build out 0dB, -7.5dB, -15.0 dB or -22.5 dB due to cable loss at
(LBO) level 772 kHz

LBO level accuracy At 772 kHz relative to the signal at 0 dBdsx:
— £25dBfor-7.5dB
— 3 dBfor-15.0 dB and -22.5 dB

Line code AMI, B8ZS
Clock source — Internal reference clock with accuracy £1.5 ppm,
(Timing) 11 ppm per year aging

— Recovered from Rx1 or Rx2
— External from BITS, SETS, or CLOCK
Frequency offset +100 ppm, in 1 ppm steps

Pulse shape With output terminated in 100 Q resistive load and 0 dB
LBO selected, the interface meets ITU-T Recommenda-
tion G.703 (11/01) and ANSI T1.102-1993

Physical measurements
Table 120 lists frequency, level, and jitter measurement specifications for DS1.

Table 120DS1 frequency, level, and jitter measurement specifications

Parameter Specification
Level V p-p Range: 14.0 V to 0.06 V

Accuracy: + 0.04V £ 10%
Resolution: 0.01 V
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Table 120DS1 frequency, level, and jitter measurement specifications (Continued)

Parameter Specification

Frequency Range: 1.544 MHz 250 ppm
Accuracy: £ 1.5 ppm, £ 1 ppm per year aging
Resolution: 1 Hz or 1 ppm

Level dBdsx’ Range: +7.3 dBdsx to -37 dBdsx
Resolution: 0.1 dB
Level dBm? Range: +23.8 dBm to -10.5 dBm

Resolution: 0.1 dB

1. The designation dBdsx is a level measurement in dB relative to dsx level, which is 6 V peak-peak. A signal with a
peak-peak level of 6V corresponds to 0 dBdsx.

2. Available only when unframed all ones (AlS) signal is detected.

E1(2M) electrical specifications

Table 121 on page 214 through Table 123 on page 215 list specifications for the E1
(2M) receivers and transmitters.

Receivers

The E1 receivers operate as per ITU-G.703 (11/01). Table 121 lists the receiver speci-
fications.

Table 121 E1 receiver specifications

Parameter Specification

Input One Balanced RJ-48 jack. Two Unbalanced BNC
connectors. Secondary Input may also be used as an
external E1 reference clock:

— 0.5to 3 Vpp square or sine wave, 2.048 MHz,
unbalanced/ 75 Q
Bit rate 2.048 Mbps

Frequency measurement Range: 2.048 MHz +250 ppm
Accuracy: £1.5 ppm, +1 ppm per year aging
Resolution: 1 Hz

Level Measurement (Bal- Level Vp
anced) Range: +7 V to 0.03 V
Accuracy: £0.02 V £ 10%
Resolution: 0.01 V
Level dBnom:
Range: 7.3 dBnom to -37 dBnom
Resolution: 0.1 dB
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Table 121 E1 receiver specifications (Continued)

Parameter Specification

Level Level Vp

Measurement (Unbal- Range: +5V to 0.03 V
anced) Accuracy: £0.02 V = 10%

Resolution: 0.01 V

Level dBnom?:
Range: 7.3 dBnom to -37 dBnom
Resolution: 0.1 dB

1. The designation in dBnom is relative to nominal signal 3 Vp.
2. The designation in dBnom is relative to nominal signal 2.37 Vp.

Table 122 lists the input sensitivity specifications for the E1 receivers.

Table 122 E1 receiver sensitivity specifications

Egzination Impedance Input Range
Bridge (HI-Z) >1200 Q +6 to -35 dBnom due to cable loss
Terminate 120 Q balanced +6 to -35 dBnom due to cable loss
75 Q unbalanced
PMP 120 Q balanced -20 dBnom due to resistive loss in addi-
75 Q unbalanced tion to 0 to -6 dB due to cable loss

Transmitters

The E1 transmitters operate as per ITU-G.703 (11/01). Table 123 describes the trans-
mitter specifications.

Table 123 E1 transmitter specifications

Parameter Specification

Output One balanced RJ-48 jack
Impedance 120 W
One unbalanced BNC connector/ 75 W
Line code HDB3 or AMI
Bit rate Nominal: 2.048 Mbps
Accuracy: £1.5 ppm, +1 ppm per year aging
Frequency offset: 100 ppm in 1 ppm steps

Clock Source — Internal reference clock with accuracy £1.5 ppm,
(Timing) +1 ppm per year aging

— Recovered from Rx1

— External from BITS, SETS, or CLOCK

Frequency 100 ppm in 1 ppm steps
offset
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Table 123 E1 transmitter specifications (Continued)

Parameter Specification

Pulse shape Complies with ITU-T G.703 (11/01)

E3 electrical specifications
Table 124 on page 216 through Table 126 on page 217 list specifications for E3

receivers, transmitters, and frequency and level measurements.

Receiver
Table 124 lists specifications for the E3 receiver.

Table 124 E3 receiver specifications

Parameter Specification

Input One BNC connector

Bit rate 34.368 Mbps

Impedance Nominal 75 Q at 17 MHz, unbalanced

Input Range Term: 0 to 12 dBnom due to cable loss at 17 MHz, from a

nominal signal

PMP: -20 dB due to resistive loss in addition to 0 to 12 dB
due to cable loss at 17 MHz, from a nominal signal

Transmitter

Table 125 lists specifications for the primary E3 transmitter.

Table 125E3 transmitter specifications

Parameter Specification

Output One BNC connector

Bit rate 34.368 Mbps

Line coding HDB3

Clock Source (Timing) — Internal reference clock with accuracy £1.5 ppm,

+1 ppm per year aging
— Recovered from E3 Rx
— External from BITS, SETS, or CLOCK

Frequency offset +100 ppm, in 1 ppm steps
Pulse Nominal 1.0 Vp Complies with ITU-T G.703 (11/01)
Impedance Nominal 75 Q
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Level measurements

Table 126 lists frequency and level measurement specifications for E3.

Table 126 E3 frequency and level measurement specifications

Parameter Specification

Tx and Rx Frequency Range: 34.368 MHz +100 ppm
Accuracy: £1.5 ppm, £1 ppm per year aging
Resolution: 1 Hz or 1 ppm
Level Vp Range: 1.6 Vt0 0.01V
Resolution: 0.01 V
Accuracy: £0.02 V £10%

DS3 electrical specifications
Table 127 on page 217 through Table 129 on page 218 list specifications for DS3
receivers, transmitters, and frequency and level measurements.
Receivers

Table 127 lists specifications for the primary and secondary DS3 receivers.

Table 127 DS3 receiver specifications

Parameter Specification

Input Two BNC connectors

Bit rate 44,736 Mbps

Impedance Nominal 75 Q at 22 MHz unbalanced

Input Range High/Low: 0 to 12 dB due to cable loss at 22 MHz, from a high
signal

DSX/Monitor: -20 dB due to resistive loss in addition to 0 to 9 dB
due to cable loss at 22MHz, from a high signal

Transmitter

Table 128 lists specifications for the primary DS3 transmitter.

Table 128 DS3 transmitter specifications

Parameter Specification
Output One BNC connector
Bit rate 44.736 Mbps

Line coding B3ZS
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Table 128 DS3 transmitter specifications (Continued)

Parameter

Specification

Clock Source
(Timing)

Frequency off-
set

Pulse (high)
Pulse (DSX)
Pulse (low)

Pulse shape

Impedance

Internal reference clock with accuracy £1.5 ppm,
+1 ppm per year aging

— Recovered from DS3 Rx1

— External from BITS, SETS, or CLOCK

+100 ppm, in 1 ppm steps

Nominal 1.15 Vp. Complies with ANSI T1.102-1993 and ITU-T
G.703 (11/01) after passing through 450 feet of RG59B/U cable.

Nominal 0.6 Vp. Complies with ANSI/ T1.102-1993 and ITU-T
G.703 (11/01).

Nominal 0.35 Vp

With output terminated in 75 Q resistive load and DSX selected,
the T-BERD/MTS 8000, 6000A, and 5800 meets ITU-T Rec-
ommendation G.703 (11/01) and ANSI T1.102-1993

Nominal 75 Q

Physical measurements

Table 129 lists frequency, level, and jitter measurement specifications for DS3.

Table 129 DS3 frequency and level measurement specifications

Parameter Specification

Tx and Rx — Range: 44.736 MHz £100 ppm

frequency — Accuracy: £1.5 ppm, £1 ppm per year aging
— Resolution: 1 Hz or 1 ppm

Level Vp — Range: 1.6 Vto 0.01V

— Resolution: 0.01 V
— Accuracy: £0.02 V £10%

STS-1 electrical specifications

Table 130 on page 219 through Table 132 on page 220 list specifications for STS-1
receivers, transmitters, and frequency and level measurements.
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Receivers
Table 130 lists specifications for the primary and secondary STS-1 receivers.

Table 130 STS-1 receiver specifications

Parameter Specification

Input Two BNC connectors

Bit rate 51.84 Mbps

Impedance Nominal 75 Q at 26 MHz unbalanced

Range — High/Low: 0 to 12 dB due to cable loss at 26 MHz, from a
high signal

— DSX/Monitor: -20 dB due to resistive loss in addition to 0
to 9 dB due to cable loss at 26 MHz, from a high signal

Transmitter

Table 131 lists specifications for the primary STS-1 transmitter.

Table 131 STS-1 transmitter specifications

Parameter Specification

Output One BNC connector

Bit rate 51.84 Mbps

Line coding B3ZS

Clock Source — Internal reference clock with accuracy £1.5 ppm,
(Timing) 11 ppm per year aging

— Recovered from STS-1 Rx1
— External from BITS, SETS, or CLOCK

Frequency offset 50 ppm, in 1 ppm steps

Pulse (high) Nominal 1.15 Vp. Complies with ANSI T1.102-1993 and ITU-T
G.703 (11/01) after passing through 450 feet of RG59B/U
cable.

Pulse (DSX) Nominal 0.6 Vp. Complies with ANSI T1.102-1993 and ITU-T
G.703 (11/01).

Pulse (low) Nominal 0.32 Vp

Pulse shape With output terminated in 75 Q resistive load and DSX

selected, the Dual Module Carrier, Transport Module, and
MSAM meets ITU-T Recommendation G.703 (11/01) and
ANSI T1.102-1993

Impedance Nominal 75 Q
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Physical measurements

Table 132 lists frequency and level measurement specifications for STS-1.

Table 132STS-1 frequency and level measurement specifications

Parameter Specification

Tx and Rx frequency  Range: 51.84 MHz +50 ppm
Accuracy: £1.5 ppm, £1 ppm per year aging
Resolution: 1 Hz or 1 ppm
Level Vp Range: 1.6 Vt0 0.01V
Resolution: 0.01 V
Accuracy: £0.02 V £10%

E4 electrical specifications
Table 133 on page 220 through Table 135 on page 221 list specifications for E4

receivers, transmitters, and frequency and level measurements.

Receiver
Table 133 lists specifications for the E4 receiver.

Table 133 E4 receiver specifications

Parameter Specification

Input One BNC connector

Bit rate 139.264 Mbps

Impedance Nominal 75 Q at 70 MHz unbalanced

Range — Term: 0 to 12 dB due to cable loss at 70 MHz, from a

nominal signal

— PMP: -20 dB due to resistive loss in addition to 0 to 12 dB
due to cable loss at 70 MHz, from a nominal signal

Transmitter

Table 134 lists specifications for the primary E4 transmitter.

Table 134 E4 transmitter specifications

Parameter Specification
Output One BNC connector
Bit rate 139.264 Mbps

Line coding CMI

T-BERD/MTS/SC Getting Started Guide
Page 220 22046537, Rev. 016 March 2018



Appendix A Specifications
MSAM specifications

Table 134 E4 transmitter specifications (Continued)

Parameter Specification
Tx clock — Internal reference clock with accuracy £1.5 ppm,
(Timing) +1 ppm per year aging

— Recovered from E4 Rx
— External from BITS, SETS, or CLOCK

Frequency offset +50 ppm, in 1 ppm steps
Pulse Nominal 1.0 Vpp Complies with ITU-T G.703 (11/01)
Impedance Nominal 75 Q

Physical measurements

Table 135 lists frequency and level measurement specifications for E4.

Table 135E4 frequency and level measurement specifications

Parameter Specification

Tx and Rx Fre- — Range: 139.264 MHz £100 ppm

quency — Accuracy: £1.5 ppm, £1 ppm per year aging
— Resolution: 1 Hz, or 1 ppm

Level Vpp — Range: 1.2Vt 0.01V

— Resolution: 0.01 V
— Accuracy: £0.02 V £10%

STM-1 electrical specifications
Table 136 on page 221 through Table 138 on page 222 list specifications for STM-1

receivers, transmitters, and frequency and level measurements.

Receiver

Table 136 lists specifications for the STM-1 receiver.

Table 136 STM-1 receiver specifications

Parameter Specification

Input One BNC connector

Bit rate 155.52 Mbps

Impedance Nominal 75 Q at 78 MHz unbalanced

Range Term: 0 to 12.7 dB due to cable loss at 78 MHz, from a

nominal signal

PMP: -20 dB due to resistive loss in addition to 0 to 12.7 dB
due to cable loss at 78 MHz, from a nominal signal
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Transmitter
Table 137 lists specifications for the STM-1 transmitter.

Table 137 STM-1 transmitter specifications

Parameter Specification

Output One BNC connector

Bit rate 155.52 Mbps

Line coding CMI

Tx clock — Internal reference clock with accuracy +1.5 ppm,
(Timing) 11 ppm per year aging

— Recovered from Rx1
— External from BITS, SETS, or CLOCK

Frequency offset 50 ppm, in 1 ppm steps
Pulse Nominal 1.0 Vpp Complies with ITU-T G.703 (11/01)
Impedance Nominal 75 Q

Physical measurements
Table 138 lists frequency and level measurement specifications for STM-1.

Table 138 STM-1 frequency and level measurement specifications

Parameter Specification

Tx and Rx — Range: 155.52 MHz £50 ppm

Frequency — Accuracy: £1.5 ppm, £1 ppm per year aging
— Resolution: 1 Hz or 1 ppm

Level Vpp — Range: 1.2V 1t00.01V

— Resolution: 0.01 V
— Accuracy: £+0.02 V £10%

10/100/1000Base T electrical specifications

The Transport Module provides up to two connectors with interfaces that support rates
of 10Base-T, 100Base-T, and 1000Base-T. Each connector is fully compliant with IEEE
802.3, IEEE 802.3u, and IEEE 802.3ab.

Optical interface specifications

Table 139 describes the optical interface specifications for the internal SONET, SDH,
and Ethernet optical connectors for non-jitter and wander applications.
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If your unit is equipped with SFP interfaces, the interfaces comply with INF-8074i, Rev
1.0 published on May 12, 2001. For SFP specifications refer to the specifications

provided by the manufacturer.

Table 139 Optical interface specifications (Non-Jitter/Wander)

Item

Description

Optical connector types1
Wavelength
Fiber mode compatibility

Transmit level
1550 nm, 2.5 Gbps and lower

1310 nm, 2.5 Gbps option
1310 nm, 622 Mbps option
1310 nm, 1 GigE option
850 nm, 1 GigE option

Transmit level for 10Gbps
1550 nm

1310 nm

850 nm

Eye diagram, 1310 nm, 1550 nm

850 nm, 1310 nm

Clock frequency accuracy
Receive level range
2.5 Gbps option
155 Mbps option
622 Mbps option
GigE only ports
1310 nm
850 nm

Receive level range 10 Gbps
1310 nm only option

1550 nm intermediate reach (IR)
option
1550 nm long reach (LR) option

850 nm
Transmitter frequency offset

Frequency measurement accu-
racy

Jitter output

FC, SC, ST, or LC
850, 1310, or 1550 nm

1310 and 1550 nm — singlemode fiber
850 nm — multimode fiber

0to -6.5dBm
+3 to -3.5 dBm
-8 t0 -16.5 dBm
-3t0-13 dBm
-3to-13 dBm

+4 to -3 dBm
-1to0 -7 dBm
Per IEEE std 802.3ae 2002 for 10GigE

Per Telcordia GR-253-CORE Issue 4-2005
ITU-T REC. G.957
Per IEEE std 802.3ae 2002

+1.5 ppm £1 ppm per year aging

-9to -27 dBm
-8 to -34 dBm
-8 to -28 dBm

-3t0-19dBm
0to-17 dBm

-1 to -11 dBm
-1to -14 dBm

-9 to -23 at 9.95 Gbps
-9 to0 -22 at 11.1 Gbps
-1to -11 dBm

150 ppm from the nominal rate, in 1 ppm
steps

1.5 ppm %1 ppm per year aging

Per Telcordia GR-253-CORE Issue 4-2005
ITU-T G.825, IEEE std 802.3ae 2002
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Table 139 Optical interface specifications (Non-Jitter/Wander) (Continued)

Item Description

Receiver shutdown?

2.5 Gbps option -5.9.dBm

10 Gbps long reach -5.9 dBm

Reflectance Per Telcordia GR-253-CORE Issue 4-2005

Level measurement range

2.5 Gbps -6to-30 dBm

622 Mbps -5t0 -31 dBm

155 Mbps -5t0-31 dBm

Level measurement range for

10 Gbps

1310 nm and 1550 nm +0 to -17 dBm
IR RX -6 to -20 dBm
LR RX +0 to -14 dbm
850 nm

Level measurement accuracy +3 dB

Level measurement resolution 0.1dB

APS

resolution 1ms

accuracy 1ms

RTD

resolution 1us

accuracy 2us

1. Remove the connector to clean the optical fiber.
2. Do not apply a greater than —8 dBm optical-level signal to the long reach receiver on the Dual Module Carrier, and
MSAM. Damage to the receiver may occur.

Jitter and Wander specifications

Refer to the following sections for jitter and wander specifications for the T-BERD / MTS
5800 and MSAM:

*  “Electrical jitter and wander specifications” on page 224
* “Interface specifications (Jitter and Wander applications)” on page 230
e  “Optical jitter and wander specifications” on page 231

Electrical jitter and wander specifications

This section provides electrical jitter and wander specifications for the T-BERD / MTS
5800 and MSAM. For specifications, see:

e “Standards” on page 225
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«  ‘“Jitter generator” on page 225

« ‘“Jitter analyzer” on page 225

*  “Automatic jitter measurements” on page 227
*  “Wander generator” on page 228

*  “Wander measurement” on page 229

*  “Memory requirements” on page 230

Standards

Jitter and wander are generated and analyzed in accordance with the following stan-
dards:

* |TU-T Recommendations G.823, G.825, O.172 (04/2005)
e Telcordia GR-499-CORE Issue 2-1998, GR-253-CORE Issue 4-2005
e ANSI Standards T1.102 - 1993, Table 9, T1.404-1994 section 5.10

Jitter generator

Meets or exceeds the requirements stated in ITU-T Recommendation O.172 (04/2005).

Modulation specifications

Table 140 provides modulation specifications for the electrical jitter generator.

Table 140Electrical jitter generator modulation specifications

Item Description
Jitter modulation signal Sine wave

Jitter amplitude Per ITU-T O.172
Step width 0.001 UI
Modulation frequency accuracy +0.1%

The settling time for the changes in amplitude is less than 30 seconds.

Error limits
Error limits conform to the requirements stated in ITU-T Recommendation O.172 (04/

2005).

Jitter analyzer

Meets or exceeds the requirements of ITU-T Recommendation O.172 (04/2005).
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Bit rate

Table 141 describes the bit rate specifications for the electrical jitter analyzer.

Table 141 Bit rate of the electrical jitter analyzer

Item Description

Bit rate 1.544 Mbps, 44.736 Mbps, 2.048 Mbps, 34.368 Mbps,
51.84 Mbps, 139.264 Mbps, 155.520 Mbps

Permitted offset + 1000 ppm

Measuring ranges

Table 142 provides measuring ranges for the electrical jitter analyzer.

Table 142Electrical jitter analyzer measuring ranges

Item Range/Resolution
Peak-Peak 0 to 4,000 Ulpp/1 mUlIpp
RMS 0 to 2,000 UI/1 mUI

Measurement filters - Standard range

Table 143 describes the standard range and properties for the measurement filters. The
default filter settings are per ITU-T Recommendation O.172 (04/2005).

Table 143 Standard ranges and properties for the measurement filters

Item Description

High-pass filters' 2 Hz, 4 Hz, 10 Hz, 20Hz, 40 Hz, 80 Hz, 100Hz,
200Hz, 400 Hz, 500 Hz, 700 Hz, 1 kHz, 3 kHz,
5 kHz, 8 kHz, 10 kHz, 12 kHz, 18 kHz, 20 kHz,
30 kHz, 65 kHz, 80 kHz, 250 kHz

High-pass filter characteristics 15t order (to ITU-T 0.172)

Low-pass filter 40 kHz, 60 kHz, 100 kHz, 400 kHz, 800 kHz, 1.3
MHz, 3.5 MHz

Low-pass filter characteristics 3" order Butterworth
(refer to ITU-T O.172)

Filter properties:
-3 dB cut-off frequency toler- fc + 10%
ance

Maximum attenuation at least 60 dB/decade

1. Filter availability depends on the electrical input rate.

Results display

Positive and negative jitter amplitudes are measured.

T-BERD/MTS/SC Getting Started Guide
Page 226 22046537, Rev. 016 March 2018



Appendix A Specifications
Jitter and Wander specifications

Current values

Table 144 describes the ranges for the current values. The values are displayed contin-
uously, or they appear in a graph.

Table 144 Ranges for the current values

Item Description
Standard range

— Jitter peak-peak — 4000 Ulpp
— Jitter +peak/-peak — 2000 Ulp

Display resolution

Table 145 describes the resolution of the current and maximum values for displayed
and logged results.

Table 145Display resolution for the maximum values

Item Description
Standard range 0.001 Ulpp

Error limits for displayed jitter

The error limits for displayed jitter meet the requirements of ITU-T Recommendation
0.172 (04/2005).

The stated error limits apply under the following conditions:

¢  Sine wave modulation

*  Structured test signals (for STM-1e as described in | TU-T Recommendation
0.172 (04/2005))

e  Standard filter selections

RMS jitter - Range and resolution

Refer to Table 142 on page 226 for the RMS range and resolution. Measurement accu-
racy is per ITU-T Recommendation O.172 (04/2005).

Automatic jitter measurements

This section provides specifications for automatic jitter measurements.

Maximum Tolerable Jitter (MT))

A group of up to 20 user-specified jitter frequencies (scan frequencies) can be defined.
A set of pre-defined masks per applicable standards is also provided.
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Fast Maximum Tolerable Jitter (Fast MT))

A group of up to 20 user-specified frequencies (scan frequencies) can be defined. A set
of pre-defined masks per applicable standards is also provided.

Jitter Transfer Function (JTF) measurement

A group of up to 20 user-specified jitter frequencies (scan frequencies) can be defined.
A set of pre-defined masks per applicable standards is also provided.

Table 146 describes the JTF measurement specifications.

Table 146 JTF measurement specifications

Item Description

Settling time 0.1 t0 999.9 seconds
RMS integration period 5 seconds

Recovery time 0.1 t0 999.9 seconds
Filter bandwidth 10 Hz

(band-pass, -3 dB)

Measurement range -60 dB to -50 dB

Measurement error

According to ITU-T Recommendations G.783 and G.8251.

Wander generator

This section provides specifications for the electrical wander generator.

Bit rate

Table 147 provides bit rate specifications for the electrical wander generator.

Table 147 Bit rate specifications

Item Description

Bit rate 1.544 Mbps, 44.736 Mbps, 2.048 Mbps, 34.368 Mbps,
51.89 Mbps, 139.264 Mbps, 155.520 Mbps

Maximum offset + 50 ppm

Modulation source internal
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Modulation specifications

Table 148 describes the modulation specifications for the electrical wander generator.

Table 148 Modulation specifications

Item Description
Jitter modulation signal sinusoidal
Frequency range 10 uHz to 100 MHz

Amplitude range at 155.52 Mbps 0.01 Ul to 3600 UI

Error limits

The error limits conform to the requirements of ITU-T Recommendation O.172 (04/
2005), with a modulation frequency accuracy of £ 0.1%.

Synchronization

When generating wander, the device must be synchronized with an external timing
source. For more details, see “Reference clock” on page 229.

Wander measurement

This section provides specifications for wander measurements.

Reference clock

Table 149 lists the wander clock frequency and input level specifications.|

Table 149 Wander clock frequency and input level specifications

Permissible offset 1+ 1000 ppm

Wander transfer bandwidth Driven by the low pass filter as specified in
Table 150 on page 229.

Measurement range

The upper limit of the wander frequency range is set by a first-order low-pass filter. The
sample rate is selected automatically to correspond with the selected low-pass filter.
Table 150 lists the sample rates for various low pass filters.

Table 150 Sample rates for various low pass filters

Low pass filter/fc Sample rate
0.1 Hz 1/s

10 Hz 30/s

20 Hz 60/s

100 Hz 1000/s

T-BERD/MTS/SC Getting Started Guide
March 2018 22046537, Rev. 016 Page 229



Appendix A Specifications
Jitter and Wander specifications

Measurement filters

Measurement filters are defined per ITU-T Recommendation O.172 (04/2005).

Memory requirements

Table 151 describes the memory requirements (storage requirements) for the base unit
when measuring wander.

Table 151 Memory requirements for wander measurements

Sample rate Required flash/hard disk space
1/second approximately 150 KB/hour
30/second approximately 5 MB/hour
60/second approximately 9.0 MB/hour
1000/second’ approximately 150 MB/hour

1. Supported on MSAM only.

The maximum wander measurement time is only limited by the available hard disk
space. However, you can only perform wander analysis (MTIE/TDEV) for the first 8.64
million samples of the measurement.

Interface specifications (Jitter and Wander applications)

Table 152 describes the specifications for the optical connectors when running jitter and
wander applications. The interfaces meet the specifications stated in /ITU-T Recom-
mendation G.957/GR-253.

Table 152 Optical interface specifications (Jitter and Wander applications)

Item Description
Optical connector types1 FC, SC, ST, or LC
Wavelength 1310 and 1550 nm
Line rates — 155 Mbps
— 622 Mbps
— 2488 Mbps
— 2666 Mbps
Line code Scrambled NRZ
Transmitter specifications
Transmit level -2 to +3 dBm
Fiber mode compatibility 1310 and 1550 nm — singlemode fiber
Frequency offset +50 ppm from the nominal rate,

in 1 ppm steps
Frequency accuracy +1,5 ppm +1 ppm per year aging
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Table 152 Optical interface specifications (Jitter and Wander applications) (Continued)

Item

Description

Synchronization

Receiver specifications
Wavelength range

Rx offset acceptance
Sensitivity

Maximum input power
(destructive)

Fiber mode compatibility

Optical level measurement

Level measurement accuracy

Level measurement resolu-
tion

See the Reference Clock Requirements published
in the testing guide that shipped with your unit.

1260 to 1360 nm
1430 to 1580 nm
+100 ppm
622/2488/2666 Mbps
— -81t0-28dBm

155 Mbps

— -81t0-34 dBm

+0 dBm

OC3/0C12 connector
— multimode fiber
— singlemode fiber
0OC48/0TU1 connector
— singlemode fiber

622/2488/2666 Mbps
— -81t0-28 dBm

155 Mbps

— -8t0-34 dBm

+3 dB

0.1dB

1. Remove the connector to clean the optical fiber.

Optical jitter and wander specifications

This section provides jitter and wander specifications for the MSAM:

“Standards” on page 232

“Jitter generator” on page 232

“Jitter analyzer” on page 232

“Automatic jitter measurements” on page 236

“Wander generator” on page 236

“Wander measurement” on page 237

“Memory requirements” on page 239
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Standards

Optical jitter and wander are generated and analyzed in accordance with the following
standards:

e |TU-T Recommendations G.825, G.8251, O.172 (04/2005) and O.173 (03/2003)
. Telcordia GR-253-CORE Issue 4-2005
e ANSI/ Standards T1.101, T1.105.03

Jitter generator

The jitter generator meets or exceeds the requirements of ITU-T Recommendation
0.172 (04/2005) and O.173 (03/2003).

Internal modulation source

Table 153 provides modulation specifications for the optical jitter generator.

Table 153 Modulation specifications

Item Optical

Jitter modulation signal Sine wave
Jitter amplitude up to 800 Ulpp
Step size 0.001 UI

The settling time for the changes in amplitude is less than two seconds.

Error limits

Error limits conform to the requirements of ITU-T Recommendations O.172 (04/2005)
and 0.173 (03/2003).

Intrinsic jitter

The maximum output jitter of the intrinsic jitter for a jitter amplitude setting of 0 Ul is <
0.04 Ulpp. Wideband is assumed.

Jitter analyzer

Meets or exceeds the requirements of ITU-T Recommendation O.172 (04/2005) and
0.173 (03/2003).
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Measuring ranges

Table 154 describes the measuring ranges for the optical jitter analyzer.

Table 154 Measuring ranges

Item Range/Resolution
Standard
— Peak-Peak 0 to 50 Ulpp/1 mUIpp
- RMS 0 to 25 Ul/0.1 mUI
Extended
— Peak-Peak
155M 0 to 50 Ulpp/100 mUIpp
622M 0 to 200 Ulpp/100 mUIpp
2.52.7G 0 to 800 Ulpp/100 mUlpp
- RMS
;ggm 0 to 25 UI/10 mUI
25276 0 to 100 UI/10 mUI

0 to 400 UI/10 mUlI

Measurement filters

This section provides specifications for the measurement filters.

Standard range

Table 155 describes the standard range and properties for the measurement filters.

Table 155 Standard ranges and properties for the measurement filters

Item

Description

High-pass filters

High-pass filter charac-
teristics

Low-pass filter

Low-pass filter charac-
teristics

Filter properties:
-3 dB cut-off frequency
tolerance

Maximum attenuation

500 Hz, 1 kHz, 5 kHz, 12 kHz, 65 kHz, 250 kHz, 1 MHz
18t order (to ITU-T 0.172/0.173)

1.3 MHz, 5 MHz, 20 MHz

3™ order Butterworth
(to ITU-T ©.172/0.173)

fc +10%

at least 60 dB

Default filter settings are per ITU-T Recommendations O.172 (04/2005) and

0.173 (03/2003).
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Extended range

Table 156 provides the extended range for the measurement filters.

Table 156 Extended ranges for measurement filters

Item Description

High-pass filter characteristics  typically 25 Hz
(-3 dB cut-off frequency)

Low-pass filter typically 400 kHz

Results display

Positive and negative jitter amplitudes are measured.

Current and maximum values

The current and maximum values are displayed continuously or shown as a graph.
Table 157 describes the ranges for the current and maximum values.

Table 157 Ranges for the current and maximum values

Item Description

Standard range
— Jitter peak-peak 50 Ulpp
— Jitter +peak/-peak - 25 Ulp

Extended range
— Jitter peak-peak 800 Ulpp
— Jitter +peak/-peak — 400 Ulp

Resolution

Table 158 describes the resolution for the current and maximum values, display and
logged results.

Table 158 Resolution for current and maximum values

Item Description
Standard range 0.001 Ulpp
Extended range 0.1 Ulpp

Error limits for jitter measurement

The error limits for displayed jitter meet the requirements of ITU-T Recommendation
0.172 (04/2005) and O.173 (03/2003).

The stated error limits apply under the following conditions:

*  Optical input level in the range -10 dBm to -12 dBm (scrambled NRZ signal code)
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e Structured test signals (for SDH as described in ITU-T Recommendation 0.172)
*  Sine wave modulation
» Standard filters: Highband

Measurement error

The stated measurement error applies without restriction to standard range, for values
>25 Ulp in extended range.

*  Maximum measurement error: £ R % of reading + W

The value for W (fixed error) is taken from Table 159. The value for R (variable error)
can be taken from ITU-T Recommendations O.172 (04/2005) and O.173 (03/2003) as
applicable.

Table 159 W (fixed error)

Range Wide-band Filter Extended-band Filter
W in Ulpp W in Ulpp
Standard range 0.035" 0.5

1. Mapping SDH VC-4/SONET STS-1, payload pattern PRBS31, environmental temperature +20°C to +30°C.

RMS jitter

This section describes the RMS jitter specifications.

Range and resolution

Table 160 describes the RMS range and resolution.

Table 160 RMS range and resolution

(peak-peak) Standard range Extended range
RMS range 0 to 25 Ul 0 to 400 UI
Resolution 0.0001 UI 0.01 Ul

Measurement accuracy

Table 161 describes the RMS jitter measurement accuracy.

Table 161 RMS jitter measurement accuracy

Item Description

Standard range + R% of measured value + 0.003 Ul
Extended range + R% of measured value + 0.05 Ul
Integration time 1 second

1. The value R (variable error) is taken from ITU-T Recommendation O.172 (04/2005) and O.173 (03/2003) as appli-
cable.
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Automatic jitter measurements

This section provides specifications for automatic jitter measurements.

Maximum Tolerable Jitter (MT)J)

A group of up to 20 user-specified jitter frequencies (scan frequencies) can be defined.
A set of pre-defined masks per applicable standards is also provided.

Fast Maximum Tolerable Jitter (Fast MT)J)

A group of up 20 user-specified frequencies (scan frequencies) can be defined. A set
of pre-defined masks per applicable standards is also provided.

Jitter Transfer Function (JTF) measurement

A group of up to 20 user-specified jitter frequencies (scan frequencies) can be defined. A
set of pre-defined masks per applicable standards is also provided.

Table 162 describes the JTF measurement specifications.

Table 162 JJTF measurement specifications

Item Description

TX jitter settings see Table 140 on page 225
Settling time 0.1 to 999.9 seconds

RMS integration period 5 seconds

Recovery time 0.1 t0 999.9 seconds

Filter bandwidth 10 Hz

(band-pass, -3 dB)

Measurement error

Per ITU-T Recommendations G.783 and G.8251.

Wander generator

This section provides specifications for the optical wander generator.

Modulation

Table 163 provides the modulation specifications for the optical wander generator.

Table 163 Internal modulation source specifications

Item Description

Jitter modulation signal sinusoidal
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Table 163 Internal modulation source specifications (Continued)

Item Description
Frequency range 10 uHz to 10 Hz
Amplitude range at 2.5/2.7G 0.1 Ul to 100000UI
Modulation frequency accu- £ 0.1%
racy

Error limits

The error limits conform to the requirements of ITU-T Recommendations O.172 (04/
2005) and O.173 (03/2003).

Synchronization
When generating wander, the Dual Module Carrier, Transport Module, and MSAM must

be synchronized to an external timing source. For more details, see “Reference clock”
on page 229.

Wander measurement

This section provides specifications when measuring wander on an optical circuit.

Reference clock

See to “Reference clock” on page 229 for reference clock requirements.

Table 164 Wander clock frequency specifications

Item Description
Permissible offset + 20 ppm
Wander transfer bandwidth approximately 1 Hz

TIE measurement

Per ITU-T Recommendation O.172 (04/2005) and O.173 (03/2003), TIE can be inter-
preted as the time difference between the signal you are measuring and the reference
clock. This measurement is used to calculate other results, such as MTIE and TDEV.
To ensure accuracy of the TIE measurement, warm-up the Dual Module Carrier,
Transport Module, and MSAM for at least 30 minutes and ensure there is no change in
ambient temperature exceeding 5° Celsius.
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Measurement range

The upper limit of the wander frequency range is set by a first-order low-pass filter. The
sample rate is selected automatically to correspond with the selected low-pass filter.
Table 165 lists the sample rates for various low pass filters.

Table 165 Wander clock frequency specifications

Maximum measurable rate

Low pass filter/fc Sample rate of phase change at 2.5/2.7G
0.1 Hz 1/s 250000 Ul/s
10 Hz 30/s 250000 Ul/s
20 Hz 60/s 250000 Ul/s
100 Hz 1000/s 300000 Ul/s

Measurement filters

This section provides specifications for the measurement filters.
Table 166 describes the measurement filters.

Table 166 Measurement filters

Item Description
Low-pass filter 0.1, 10, 20, 100 Hz
Low-pass filter characteristics 18t order (to ITU-T 0.172/0.173)

Filter properties:
-3 dB cut-off frequency tolerance  fc + 10%
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Table 166 Measurement filters (Continued)

Item Description
Pass band ripple (referred to <+0.2dB
0.1 Hz)

Maximum attenuation >30dB

Default filter settings are per ITU-T Recommendations O.172 (04/2005) and O.173 (03/
2003).

Memory requirements

See “Memory requirements” on page 230.

CSAM specifications

Physical Specifications

The physical specifications for CSAM are detailed below:.

Table 167 CSAM physical specifications

Item Description

Height 1.25 inches / 3.17 cm
Width 4.87 inches / 12.38 cm
Depth 9.12 inches / 23.49 cm
Weight (CSAM only) 1.0 Ibs / 0.45 kg

Combined Weight (CSAM, 6000Av2 7.6 lbs/3.4kg
Base Unit, one CFP2)

Power Supply Specifications

The specifications for the Power Supply for CSAM are detailed in Table 168 and
Table 169.

Table 168 CSAM in 6000Av2

Item 220W power supply
Input, nominal range 100-240 V. 50-60 Hz, 2A
Maximum power draw 150W
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Table 169 CSAM in 8000v2

Item 220W power supply
Input, nominal range 100-240 V. 50-60 Hz, 0.4A
Output 20V, 11A, 220W max power

Battery Specifications

To ensure the maximum operating time is obtained while testing using the CSAM, if you
are not using the power adapter, be certain to install two batteries in the 6000Av2 or
8000v2. Different tests deplete the batteries at different rates; therefore battery life can
not be guaranteed for any specific length of time. Always use the power supply when
multiple modules are attached to an 8000v2.

Table 170 Battery Specifications

Item Specification
Battery Life in 6000Av2 45 minutes minimum
Battery Life in 8000Av2 1 hour 30 minutes minimum

(one CSAM in DMCv2)

Optical Specifications

The CSAM has three physical optical ports — CFP2, QSFP+, and SFP+.

CFP2 Interface

The optical specifications for the CFP2 module interface in the CSAM are detailed in
Table 171.

Table 171 CFP Optical Module Interface Specifications

Module Specification

CFP2, hot-pluggable compliant with CFP MSA, CFP2 Hardware Specification
Rev 1.0, E 802.3ba

QSFP+ Interface

The optical specifications for the QSFP+ interface in the CSAM are detailed in
Table 172.

Table 172 QSFP+ Optical Module Interface Specifications

Module Specification
QSFP+, hot-pluggable  compliant with QSFP+ MSA(SFF-8436), IEEE P802.3ba
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SFP+ Interface
The optical specifications for the SFP+ interface in the CSAM are detailed in Table 173.
Table 173 SFP+ Optical Module Interface Specifications

Module Specification
SFP/SFP+, hot-pluggable compliant with MSA(SFF-8436), IEEE P802.3ba

DMC specifications

Refer to the following sections for specifications for the DMC:

*  “Physical specifications” on page 241
*  “Power supply specifications” on page 241
*  “Battery specifications” on page 242

Physical specifications

The physical characteristics for the DMC are described in Table 174.
Table 174 Module physical specifications

Item Description

Height 2.75inches /7 cm
Width 12 inches / 30.48 cm
Depth 9.74 inches / 24.76 cm
Weight DMC Only:

— 4911bs/2.22 kg

Combined (DMC, two MSAMSs, 8000 base unit, two SFP PIMs,
and two XFP PIMs):

— 17.281bs /7.83 kg

Power supply specifications

Table 175 describes the specifications for the 150W power supply.

Table 175Power supply specifications

Item 150W power supply
Input, nominal range 100-240 V. 50-60 Hz, 2A
Maximum power draw 150 watts
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Battery specifications

To ensure the maximum operating time is obtained while testing using the DMC and
MSAMs, if you are not using the power adapter, be certain to install two batteries in the
battery module. Different tests deplete the batteries at different rates; therefore, when
performing more than one BER test, battery life can not be guaranteed for any specific
length of time. Do not power the unit using batteries if multiple DMCs or application
modules are attached. For detailed battery information, refer to the 8000 Base Unit
User Manual.

Transceiver and adapter specifications

For detailed transceiver and adapter specifications, refer to your SFP, SFP+, XFP,
QSFP+, or CFP manufacturer’s web site. Summarized information for inserted trans-
ceivers (such as the model number, supported wavelength, and supported interface) is
provided on the user interface (GUI).

If you are not certain whether you are using a Viavi recommended transceiver, contact
your local Viavi representative, or review the list of Viavi Recommended Optics that
shipped with the transceiver.

Environmental specifications

Refer to the following sections for environmental specifications:

* “T-BERD /MTS 5800 and SC 4800 environmental specifications” on page 242
« “MSAM environmental specifications” on page 243

T-BERD / MTS 5800 and SC 4800 environmental specifications

Table 176 lists the environmental characteristics for the T-BERD / MTS 5800 and SC
4800. Operating temperature and humidity are provided below; for storage temperature
and humidity, see “Storing the instrument” on page 262.

Table 176 T-BERD / MTS 5800 and SC 4800 Environmental specifications

Item 5800 v1 & v2, 5882, 4800/ 5800-100G
4800P
Operating 32°F to 122°F (0°C to +50°C) Dual 100GE: 0°C to +40°C;
Temperature Note: For maximum battery Dual 10GE: 0°C to +50°C:
capacity and runtime, limit ’
charge and discharge tem-
perature of the battery to
40°C (104°F).
Operating 10% to 90% relative humidity,  the same
Humidity non-condensing
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Table 176 T-BERD / MTS 5800 and SC 4800 Environmental specifications (Continued)

ltem 5800 v1 & v2, 5882, 4800/ 5800-100G
4800P

Shock/Drop/Vibe  Shock - per IEC 68-2-27 and  the same
68-2-29 Ed. 2.0

Drop - per IEC 721-3-7 2nd
Ed. /IEC 61010-1

Vibration -per IEC 68-2-6 and
MIL-PRF-28800F (Class 2)

MSAM environmental specifications

Table 177 lists the environmental characteristics for the assembled instrument. Oper-
ating temperature and humidity are provided below; for storage temperature and
humidity, see “Storing the instrument” on page 262.

Table 177 MSAM Environmental specifications

Item Model Description

Operating MSAMv2  All applications

Temperature 32°F to 104°F (0°C to +40°C)
MSAM One or two applications at line rates less than
vi 10 Gbps:

— 32°F to 104°F (0°C to +40°C)

One 10 Gbps application, with a second appli-
cation at a line rate less than 10 Gbps:

— 32°F to 95°F (0°C to +35°C)
OTU-1 applications

— 32°F to 104°F (0°C to +40°C)
OTU-2 applications

— 32°F to 95°F (0°C to +35°C)

Operating Humidity 5% to 95% relative humidity, non-condensing
Shock/drop height As published in the 6000A Base Unit User
Manual
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Maintenance and Troubleshooting

This chapter describes how to maintain your unit and identify and correct issues related
to the T-BERD / MTS 5800 family, Transport Module, CSAM, and MSAM. Topics
discussed in this chapter include the following:

“Maintaining the T-BERD/MTS 5800 and SC 4800 batteries” on page 245
“About troubleshooting” on page 253

“Assembly and setup” on page 254

“Operating the instrument” on page 255

“Performing tests” on page 257

“Maintaining your instrument” on page 259

“Battery communication” on page 260

Maintaining the T-BERD/MTS 5800 and SC 4800 batteries

This section provides guidelines for maintaining the T-BERD / MTS 5800’s and SC
4800'’s rechargeable lithium-ion battery. For instructions on maintaining the MSAM, or
CSAM batteries, refer to the supporting 8000 Base Unit User Manual or 6000A Base
Unit User Manual.

Guidelines

To prolong the life span of the battery, follow the guidelines below:

WARNING: Danger of extreme heat, fire, or explosion if battery is tampered with.

Use only Viavi approved Li-ION battery. Dispose of used batteries according to
the manufacturer's instructions.

Use the AC power adapter to power up the instrument the first time you use it or
after prolonged storage (see “Verifying that you have the correct adapter” on
page 56). For optimal battery gauge accuracy, run the battery through a complete

charge cycle by fully charging the battery, then fully discharging and recharging
the battery.
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Constantly holding a Li-ION battery at full charge can shorten the battery lifetime.
Do not keep the AC power adapter connected for long durations without occasion-
ally discharging the battery. Disconnect the adapter about once a month and
operate the instrument using battery power to discharge the battery to approxi-
mately 20%-40%. If you have a spare battery, rotate the batteries periodically (for
example, once a month) so that they are used on a regular basis.

The charger will not charge the battery when the battery temperature is above or
below the battery’s charging temperature specification.

Store the instrument and battery in a cool, dry, and clean environment. Do not
leave the battery in a car or truck, particularly during extremely hot or cold
weather.

When storing the instrument for extended periods of time, it is best to keep the
battery capacity in the 20% to 80% range. The battery will discharge slowly over
time when the instrument is off, so it is recommended to occasionally check that
the battery is not approaching full depletion.

See “Checking the battery” on page 72 for information on checking the battery status.

Recharging the battery

The T-BERD/MTS 8000, 6000A, and 5800, and SC 4800 will typically run between two
and five hours on a fully charged battery, depending on the type of tests you are
conducting. Some applications or modes require more power than others, so run time
will vary.

When the battery level is at 25 percent or less, the battery should be recharged.

>

NOTE:

You can test a circuit and recharge the battery at the same time. If you do not
want to interrupt the current test, you may leave the power on and connect the
AC power adapter. You can also charge the battery while it is removed from
the T-BERD/MTS 8000, 6000A, and 5800.

:- WARNING: ELECTRICAL SHOCK

Electrical shock may result in serious injury or death. Be sure the AC power
adapter is connected to the correct voltage mains. Do not use outdoors or in
wet locations. Use only the AC power adapter supplied with the instrument.

To charge the battery

1

Connect one end of the AC power adapter to the power jack on the right side
panel.

Connect the other end of the AC power adapter to an AC power supply.
Let the instrument charge for up to 7 hours depending on the battery charge level.

The power button is amber when the battery is charging.

The battery icon in the title bar turns green when the charge is above the “low
battery” threshold.
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Charging the battery is complete.

Replacing the T-BERD / MTS 5800 and SC 4800 batteries

This section discusses replacing the battery ina T-BERD / MTS 5800 and SC 4800. For
instructions on replacing the MSAM, or CSAM batteries, refer to the supporting 8000
Base Unit User Manual or 6000A Base Unit User Manual.

The battery compartment is located on the back of the unit.

Before replacing the battery, verify that it is a Viavi-supplied replacement battery pack.

CAUTION: INSTRUMENT DAMAGE

Failure to turn the power off before removing the batteries from the instru-
ment could damage internal components and/or corrupt the software. Always
power down the unit before removing the battery pack.

To replace the battery pack

1  Turn the power off.
2 Turn the instrument over, resting on the face.

3 Using a Phillips screw driver, remove the four screws from the battery compart-
ment door.

4 Remove the battery compartment door.

Pull the battery out of the battery compartment and disengage the battery cable's
locking connector from the mating connector on the right side.

6 Engage the locking connector of the new batter with the mating connector on the
right side and then place the new battery into the battery compartment.

7 Replace the battery compartment door.

8 Tighten the four screws until hand tight.

Replacing the battery pack is complete.

Calibrating the T-BERD / MTS 5800 and SC 4800 touchscreen

This section discusses calibrating the touchscreen on a T-BERD / MTS 5800 and SC
4800. For instructions on calibrating the MSAM or CSAM touchscreen, refer to the
supporting 8000 Base Unit User Manual or 6000A Base Unit User Manual.

If, after a period of time, you observe issues with your touchscreen (for example, the
arrow does not appear in the correct location after you touch the screen, or the top or
bottom of the screen become unresponsive), the touchscreen may require recalibra-
tion.
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To calibrate the touchscreen

1 Select the SYSTEM icon.
The System screen appears.

2 Select Display.
3 Select Calibrate touchscreen.

4 Tap the screen on the cross-hairs, as prompted.

The calibration process closes automatically after calibration is complete.

Viewing the System Info

To view the revisions of internal components and to see which options are enabled, use
the System Info menu. This menu also provides the serial numbers of internal compo-
nents. The Copy System Info to File button is used to save a file that includes all of the
system information for the instrument.

Enabling software options

You can enable purchased software options in the field by entering the option key that
was provided to you by Viavi. Please call the Viavi Solutions Technical Assistance
Center (TAC) when you receive the option key so we can assist you with entry of the
key and ensure that the process goes smoothly.

TAC will ask you for two items:

* the serial number of the test instrument for which the upgrade or software option
was ordered

* the Option Challenge ID assigned to your test instrument.

Locating the Option Challenge ID

Your instrument’s Option Challenge ID is provided on the Review/Install Options
screen.

To locate the Option Challenge ID that is assigned to your instrument

*  Select the Tools menu, and then select Review/Install Options...

The Option Challenge ID appears close to the bottom of the screen, directly under the
Option Key field.
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Enabling the software option

After you provide the instrument’s serial number and Option Challenge ID, TAC will
assist you as you enable the software option.

To enable the software option

1 Select the Tools menu, and then select Review/Install Options...

2 In the Option Key field at the bottom of the screen, enter the option key that was
provided by Viavi Solutions, and then select OK.

3 Select Install to enable the software option.

When enabled, a check mark will appear next to the option indicating it is available for
use.

Updating the software

The SC 4800 software update instructions (TBD). The T-BERD / MTS 5800 software
can be updated in the field two ways:

¢ Using a USB memory stick.
— Software can be downloaded for the 5800v1 from http://5800.update-
myunit.net
— Software can be downloaded for the 5800v2 from http://
5800v2.updatemyunit.net
— Software can be downloaded for the 5800-100G from http://5800-
100G.updatemyunit.net

e Over a network.

The process for updating varies depending on the way the update is performed.

NOTE:

D To upgrade the 5800’s firmware, follow the instructions provided with the firm-
ware upgrade package. The instructions include requirements, restrictions, and
the procedure that must be followed to upgrade the firmware. Please contact
your local sales office or technical assistance representative if you experience
significant problems with the upgrade.

Downloading software to a USB

A USB memory stick with at least 750MB of space is required to store the 5800 soft-
ware.
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To download the software

1

3

Using a browser, go to one of the following:

— 5800v1: http://5800.updatemyunit.net

— 5800v2: http://5800v2.updatemyunit.net

— 5800-100G: http://5800-100G.updatemyunit.net

This will bring you to a landing page where you can download the latest self
extracting software upgrade file.

Click the bert -rpm-x.x . exe link for the software release you want to download
(“x.x” represents the software release number).

Save the file to the desktop of your personal computer (PC).

The software is downloaded.

Reimage software URLs

http://5800.updatemyunit.net/archives/

http://5800v2.updatemyunit.net/archives/

http://5800-100g.updatemyunit.net/archives/

http://4800.updatemyunit.net/archives/

The reimage exe files are in the format: Base5800v2-Bert-x.x-Fiber-x-reimage.exe

Extracting the software to a USB stick

After downloading the software to your PC, it must be extracted to a USB stick.

To extract the files to a USB stick

1
2

6

Insert the USB memory stick into your PC.

Double-click the downloaded self-extracting file you saved to your desktop, then
click Run as prompted.

A dialog box appears asking for the location to extract the files.
Click Browse to navigate to and select the drive with the USB stick.

Click Extract.
The files are extracted to the USB stick. Do not remove the USB stick.

Using Windows Explorer, navigate to the drive with the USB stick, right-click on
the drive, and then select Eject.

Remove the USB stick from the PC.

The software is ready to be installed on your instrument using the USB stick.
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Installing the software using a USB stick

To install the software using a USB stick

1 To ensure an uninterrupted supply of power during the installation, connect the
AC power adapter to the T-BERD / MTS 5800 or SC 4800.

:- WARNING: ELECTRICAL SHOCK

Electrical shock may result in serious injury or death. Be sure the AC power
adapter is connected to the correct voltage mains. Do not use the adapter
outdoors or in wet locations. Use only the AC power adapter supplied with
the instrument.

2 Connect the USB flash drive with the extracted software into the USB connector
on the top panel of the instrument.

Select the SYSTEM icon.
4 Select Upgrade.

Select USB.
The release number of the software on the USB is displayed.

If the release is equal to the current software release installed on your instrument,
an equals symbol will be displayed next to the USB software release number.

If the release is a retrograde (an earlier software release than that installed on
your instrument), a down arrow will be displayed next to the USB software release
number.

If the release is an upgrade (a later software release than that installed on your
instrument) an up arrow will be displayed next to the USB software release
number.

6 Select Start Upgrade.

A dialog box appears instructing you to exit any existing tests. You have the
option to cancel the upgrade at this point (for example, if you need to complete a
test that you are currently running).

7 Select OK.

The software is installed. The instrument automatically reboots when the installation is
complete. After the instrument reboots, remove the USB stick from the instrument.

Reimage Software using a USB stick

To reimage software using a USB stick

1 To ensure an uninterrupted supply of power during the installation, connect the
AC power adapter to the T-BERD / MTS 5800 or SC 4800.
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:- WARNING: ELECTRICAL SHOCK

Electrical shock may result in serious injury or death. Be sure the AC power
adapter is connected to the correct voltage mains. Do not use the adapter
outdoors or in wet locations. Use only the AC power adapter supplied with
the instrument.

2 Connect the USB flash drive with the extracted software into the USB connector
on the top panel of the instrument.

3 Use the power button to turn off the unit.

4 Use the power button to turn on the unit.

The software is installed. The instrument automatically reboots when the installation is
complete. After the instrument reboots, remove the USB stick from the instrument.

Updating over a network connection

Before updating your instrument using a network connection, review the following
recommendations:

* A wired network connection is recommended for software upgrades.

* You may experience problems accessing the update myunit.net site from
behind a firewall. If this is the case, please connect the instrument or your PC to a
public network for the purpose of performing the upgrade.

To update over a network connection

1 Connect the T-BERD /MTS 5800 or SC 4800 to AC power to ensure an uninter-
rupted supply of power during the update.

:- WARNING: ELECTRICAL SHOCK

Electrical shock may result in serious injury or death. Be sure the AC power
adapter is connected to the correct voltage mains. Do not use outdoors or in
wet locations. Use only the AC power adapter supplied with the instrument.

Select the SYSTEM icon.
Select Upgrade.

Select Network.

a A~ WO DN

Do one of the following:

— Enter the address where the software file is located. This could include the
FTP address, server IP address or hosthame, and the proxy server address
(if necessary), as well as a User Name and Password.

— Use the provided update myunit.net server address.

6 Select Connect.

This will bring you to a landing page where you can select the software release
that you want to use to update your instrument.
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Click the bert-rpm-x.x.exe link for the software release that you want to install.
(“x.x” represents the software release number).

The release number of the software is displayed.

If the release is equal to the current software release installed on your instrument,
an equals symbol will be displayed next to the software release number.

If the release is an upgrade (a later software release than that installed on your
instrument) an up arrow will be displayed next to the software release number.

7 Select Start Upgrade.
A dialog box appears instructing you to exit any existing tests. You have the
option to cancel the upgrade at this point (for example, if you need to complete a
test that you are currently running).

8 Select OK.

The instrument will communicate with the upgrade server, download the software,
and then install it.

NOTE:

You will be downloading a file in excess of 700MB; therefore, the update will
typically take 15 to 30 minutes, depending on the speed and reliability of the
network.

Retrograding the software

If you require an earlier software version (you wish to retrograde your instrument’s soft-
ware), the software must be updated via a USB stick; retrogrades are not possible via
a network connection.

The “Older software releases are available here” link located at the bottom of the
updatemyunit.net page provides access to older, released versions of software for
the 5800 and 4800 (available as self-extracting files). For instructions, see “Down-
loading software to a USB” on page 249

0 ALERT: LOSS OF FUNCTIONALITY

Please be aware that retrograding your unit to older software releases may
render some installed software options unusable - especially if these soft-
ware test options were released after the date of the software release you
retrograde to. Please proceed with caution. Once complete, if some of your
previously installed test options disappear, these can be restored by upgrad-
ing to the most recent software version again.

About troubleshooting

If you experience problems using your instrument, you may be able to solve these prob-
lems on your own after referring to this section. If you experience significant problems
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with the module, call the Technical Assistance Center (see “Technical assistance” on
page xxii).

Assembly and setup

The following issues may arise when assembling and setting up the instrument.

Which transceivers are compatible with the instrument?
A list of Viavi recommended optics is available by selecting the corresponding option
from the Help menu on the user interface of your instrument. You can also see detailed

information for the currently inserted SFP, XFP, QSFP+ or CFP on the Interface setup
tab of the user interface.

Can | hot-swap MSAMs and CSAMs?

No, MSAMs and CSAMs are not hot-swappable. You must power down the instrument
and unplug the AC power adapter before swapping MSAMs and CSAMs.

Can | hot-swap PIMs?

No, PIMs are not hot-swappable. You must turn the BERT module OFF before inserting
or swapping PIMs.

Can | hot-swap transceivers?

Yes, all Viavi-qualified transceivers are hot-swappable.

Can | do dual port testing from a single SFP PIM?
No. Two SFP jacks are provided on the PIM to allow you to insert transceivers for

different line rates or wavelengths without swapping SFPs. This minimizes wear and
tear on the SFPs.

If you need to perform dual port tests, you need a dual port chassis and two SFP PIMs.

No signal is detected when running 10 GigE application

There are several reasons why a signal may not be detected:

*  Verify that the XFP transceiver is properly inserted.
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e Turn the laser OFF, and then ON again.

* If you are using an MSAM, verify that the MSAM chassis supports 10 GigE
testing. If so, the panel will be labeled C1000 or C1004.

* If you are using an MSAMv1, verify that the XFP PIM is inserted properly in Port 1.
It will not work if it is inserted in Port 2. This restriction does not apply to the
MSAMv2.

Operating the instrument

The following issues may present themselves when operating and performing basic
functions using your instrument.

How much space is available for my data?

T-BERD / MTS 5800v1

There is roughly 1 GB of space available for storing data such as reports.

T-BERD / MTS 5800v2

There is roughly 1 GB of space available for storing data such as reports.

T-BERD / MTS 5800-100G

There is roughly 1 GB of space available for storing data such as reports.

$C 4800

There is roughly 1 GB of space available for storing data such as reports.

6000A Base Unit

There is roughly 512 MB of space available for storing data such as reports.

6000AvV2 Base Unit

There is roughly 1 GB of space available for storing data such as reports.

8000 Base Unit

50% of the base unit hard drive is available for storing data such as reports. If the disk
is full, you will be alerted to the situation when you attempt to save your data.
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Instrument will not power up

There are several reasons why the instrument may not be powering:

Check the power source and restart the instrument.

If the instrument is running on the AC power adapter, verify that the power source
is adequate.

Verify that the components are secured tightly to the base unit. The instrument will
not power up if it is not properly assembled.

Unplug the AC power adapter. Remove the battery, and then reconnect the
battery. Plug in the AC power adapter, and then turn the instrument ON.

Can not print test results

Verify the following:

Verify that the printer cable is properly connected to the instrument. For instruc-
tions on connecting a printer to the base unit, refer to the base unit manual that
shipped with your instrument or upgrade.

Verify that correct printer is specified for the instrument (see “Specifying a printer
for the instrument” on page 79).

Verify that your printer is working properly.
Verify that the printer is turned on and loaded with paper.

Instrument shows an unused slot

In rare instances, the instrument may show an unused slot. This is more likely to occur
if a MSAM is swapped while the base unit is using AC power but may occur after
upgrading firmware.

If it occurs after upgrading the firmware, 1) hard boot the instrument, 2) power down
and unplug the adapter, then 3) replug the adapter and power up again.

If removing a MSAM, power down the instrument and unplug the AC power adapter.
See “Inserting MSAMs or CSAMs into the 6000A base unit or DMC” on page 35.

Instrument does not recognize USB stick

Do the following:

Reboot the instrument. Verify that your instrument is OFF, and then unplug the
unit for at least 5 seconds to force a hard boot.

Reconnect AC power to the instrument.
Turn ON the instrument.
Re-insert the USB stick. This should resolve the issue.
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Performing tests

The following section addresses questions that may be asked about completing tests
with the instrument.

Test menu does not appear

Your instrument may be configured to display the Quick Launch screen by default
(instead of the Main screen). If this is the case, on the Quick Launch screen, select the
All Tests button. The Test menu will appear to the left of the screen.

Application does not appear on the Test menu

Verify the following:

*  Ensure that the required test option is installed. For example, if you are looking for
MiM (PBT) applications, or if you do not see the settings required to verify layer 2
transparency, verify that the associated test option has been installed.

e If you are testing using an MSAM, ensure that the appropriate PIM is inserted in
the MSAM chassis. For example, to see DS1 applications, a DS1 PIM must be
inserted into a port on the chassis. If an SFP PIM is inserted, the DS1 applications
will not appear.

Optical Overload Protection is activated

When testing on an optical circuit, the instrument displays a warning that the Optical
Overload Protection is activated, or the instrument does not detect a signal.

Verify that the applied power does not exceed the power level supported by the
connected transceiver. If it does, attenuate the signal.

MSAM or CSAM user interface is not launching

After verifying that the appropriate BERT icon is highlighted in yellow with a green
outline, press the Results or the Start/Stop key to display the MSAM, or CSAM user
interface.

The green outline indicates which particular BERT module the instrument is currently
displaying the user interface for (in other words, it is the module in focus). A yellow icon
without a green outline indicates that the BERT module is active, but that the user inter-
face is not displayed.
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Test results are inconsistent

Verify the following:

*  Verify that your instrument is connected to the circuit properly for the test you are
running. For details, see “Connecting your instrument to the circuit” on page 79

This is the primary reason for inconsistent test results.

e Verify that your transceivers and cables are good and are connected properly for
the test you are performing.

«  Verify that you have inserted the correct transceiver for the circuit you are testing.
SFPs, SFP+, XFPs, QSFP+, and CFPs are designed to support different line
rates and interfaces.

*  Verify that the correct timing source is selected on the Interface setup screen.
*  Verify that the correct line rate for the interface is selected.

* If you are running SONET or SDH applications, verify that the correct mapping,
tributaries, and analysis rates are selected.

* If an object or person coming in contact with the test set causes a temporary burst
of errors to be recorded, the errors might have been caused by an ESD event.
The recorded errors can be cleared by pressing Test Restart. Please note that the
test set is fully compliant with IEC 61326-1 ESD requirements for industrial equip-
ment and has passed testing according to IEC 61000-4-2 using test limits of 4 kV/
8 kV contact/air and performance criterion B.

The best method of preventing ESD events is to use an ESD wrist strap and/or use a
grounding mat or table. Viavi recognizes that most field users will not have access to
these items at will and therefore cannot have an ideal, ESD-free environment.

In this case, Viavi offers the steps below to help reduce the chances of an ESD event
as much as possible.

a Zero Potential - Most importantly, make sure that you and the test set are at
Zero Potential by touching the metal frame of the AC mains power strip
before touching the unit both before and during the test.

b  Restricting movement — When achieving zero potential through the above
means is not practical, it is recommended to stand upright while using the test
set or otherwise minimize movement. Even when still, use of ESD-safe furni-
ture is recommended whenever possible.

¢ Clothes - Make sure not to wear any clothing that builds excessive electrical
charge, such as a wool sweater.

d Weather - Electrical storms can increase the risk of ESD events. Unless
absolutely necessary, try not to use the test set during an electrical storm.

e Accessories - To help reduce ESD and help prevent other problems, it is also
a good idea to remove all jewelry.
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Appendix B Maintenance and Troubleshooting
Maintaining your instrument

Result values are blank

Results are blank if gating criteria have not been met. Criteria examples include Signal
Present, Frame Sync Present, Pointer Present, and BERT Pattern Sync Present.

No RFC 2544 or FC test buttons appear

If the RFC 2544 Test or FC Test buttons do not appear on the Main screen, verify the
following:

* Payload analysis is ON for your current test application. You can not run the auto-
mated RFC 2544 or FC tests when the instrument is configured to analyze live
traffic.

e Traffic is not VPLS or MPLS encapsulated. You can not run the RFC 2544 tests
with VPLS or MPLS encapsulated traffic.

¢ The instrument is not configured to run a multiple streams Ethernet test.

* The instrument is not configured to run a timed test. You can not run the RFC
2544 or FC tests during a timed test.

Maintaining your instrument

The following section addresses questions that may be asked about maintaining your
instrument.

How often does the instrument need to be calibrated?

e The T-BERD / MTS 5800, MSAM, and CSAM must be calibrated every 36
months.

*  The 6000A base unit must be calibrated every 12 months if the VFL and PM
options are installed.

e  For calibration intervals for the 8000 base unit, refer to the base unit user’s
manual.

What are the insertion rates for all components?

e The MSAM and Fiber Optics chassis can be inserted into the 6000A base unit up
to 1,000 times.

e The MSAM can be inserted into the DMC chassis up to 1,000 times.
. Each PIM can be inserted into the MSAM chassis up to 1,000 times.

* Each SFP or XFP transceiver can be inserted into the jacks provided on the PIMs
up to 100 times. More insertions may be possible, but after 100 times, the plug-
gable optic should be checked.
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Battery communication

Battery communication

The following section addresses questions that may be asked about powering the
instrument using the battery.

Battery gauge reading is inaccurate

Some users have experienced sporadic issues with battery communication when using
the 8000 Base Unit and Battery Modules. When communication issues occur, the
battery gauge reading is no longer accurate, and warnings will not be presented to warn
you that the battery is low.

The 8000 Base Unit detects the problem if it exists. If the power adapter is connected
to your unit when the unit detects the problem, a warning message appears. A similar
message is also presented when the power adapter is not connected to the unit.

To restore battery communication, you must turn OFF the instrument, and restart the
instrument.

To restore battery communication

1 Do one of the following:

— Ifatestis currently in progress, and you want to wait to turn OFF the instrument, verify
that power is supplied using the adapter, and then select Ask me again later.

The instrument will continue running the test (if power is supplied using the
adapter), and will prompt you later to restart the instrument.

— If no tests are currently in progress, verify that the power adapter is disconnected, and
then select Restart Now to restart the instrument immediately.

After you turn OFF or restart the unit, battery communication is restored.
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Storage and Shipment

This appendix describes how to maintain, store and ship your test instrument. Topics
discussed in this appendix include the following:

e “Storing the instrument” on page 262

*  “Shipping the your instrument” on page 262

*  “Returning equipment to Viavi” on page 263
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Appendix C Storage and Shipment
Storing the instrument

Storing the instrument

When the instrument is not in use, it can be stored. You should follow the criteria below
when storing the Dual Module Carrier, Transport Module, CSAM, MSAM, T-BERD/MTS
5800 and SC 4800.

Refer to ““Maintaining the T-BERD/MTS 5800 and SC 4800 batteries” on page 245" for
guidelines related to battery storage.

Environmental specifications

The T-BERD/MTS 5800, SC 4800, and DMC should be stored according to the envi-
ronmental specifications listed in Table 178.

Table 178 T-BERD/MTS 5800, SC 4800 and DMC storage specifications

Item Description

Storage Temperature -4°F to 140°F (-20°C to +60°C)

Humidity at 86°F (30°C) 10% to 95% relative humidity, non-condensing
Shock/drop height (non-operat- Meets requirements specified in IEC 721-3-7,
ing) 2nd Ed. for Class 7M3 products.

The CSAM, MSAM, and PIMs should be stored according to the environmental speci-
fications listed in Table 179.

Table 179 CSAM, MSAM, and PIM storage specifications

Item Description

Storage Temperature -4°F to 140°F (-20°C to +60°C)

Humidity at 86°F (30°C) 10% to 95% relative humidity, non-condensing
Shock/drop height (non-operat- As published in the 6000A Base Unit

ing) User Manual.

Shipping the your instrument

If you will be shipping the instrument, you should follow the guidelines below.

Removing the component

If you are returning the Dual Module Carrier, Transport Module, and MSAM only (rather
than the entire assembly), remove the component before shipping. For instructions,
Chapter 2 “Assembling Your Instrument”.

T-BERD/MTS/SC Getting Started Guide
Page 262 22046537, Rev. 016 March 2018
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Returning equipment to Viavi

Packing the components

When packing the components for shipment, Viavi recommends using the original ship-
ping container and packing materials. If the original container and packing materials are
damaged or not available, the components should be carefully packed so that they will
not be damaged in transit. Viavi recommends using anti-static packing material to
secure the components inside a box or other container. If needed, you can obtain
appropriate packing materials by contacting Viavi Customer Care at 1-866-228-3762 or
at www.viavisolutions.com.

NOTE:
D Viavi is not liable for any damage that may occur during shipping.

Returning equipment to Viavi

Before you return any equipment to Viavi, contact Viavi Customer Care at 1-844-GO-
VIAVI or www.viavisolutions.com for the correct shipping address and for a Return or
Reference Authorization. You must have a Return or Reference Authorization when-

ever you return equipment to Viavi.

For each piece of equipment returned for repair, attach a tag that includes the following
information:

*  Owner’s name, address, and telephone number.

*  The serial number, product type, and model.

*  Warranty status. (If you are unsure of the warranty status of your instrument,
contact Viavi Customer Care.)

* A detailed description of the problem or service requested.

* The name and telephone number of the person to contact regarding questions
about the repair.

*  The return authorization (RA) number (US customers), or reference number
(European Customers).

Clearly mark the outside of the package with the Viavi-issued Return or Reference
Authorization number and ship it prepaid and insured to Viavi. For information on pack-
aging equipment for shipment, see “Shipping the your instrument” on page 262.
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Glossary

Symbols/Numerics

10G — Used on the connector panel to represent 10 Gigabit Ethernet.
10GE — Used on the connector panel to represent 10 Gigabit Ethernet.
10GigE — Used throughout this manual to represent 10 Gigabit Ethernet.

802.11b — IEEE standard for wireless LANSs. You can establish wireless LAN connec-
tions to the T-BERD/MTS 8000, 6000A, and 5800 using an 802.11 PCMCIA card.

A

AC — Alternating Current. An AC power adapter is supplied with the T-BERD/MTS
8000, 6000A, and 5800.

Assembly — Used throughout this manual to refer to a complete set of components
assembled as an instrument and used for testing.

B

Base unit — The unit which connects to the Transport Module and battery or power
adapter, providing the user interface and a variety of connectivity and work flow tools.

BER — Bit Error Rate.
BERT — Bit error rate test. A known pattern of bits is transmitted, and errors received

are counted to figure the BER. The Bit Error Rate test is used to measure transmission
quality.

Cc

CFP — C Form-Factor Pluggable optical transceiver. Optical transceiver used to
connect to and test over 40G and/or 100G fiber circuits.
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Component — Used throughout this manual to refer to an individual hardware compo-
nent which is connected to the other components to build a test instrument (assembly).
This manual supports the following components: the MSAM and the DMC. The base
units are documented in separate manuals.

D

Data tether — A connection to a cell phone (using a data cable) for the purpose of
establishing an Internet connection via the phone's wireless connection to the cell
phone network.

DHCP — Dynamic Host Configuration Protocol. A communications protocol that
assigns IP addresses dynamically as needed. The test instrument supports static IP
address assignment.

DMC — Dual Module Carrier. Two slot chassis which you can connect to the T-BERD

/ MTS 8000 base unit to test using up to two MSAM application modules and four Phys-
ical Interface Modules (PIMs).

E

Ethernet — A LAN protocol. Using the T-BERD /MTS 8000, 6000A, and 5800, you can
test and verify Ethernet network elements and services.

Ethernet link partner — The nearest Ethernet device on a link. The T-BERD/MTS
8000, 6000A, and 5800 auto-negotiates its capabilities with this device when you
initialize a link.

F

FTP — File transfer protocol. Protocol used on LANs and the Internet to transfer files.

G

GE — Used on some devices to represent Gigabit Ethernet.

GigE — Used throughout this manual to represent Gigabit Ethernet.
GNSS — Global Navigation Satellite System.

GUI — Graphical User Interface. Layout of commands in a user-friendly environment.
See also Ul (user interface).

H

Histogram — Print output of specific results in a bar graph format.

ISO — International Organization for Standardization.
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IP — Internet Protocol. Protocol specifying the format and address scheme of packets
transmitted over the Internet. Typically used with TCP.

L

LAN — Local Access Network.
LED — Light emitting diode.
LLB — Line loopback.

LilON — Lithium lon. The T-BERD/MTS 8000, 6000A, and 5800 can be equipped with
a rechargeable Lithium lon battery.

M

MDI — Medium dependent interface.

MDI-X — Medium dependent interface crossover.
MPO — Multi Fiber Push On connector.

MSAM — Multiple Services Application Module.

Msg — Message.

o

OC-3 — Optical carrier 3. A SONET channel equal to three DS3s (155.52 Mbps).
0OC-12 — Optical carrier 12. A SONET channel of 622.08 Mbps.

0OC-48 — Optical Carrier 48. SONET channel of 2.488 Gbps.

0C-192 — Optical Carrier 192. SONET channel of 9.953 Gbps.

OTDR — Optical Time Domain Reflectometer.

P

Packet — Bundle of data, configured for transmission. Consists of data to be trans-
mitted and control information.

PIM — The physical interface module inserted into one of up to two ports provided on
the MSAM chassis. Provides the interfaces used to connect to the circuit you are
testing.

PON — Passive Optical Network.
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Q

QSFP+ — Quad Small Form-Factor Pluggable optical transceiver. A transceiver used
to test 40G fiber circuits.

QSFP28 — An optical adapter or transceiver used to connect to and test over 100G
fiber circuits. An optional CFP2 to QSFP28 adapter is available for the CSAM.

R

RJ 48-45 — Jack on the Transport Module used for 10/100/1000 Mbps Ethernet
testing.

Rx — Receive or receiver or input.

S

SDH — Synchronous Data Hierarchy.

SONET — Synchronous optical network.

STM-1e — An electrical SDH signal of 155.52 Mbps.
STM-4 — An SDH signal of 622.08 Mbps.

STM-16 — An SDH signal of 2488.32 Mbps.
STM-64 — An SDH signal of 9.953 Gbps.

STS-1 — An electrical SONET signal of 51.84 Mbps.
Sync — Synchronization.

SyncE — Synchronized Ethernet.

T
TEM — Timing Expansion Module
Term — See Terminate

Terminate — An application where the test set is terminating the circuit. In these appli-
cations, the test set sends and receives traffic.

Through — An application where the test set is used in series with a network circuit to
monitor the traffic on that circuit.

Tx — Transmit or transmitter or output.
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U

USB — Universal Serial Bus. A bus designed to handle a broad range of devices, such
as keyboards, mouses, printers, modems, and hubs.

\'

VNC — Virtual Network Computing. A thin client system that enables you to run appli-
cations on a VNC server from any other computer connected to the Internet. Using
VNC, you can run the T-BERD/MTS 8000, 6000A, and 5800 from a remote worksta-

tion, and you can run remote applications from the T-BERD/MTS 8000, 6000A, and
5800.

w

WAN — Wide area network.

X

XFP — 10 Gigabit Small Form Factor Pluggable optical transceiver. A variety of
optional XFPs are available for testing 10 Gigabit LAN or 10 Gigabit WAN fibre circuits.
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